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1 Introduction

The scanning electron microscope LEO 15XX is a fully computer controlled instrument. All operations,
settings and functions necessary for the handling of the microscope are controlled by use of a keyboard and a
mouse. Using fiber-optic cables, entered commands are transmitted to the electronic system.

Control of the stage is by a dual joystick providing control of all motorized axes of the stage. Optionally, a
hard panel provides control of the stage. (see ). Additionally the hard panel provides the advantage that
setting and adjustment of important parameters such as magnification and focus, stigmator or beam
alignment is possible using two potentiometers (encoders).

The LEO 32 Software is a special communication and control program running under the Windowsg 98 or
Windowsg NT (2000) operating systems and following the normal rules for Windowsge applications.

The different functions, parameters or windows can be opened or activated using a Pop-Up Menu (see E[) or

using a toolbar (see .
@ icon in the

Starting the software is by a double-click with the left mouse button on the
Windowsg user interface or by clicking, START-> PROGRAMS > LEO- 32 - SEM USER INTERFACE.

After starting the LEO software, the LEO server,
realizing the internal communication between

=) Accessories
fa FTP Remate Archiving

LEQ-32 Service 8 LED Admiisralor software and hardware, will load the different drivers.
) Startup  Parachuie Each specific user logs on with his user name and the
g i?::;”:ﬁ::gft % ;:’:j;“:mb password established by the administrator. If the user
(%1 Dutook Express & Filease Noles name and the password are entered correctly, the LEO
(2] Windows NT Explorer £ RemConi2 32 user interface will start with the corresponding user
Adminstote Took Conmor) »_ L8 SEM Usst etace specific configurations.
(3 AdobeAcrobat 40 The server will remain active even after closing the

Norton Antiis
Startup

user interface. The communication between hardware
and software will only end after finishing Windowsg
or after closing manually.

LED-32 Log on |

Uzer Marne IMustermann

Password | A Start| M= LED SRY-32

Help | 0k, I Cancel

If you want to install new user software on the computer you should inform your service engineer.
Make sure that the LEO server of the LEO-32 software is closed before installing further software
components (e.g. Word, Excel, Power Point etc.). Before starting a new installation routine, it is

B>
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recommended to restart Windowsg .

Do not forget that the LEO 15XX has been developed as a scanning electron microscope. The
integrated personal computer should mainly be used for the installation of control software and for
the storage of images. The installation of other software components may cause problems in
individual cases.

Apart from the LEO user interface, other programs can be started using the Windowsg paths START>
PROGRAMS > LEO-32 or START> PROGRAMS > LEO-32 Service. Some of these programs are only
available to LEO Service, e.g. calibration of the instruments or to set or control special parameters. Other
programs are available to the specific user and can be considered as help programs for special applications of
the scanning electron microscope. The different programs are explained as follows:

LEO- 32> FTP Remote Archiving (optional

=) Aocessories

032 software)

032 [F Calbraton wizard Program to send saved SEM images to another
(=) Startup =% Gun Moritor Utility 1 1
B, Conmot o % tunSevie computer or printer using a network.
e Internet Explorer & Stage Admin
I‘_;ﬂ Outlook E xpress ﬁ Upgrade User Databaze LEO- 329 LEO Administrator
O TS G Vi DATAYAC Starts the LEO Administrator. By means of this
xm:‘j"‘t”: o e administrator, it is possible to install or edit new user
=) jobe AcroDat 4. . . . .
(3, Noren A directories (for further information see B

LEO- 32 Read Me
Shows the Read Me file which contains important
details on the current LEO software.

LEO- 32 Release Notes
Gives an overview on all LEO software versions with
their new developments and special details.

B

LEO- 32> RemCon32
Special program to support communication using the serial interface (for more information see 9.4).

LEO- 32> SEM User Interface
Starts the LEO user interface.

LEO- 32 Service=> Calibration Wizard
Program for the calibration of the scanning electron microscope. This program is only available to LEO
service personnel.

LEO- 32 Service> Convert DATA.VAC
Conversion of the file “data.vac” to a more recent version, necessary for the upgrade from the 16-Bit version
to the 32-Bit software version.

LEO- 32 Service> Gun Monitor Utility
This program monitors parameters of the scanning electron microscope Gun in the form of a diagram (for
more detailed information see .

LEO- 32 Service> Gun Service
Program for setting and adjusting of the filament, only available to LEO Service personnel.

LEO- 32 Service=> Stage Admin
Program for setting and adjusting the motorized stage, only available to LEO Service personnel.

8 LEO Electron Microscopy Ltd
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LEO- 32 Service> Upgrade User Database
Program to adjust an old user data file to a new LEO-32 software version.

LEO- 32 Service> View DATA.VAC

Shows the contents of the file “data.vac”. All calibration and configuration data of the SEM are stored in this
file.

ST — You will find the complete LEO software in two main folders on the hard
Fle Edt View Toos Help disk. These folders are C:\LEO and C:\Program Files\LEO (LEO Electron
[ 22 images =l i=l5| Microscopy Ltd). The folder C:\LEO contains mainly calibration and
Al Falders initialization files for the LEO software. One of the most important files in
%__S:;E'Eomputer this directory is the file data.vac as it contains all calibration data of the
56 3% Floppy [&4) scanning electron microscope. It is recommended to back up the contents
T of this file to the hard drive or to a disk to protect the stored data. The
D{:l Program Files directory C:\Program Files\LEO (LEO Electron Microscopy Ltd) contains
£ LEM Electron Microscopy Lid the complete program. The subdirectories \user contain the different user

2] Len-32 . . .. .
(3 Distib directories that the administrator can help to set up and edit (see 2.1.).

These directories contain all user specific data and configurations.. The
directory \images contain image files for the specific users to store the
{1 Mustermann

(23 Irproc 1mmages.
{1 Log

-0 Parachube
{1 Service Reports
[ Systern

{1 Mustermann
[ service

To ensure safe running of the control software, no modifications should be made to directories and
files of the LEO software with the exception of the files and subdirectories in C:\Program
Files\Leo\Leo32\images and C:\Program Files\Leo\Leo32\user where user specific and temporary

modifications may occur. Always make a back up to protect the stored data before deleting files or
directories.

B>
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2 The Administrator

The Administrator provides for establishing different user directories, editing existing folders and user
configurations. A user directory contains frequently modified configuration parameters of the LEO-32 user
interface and system software files for specific users. Each specific user has his own directory for
configuration parameters, toolbar, menus, data zones, operation modes, etc. Each user interface will thus
load with the user specific configuration settings.

2.1 Setting the User Directories

After the installation, the user directories should be set up by the person responsible for the system or the
service engineer. The Administrator is opened using the Windowsg Overlay as follows:

START-> PROGRAM~> LEO 32> LEO ADMINISTRATOR.

Once the program begins loading, you will be prompted to enter a name and a password. Log on is possible
with the user name SERVICE and the current service password or with the user name SYSTEM. Click on
OK to confirm.

'

After the first set-up, a password only known to the Administrator should be established for
/;\ SYSTEM. This password can be reestablished in case it is forgotten.

& LEOD 32 Administrator [SYSTEM]

Uszers Accounting Licences .. Configuration .. Service Databaze Help

User Mame User Directory Image Directory User level
Ack | C:z\Program Fil..__\LED32\userifAck | C:\Program Fil..__EO\LED32%\images | Any
Development | C:vProgram Fil...32\user\default | C:\Program Fil...EO\LED32\images | Any
Factory | C:\Program Fil.._._32\user\service | C:\Program Fil..__EO\LED32%\images | Any
Guest | C:\Program Fil...E0D32\useriguest | C:\Program Fil...EO\LEOD32%images |

C:wProgram Fil..._user\Hustermann C:%Program Fil. . _EDA\LED32%vimages

Service | C:vProgram Fil...32\user\service | C:\Program Fil...EO\LED32\images | Any
Systen | c:ziprogram fil...32\userhdefault | c:\program fil...eo\leo32\images | Any

The Administrator panel is now visible, and the user lists are displayed.
Creating a New User:

= Pop-Up Menu USERS > NEW: displays a window that allows the creation of new user directories and
modification of existing user directories.

= Enter a user name in User Name (it is recommended to use short forms)

= To create a user directory, click on the gray box behind User Directory. Now select a specific directory,
or create a new directory. All user specific configurations, e.g. toolbar, data zone, stage coordinates etc.
will be saved and loaded into this directory. To create a directory “ Userl”, replace “default” by “Userl”.
Click on “Create Directory” to install this directory on the hard drive.

= Create an image directory by clicking on the gray box behind Image Directory. Now select a specific
directory or create a new directory (see User Directory). All stored images will be filed in this directory.

= Setting user levels: The level of access can be set to Novice, Expert, Full and Any Level. These privilege
and permission levels refer to the number of enabled SEM parameters (see . “Any level” will allow
access to all available parameters. The other levels only enable access to a certain number of privileges
and permissions

= Enabling different permissions, i.e. permission to switch off or adjust the filament, to initialize the stage,
to act as a supervisor or to edit the toolbar.

10 LEO Electron Microscopy Ltd
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It is recommended SUPERVISOR only be assigned to a restricted number of authorized users.
SUPERVISOR is allowed to start the administrator and establish or edit new user directories.
Furthermore, the user can adjust or activate the following SEM parameters:

* USER MAX EHT (setting of user specific peak values for the acceleration voltage

* Filament Current (modification of the filament current)

* Bake out (setting and start of the bake out for the IGP)

* Activation of LEAVE GUN ON AT SHUTDOWN, PARTIAL VENT ON STANDBY, Z MOVE

ON VENT, PROTECT Z and EHT OF @ LOG OFF.

= OTHER SETTINGS: Use Common Toolbar, if this control window is activated, a standard toolbar
(COMMON.UTB) from the directory “C:\Program Files\Leo\Leo32\User” will load when loading the
user interface. If not, the specific toolbar from the corresponding user interface will load.

Creating new User Profile . Uszer Directory !E =]
User hame !User‘l [Etiange Password !

![Z: \Program Files\LE 0ALED32\user\User|

Create Directory l

b e iE:\Program FileshLEONLED324uzerU zerl

Current iE: “Program Files\LEONLED32%user\User]

Image Directory ;E' \Program Files\L EO\LED 324imagesh U zer

Current ;E: \Program Files\LEOALE O324%imagesiUser

—Uszer Level permissions
v Ary level

— Directory Change Permizsions

v User ¥ Image
— Privil
¥ Supervisor ¥ Gun Off . Change password for Userl M=] E3
¥ Stage Initislize ¥ Gun Align

MHew Pagsword |><==><==

1~ Temparary Calibration Privil

I [ Er

Expires | I ety Ixx“

— Other zetting:

™ Use Camman Taalbar ' oK | Cancel |
oK 1 Cancel 1

After setting the different configurations, the window can be closed by clicking on OK. Now the new user
interface will be displayed in the user access window. The password for the user will be his user name. To
change this password, the specific directory must be opened again using FILE > EDIT.

Editing a user password:

= Select the corresponding user directory in the user access window
= Pop-Up menu USER > EDIT

= Activate Change Password

= Enter and verify the desired password (at least three letters!)

LEO Electron Microscopy Ltd 11
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2.2  Deleting User Directories

To delete a user name from the Administrator, the user name to be deleted has to be activated in the user
access window (click on user name with the left mouse button). Then select Delete in the USER menu.
After confirmation of the command, the user name will be deleted from the Administrator. Access will no
longer be possible with this user name and the corresponding password. However, the established user
directories and the corresponding files will not be deleted automatically from the hard drive. If necessary,
these files and directories must be deleted afterwards using Windowse Explorer.

2.3 Installing and Editing Software Licenses

The software licences can be opened with the menu LICENCES. A window with all installed software
licences will be displayed. This window allows the administrator to disable certain software options or to
enable disabled options. New licences can be installed. Click on “Install from disk” to select the path
containing the licence file. The licence files will have the name “Mwk????.LIC”. After selection of the file
and clicking on “Install” the licences will be implemented to the system. .

. Licence Administrator LED 1530-95-46

~ Current Licenc
348224-6003 1530-DUALMAG Dual Magnification -
348224-60085 1538-CENTRE Centre Feature\Stage Map
348224-6006 1530-STAGECD Stage Co-ordinate store and recall
3482246007 1538-STAGESCAN Stage Scan
348224-6089 1538-GAMMALUT Input Gamma
348224-6011 1530-HEASA Advanced Heasurement
348224-6013 1530-1MMATH Image Haths
348224-6014 1530-REMCON R5232 Remote Control
348224-6017 = 1530-XRAY Simple X-Ray dotmap/linescan
34822460829 1538-STAGEREG Stage Registration ;I
€+ Sart by Part Murnber = Sort By Sales Code ¢ Sort by Description

Install from disk .. Enstie/Dizatlelitences Restore Licences

2.4 System Configuration

The menu CONFIGURATION displays or edits the current system configuration. This includes available
detectors, monitor size, kind and motorization of the stage, kind of the photo unit and other relevant system
configurations. Adjustments are only necessary after reinstalling or deleting hardware components.

/’\ This menu contains important system settings, only authorized persons (service engineer) should
= ‘| make modifications.

The menu CONFIGURATION is subdivided into four index cards. The file card Column / Stage controls
parameters of the stage control and of the sample airlock, if available. The installation of a sample airlock
must be communicated to the system by activating Airlock Monitor. If the airlock can be controlled using
the LEO software, Airlock Control must also be activated. This allows control the airlock using the menu
Airlock in the LEO user interface (see 9.2.).

Stage Options selects the installed motorized stage. If there is a rotation limit switch on the stage, this option
can be selected by clicking on Rotate Limit.. The control boxes X,¥,Z,T,R and M-Enabled indicate the
motorized axes of the stage and allow switching off the axes Z,T and R (M.). Select the control module by
clicking on Joystick or Hard Panel=Markl, depending on whether a joystick or/and hard panel is adapted.
The output media can be selected on the index Tab Qutput. The first step is to adjust the adapted monitor.
Depending on its size, selection is possible between 14/15 inches, 17 inches and 19/21 inches. This value
influences the calculation of the magnification that refers to the monitor. If a high-resolution record unit has
been installed, it can be selected by clicking on HRRU=Markl.
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. System Configuration =] E3 [} . Svstem Configuration

Column/Stage | Output i Other i Detectors Colurnn/Stage If Output T Other 1 Detectors

i~ Column/Chamber O ption:

™ Aitlack Monitar ™ Aidock Control
 Stage Dpton Moritor = 14/15inch =] JHRRU = Mark 1 =l
14/15 inch
[Btage Type = Cartesian 3 [¥ % Enabled 17 inch
e 13/21 inch
istage Motar =Yes j F nane
Z Enabled
¥ Rotate Limit o et
v T Enabled
™ Joystick
[¥ R Enabled
IHald Panel = Mark 1 - 1= Enabiled

The index Tab Other allows the level of DDE support (Dynamic Data Exchange) to be set. Standard is DDE
Access = None. The setting of this level depends on the other programs installed on the computer (e.g.
special image storage programs) interactively reading data from the LEO software using the DDE support.
Upon request, a list of all DDE commands applicable to the LEO software is available.

All detector parameters can be set using the index Tab Detectors. The different detectors are selected by
clicking on Detector-> and can be activated or deactivated by clicking on Present. When a new detector is
installed, Connected to channel shows a list of the channels to which the detector may be assigned. You will
then have to select the corresponding channel. If a camera is installed on the instrument, it can be selected
using the selection TV and be assigned to the corresponding channel. Set the corresponding camera mode
using TV Mode. Possible selections are CCD, PAL and NTSC. Modifications to the detector or to the
camera settings can be stored by clicking the key Save Settings.

. System Configuration M[=I E3 [}l =. Svstem Configuration |_ O] =]
Column/Stage 1 Clutput T Other 1 Detectors Column/Stage 1 Output T Other T Detectors
Detector > - IlnLemg ¥ Present
Connected to channel

" PL13 - InLens BT

{01 B T4 5 GEZ i ELTE

) BLL 151> HHSD LTS

i PL16

3 kst £ not connected
T4 Mod:
More vI

Save Settings
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3 The Pop-Up Menu

As is the practice in other Windowsg programs, the different menu windows necessary to work with the
software can be opened using a Pop-Up menu. To allow an efficient handling, related commands are
combined in separate menu topics. Below you will find the description of these items. Wherever a more
detailed explanation is necessary, we refer to the corresponding information in the manual.

3.1 Menu: FILE

TR BTGPV The menu item “File” contains mainly options for storing and editing images,
S Edit ‘iew Beam Deter closing the software and setting special instrument configurations

Restare |
Save For Restare
el 3.1.1 Restore- Save For Restore- Standard
Load State. .. Restore:
Save State...
Loading and Processing the Macro “Restore4.mlc” from the corresponding
Load Image... Chri+0 user interface (see 4.1.3).
Save Image... Chil+E |:I
Print Image Chil+P Save For Restore:
Frint Setup... The selection of this command allows the storage of the respective instrument

configuration (acceleration voltage, magnification, focus etc.) in the
“Restore4.mlc” macro in the current user directory. Any already existing
macro will be replaced. If no “Restore4.mlc” macro exists in the current user
Log Ot directory, it will be set up and the current parameters will be stored in it.

Load Annatation
Save Annatation

E xit

Standard:

A standard configuration is set on the instrument (acceleration voltage = 5kV, working distance = 12mm,
aperture = 30um, smallest magnification). If the filament or EHT are switched off, this routine loads the
acceleration voltage or the filament startup parameters. At the same time you will be asked if the stage is to
be initialized if it has not been up to now.

Load State- Save State:

Load State...: Loading special instrument configurations (see f.1.4))
Save State...: Saving special instrument configurations (see .

3.1.2 Load Image- Save Image

Load Image...: Loading TIFF images into the LEO user interface (see
Save Image...: Saving images in TIFF format (see .

3.1.3 Print Image- Print Setup

Print Image: Printing the current image on the default printer as defined in Windowsg

Print Setup...: Loading the Print Setup. Settings such as page size and printer are possible (see .

14 LEO Electron Microscopy Ltd
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3.1.4 Load Annotation- Save Annotation

Load Annotation: Loading measurements and annotations saved using “Save Annotation” as a file in
the respective user directory (see .

Save Annotation: Saving highlighted measurements and annotations as a separate file in the current
user directory (see .

3.1.5 Log Off- Exit

Log Off: Exiting the LEO user interface and all other LEO applications such as the program
“RemCon32”. The LEO server remains active.

Exit: Exiting the LEO user interface. The LEO server remains active. You will be asked
whether other LEO applications are to be closed. If you answer “Yes”, the result will
be the same as with “Log Off”. If you answer “No”, only the LEO user interface will
be exited, all other LEO applications remain logged on.

i SEM Control E

There are aother applications registered with Lea Server.
Do vou wish to Log OFF?
Select Yez to Log Off and cloze the other applications.
Select Mo if you wish ta close thiz interface and remain logged On.

HNo | I:ancell

LEO Electron Microscopy Ltd 15
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3.2 Menu: EDIT

EM - [MUSTERMANN] The menu “Edit” provides processing of current and stored images as

Y View Beam Detection Image Se well as custom tool bar design. Processing includes editing

| brightness and contrast, insertion of measurements and texts and
Input LU

copying images using the clipboard. By clicking on Toolbar the

Dizplay LUT... e . . .
?:;;:r current toolbar can be individually designed and modified.
Annatatian. . Chrl+4,

Inzert Annatation Text... Chrl+T

Inzert Paint to Paint Marker...  Chrl+id

Clipboard...

3.2.1 Input LUT: (Requires the Licence: GAMMALUT)

Modifications of the Input LUT affects the current live image. Independent to the signal setting for
brightness and contrast (see , an individual adjustment of the transfer characteristic is defined. This
option is useful if a perfect, linear illumination of the image is difficult or impossible. In these special cases
you may try to optimize the illumination by adding or displacing discrete points of the LUT or by adding a
step function.

After loading the Input LUT a toolbar and a graph are displayed showing the signal transfer characteristic.
This characteristic represents the coordinates of the input gray level. In the simplest case it is a straight line
connecting the points (0,0) and (255,255). Processing this straight line is by adding or displacing different
points.

The different functions can be selected in the toolbar or by clicking the right mouse button within the graph
window. The displayed selection menu will show the different functions. This menu also allows to switch the
toolbar on or off (SHOW TOOLBAR - (HIDE TOOLBAR).

[ SRIREFR I Y | F0-32 LUT Editer M=l E3

Eile Help

E dit Mods v
LUT Functions Beset LUT
Ireeert LT

v Show Toolbar
Hide Toolbar

o]
XM =

=

_r Setup Step Parameters Open LUT
Save LUT Asg

Undo

Below you will find the different functions of the Input LUT.

/Ig Displacing and deleting points in the signal transfer characteristic.
(Displacing: Position the mouse cursor on to the point and displace with the pressed left mouse button.
Deleting: Position the cursor close to the point and press the middle mouse button.

j,g_ Adding and deleting points in the signal transfer characteristic (Adding: Position the mouse cursor within
the graph field and click the left mouse button / Deleting: Position the cursor close to the point and click

16 LEO Electron Microscopy Ltd
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on the middle mouse button)

Cancel the last modification of the Input LUT

Loading special Input LUT settings and applying these settings to the current image
Saving special settings of the Input LUT

Returning the Input LUT to the basic status (linear characteristic)

Inverting the current signal transfer characteristic

Adding a step function as signal transfer characteristic. By doing so, the signal transfer characteristic will
be transformed to a regular sequence of gray values. The amplitude of each step, the position of the first
step (Offset) and the number of steps (period) can be set separately. It is possible to continue to modify
the curve by adding or displacing different points.

Loading the window LUT Step Settings to set offset, amplitude and period for the step function.

¥ LED-32 LUT Editor [ O] x] LUT Step Settings
Fil= Help — Amplitude — 1~ Period
o
: Y
1
— Offzet
Min b ax
—|\I 1 1 1 1 1 ] 1 1 1
Jei|
s - Contral
¥ Apply Directly ta Curent LUT
bin =
Ready 4
3.2.2 Display LUT

By means of Display LUT modifications of the current live image and of stored images are possible. You
will find more detailed information on the different functions in

3.2.3

Toolbar

Loading the toolbar editor provides; custom design to the current toolbar, save or load a user custom or
standard toolbar. (see 6.5).

LEO Electron Microscopy Ltd 17
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3.2.4 Annotation- Insert Annotation Text- Insert Point to Point Marker

Annotation: Opening the toolbar for annotation , measurements, etc. to the image (see .
Insert Annotation Text: Loading the text editor for adding annotations to the image (see .

Insert Point-to-Point Marker: Loading the toolbar for the annotation and immediate addition of a point-to-
point measurement to the current image (see .

3.2.5 Clipboard (Requires the Licence: CLIP)

Similar to other Windowsg applications, the menu “Clipboard” allows copying images to the Windowsg-
specific Buffer store or adding images from the buffer store to the LEO user interface. The image will not be
stored in a storage medium such as a hard drive or disk, but the contents of the memory will be stored in the
main memory of the computer. The contents will therefore be available to any other Windowsg application
which has access to the buffer store. This allows copying SEM images or clippings without storage from
intermediary memory to other programs. Furthermore, SEM images contained in the Clipboard can be added
to a stored image.

Clipboard [x] Clipboard =]
Copy | Faste | Copy  Paste |
- Dimensions
ion = = - Store resolution = 1024 * 768 -

IStore resolution = 1024 * 768 J o IBS— I o : J

| i File infarmation Load at

mage eige rea v IHQ

: Cent Step F
V| & seen ¥ Annatation ™ wihale = Tipre Cley ﬂl W I‘IDD L
Feduction ¥ Overlay W width 445 Origin | Image Reduction
Centre | H Iggg ; Y |1DD
I1 'l " Calow Merge Height 222 Bt | I‘I vI

Set

By means of the index Tab “Copy” SEM images or clippings can be copied to the intermediary memory.
The control box “Store Resolution” displays the store resolution of the image and allows modifications..
Clicking the key Copy will start the copying procedure.

Control Surface IMAGE:

Processing images is possible by means of the Display LUT (see). If AS SEEN is activated, the edited
monitor content will be copied to the intermediary memory. If not, the gross data will be used. By selecting
REDUCTION, the image can be sent to the image store in a reduced size. Selection is possible between 1
(original size) and 8.

Control Surface MERGE:

ANNOTATION:
Data zone and annotations and measurements etc. will be copied to the intermediary memory together with
the image.

OVERLAY:
Copies only the data zone together with the image to the intermediary memory.

COLOR MERGE:

Must be activated to copy colored annotations or measurements together with the color to the intermediary
memory. This will reduce the number of grays (256) of the image by 20 gray scales as this storage area is
necessary for the storage of the ANNOTATION information. If Color Merge is not activated, the colors will
be converted in gray scales.

18 LEO Electron Microscopy Ltd
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Control Box DIMENSIONS:

This list indicates the upper left (X, Y) as well as width (W) and height (H) of the area to be copied. If
WHOLE is selected in AREA, upper left will always be 0,0 and the size will be identical to the set STORE
RESOLUTION. 1t is also possible to copy only a clipping of the image after entering the respective
parameters in DIMENSIONS. Click on SET to display the grid on the image in size and position
corresponding to the clipping to be copied. Size and position of the grid can also be set by using the mouse.
By clicking on ANNOTATION (see ﬁb it is possible to select an image area to be saved to the intermediary

memory. To do so, click on the symbol . Then the corresponding area can be selected by clicking on
the left mouse button. The selected area will be centered on the screen by clicking Center.

By switching to the index Tab “Paste”, insertion of images and clippings from the intermediary memory is
possible. The box FILE INFORMATION displays size and type of the image stored in the intermediary
memory. Clip on IMAGE REDUCTION to select a reduction factor if a reduced image is to be loaded into
the image memory. This enables an image-in-image presentation or a composition of 4, 9, 16 etc. images to
one entire image. Depending on the reduction factor, the size of the grid will be displayed on the screen. This
grid shows position and format of the image to be loaded. The position of the grid on the screen can be
determined by clicking on CENTER, ORIGIN (upper left) or X, Y (free positioning). Selecting X, ¥ results
in free positioning of the grid with the mouse. Click Paste to insert the selected image into the
corresponding position. It is recommended to activate STEP FRAME to display i.e. 4 images in one entire
image, the images being thus automatically positioned correctly (see . Click on ORIGIN before
selecting STEP FRAME.
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3.3 Menu: VIEW

The functions in VIEW refer mainly to the design of the LEO user interface. By clicking on VIEW it is
possible to switch on or off the toolbar and the status bar, to load markers like grid or cross hairs or to
display different data zones. It is also possible to switch on or off a certain group of measurements and
annotations. The SEM status window can be opened, listing user specific parameters which can be modified
interactively.

[MUSTERMANN] [MUSTERMANN]
m Beam Detection |mage Scanning Stage Yacuum Toolz Help m Beam Detection |mage Scanning Stage Yacuum Tool: Help
Taalbars... Chl+B | Toolbars... Chrl+E
Data Zone Toggle D ata Zone Chel+Dr Data Zone 3
Toggle Visible Dislogs ~ F3 PRy b FD B Toggle Visile Dislogs F2
Toagle Full Screen Image  Shift+F 3 Hide Data Zonelz] Toggle Full Screen Image  Shift+F3
Crozshairs ¥ Urhide Dats Zanels) Crosshairs
Graticule Load Uszer Data Zore. .. Graticule
Graticule Spacing... Graticule Spacing...
SEM Status... Crl+| SEM Status... Crl+l
Hide Annatation 3 Hide Annatation 4
Unhide &nnotation 3 Unhide Annotation Urhide Al

Urhide Text/Bitmap/Line Annotation
Unhide Meazurement Annotation

Urhide Measurement Besults Panels
Unhide A&nnotation Selection Handles

3.3.1 Toolbars- DataZone

The key combination CTRL + B or the selection of Toolbars... opens the
window Toolbar Views. Select User Toolbar, Status Bar or HFP Status (hard
panel) to activate or deactivate the toolbar, status bar or HFP Status. The
status bar for the hard panel shows the current active selection for the encoders
(potentiometers). Clicking Tool Tips switches on (Show) or off (Hide), the
short explanation of the different toolbar icons. This short explanation will be
displayed if the mouse cursor is situated on one of the toolbar icons.

Toolbar Views
i_.. TDDIbarS" ___ i -
W User Toolbar
- ¥ Status Bar

A showing or hiding of the current data zone is possible by using the key combination CTRL + D or by
clicking on Toggle Data Zone. The file CURRENT.ADZ in the current user directory will load, displaying
design, size, position and parameters of the data zone. Selecting the function Display Default Data Zone
will load the standard data zone (DATAZONE.ADZ) from the directory C:\Program
Files\Leo\Leo32\distrib. Y ou will be asked whether you want to replace the current data zone.

SEM Control 1]

Warning - This Data Zone will replace any Existing Current User D ata Zone.

Are You Sure You *Wish To Replace The Curent Data Zone

Answering “YES” will replace the current data zone with the standard data zone.If “NO”, the current data
zone will remain. The functions Hide and Unhide Datazone(s) will also show or hide the data zone.
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Load Data Zone [2[x]| Loading a user specific data zone can be done using
Lookin: | Ack = ¥ Load User Datazone... The different data zones in
the current user directory will thus be displayed.
Current. ADZ K K ) .
[#] DataZone! ADZ You will find detailed information on the set-up of
DataZone2.ADZ user specific data zones in By selecting one of
DataZoned ADZ

the listed files and clicking on Open, the respective
data zone can be loaded into the LEO user interface.
You will be asked again whether you want to
replace the current data zone with the selected one.

File name: | geen | | Answering “YES” will replace the current data zone.
Files of type: | DataZone [~.adz =] Cancel | Answering “NO” will save the current data zone as

an annotation. The loaded data zone will be
converted to the file CURRENT.ADZ and can be switched on or off by pressing on CTRL + D.

3.3.2 Toggle Visible Dialogs- Toggle Full Screen Image

Pressing the key F3 or clicking on Toggle Visible Dialogs switches off the opened windows and toolbars
(Input LUT, Annotation etc.) of the LEO user interface . A second clicking or pressing the key F3 will result
in a reactivation of the deactivated windows.

To switch off the Windowse interface, i.e. the Pop-Up menu, the toolbar, the statusbar and the HFP status
bar, use the function Toggle Full Screen Image or the key combination Shift + F3. Repeating this function
opens the Windowsg interface again.

3.3.3 Crosshairs- Graticule (Requires the Licence: GRATICULE)

The selection View — Crosshairs will display an overlay on the screen that can be switched off by selecting
View — Crosshairs again. It is also possible to display a grid on the monitor that will be activated by the
command View -> Graticule. The line distance can be entered using the function Graticule Spacing....
Values between 50 and 512 (half of the screen resolution across will be displayed on the screen) are possible.

a: SEM - [MUSTERMANN] [_[5]x]

55 SEM - [MUSTERMANN] [_[51x]
Fie Edt Vw Beam Detecion Image Sconning Stage Vaguum Iods Help

Rome, AFICND | | [ [
e | [ | |
A S T
‘e

e | |
1/ |
_ 1 = 20. v
L T [ [ [ [Wb{ f2qm [ |
baco: 0 BRBEL -/ [Guro/ EHT:¢/  ForHelp,pess 1 act: de BERREL =,/ [Gurs/ EFT:y/
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3.3.4 SEM Status- Hide/ Unhide Annotation

The SEM Status window provides the ability to list a certain number of important parameters and
commands. For more detailed information see

The commands Hide and Unhide allow the user to
activate and deactivate specific annotation and
measurement objects. Standard set-up for all objects

Pa 1 =26.80 ym

/(f
Lb 1 A8
La1=12.09 ym
Lb1=8.777 ym

X
Pb 1=323.2 Deg

Da1=15.03 ym
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Lc 1=303.4 Deg
Ld 1=106.1 ym?*
iLa 1P~ A
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wnén
E
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A44.7um

-~ < % .
Aperture Size = 30.00 pm \“ 4 Text S
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WD= 12mm

=
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h

2um
MAG= 1.95KX

Macro:dle. BB~ G o/ EHT-/

All selections are set to Unhide

23, SEM - MUSTERMANN]
Tle Edt View Beam Delecion Image Scarning Stage Vaguum Iook Heb
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is Unhide (visible). The image on the left shows a
number of the different annotation and measurement
objects. The images below show which type of
objects are hidden, when selecting the specific Hide
function.

o B sy
anDelecion Inage Scanning Stage Vagwm Toos Helbp

20.
MAG= 195KX WD= 12mm

For Help pess F1. Macio: e ISR/~ .~ Gun o/ EAT./

Hide Text/ Bitmap/ Line Annotation
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3.4 Menu: BEAM

m The menu “Beam” contains commands and settings important for the

— 5 adjustment of the electronic beam.
il Ete':t":'n {1305 =2 The commands EHT On and EHT Off will switch on or off the acceleration
| voltage. Emission switches over to the emission mode necessary for aligning

ErRr the filament (sed 4.3]5). The menu Accelerating Voltage... provides for
Gun Setup.. adjusting the current acceleration voltage. Selecting the menu Apertures... will
Errission result in the activation of the SEM Control window; the tab Apertures opened

(see 3.5).

The functions Stigmation... and Beam Shift... open separate menus to adjust the

Accelerating Yaoltage. ..

apertures... stigmator or the beam shift. Both parameters can also be set and adjusted in the
Stigmation... SEM Control window (see [4.3.9). In both menus it is possible to activate
Beam Shift... automatic correction of the astigmatism.

3.4.1 Gun Setup

The menu Gun Setup is available, without limitats, to LEO service staff, all settings for the ficld emission
cathode are set in this menu. Other users can open the menu but have only limited access to modify
parameters.

On the left side of the window Gun Service three parameters can be set: The parameter acceleration voltage (
EHT Target), available to every user, can be modified continuously. Users (Supervisor level) have the
ability to modifiy the filament heating current (Fil I Targef) within certain limits. Using the slider control,
the extractor voltage (Extractor V Target) can be varied within certain limits. This parameter is also
available to all users.

The right side of the window shows the current values of the filament. . Clicking Gun Parameters indicates
nominal, maximum and minimum values of the cathode. Modification of these values is only possible for
LEO service staff.

,ﬁ Gun Service Y03.00 (=l B4l /= Gun Parameters =] B
el [Hominal Fill = 2,240 4
Liner Target = 8.00 ki |Liner Tube = 8.00 kY
q = |Nomina| extractor v = 4,20 kY
| Hew Eilament ISUPP'BSSD' V= 300% |Extractor Trip Currert = 250 p&,
HT Taigst = 5.00 k¥ [EHT = B00 kY M E sractor V = 500 K/
4 L3
{Min Extractor 'y = 4.10 kv
[Fill= 23404

B>

Fil| Target= 2.340 A
: & I |

Extractor V¥ Target = 4.20 kW
gl =

Senyiee Hunup

|Entractor v = 4.20 kY

1|

| [Estracter | = 200,00 p4

BT FEset

| | Gun Parameters |

JEHT Cal@0. 1Ky = 100

|EHT Cal@ 10Ky = 10.00 kY

|EHT Cali@24Ky = 24.00 kY

|EHT Cal@a0Ky = 30.00 kY
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As modifications of these parameters will effect the life and the emission of the cathode, changes
should only be carried out by the person responsible for the instrument after discussion with the
respective service engineer.
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LED

The menu “Detection” provides selection of the different signal sources to be displayed on the monitor.
Detectors: lists the different detectors available for imaging. The currently active detector has a check. On
activation of the command Mixing two detector signals can be mixed. For further information on mixing of
detector signals see This function requires the software license SIGMIX.

If one or several TV cameras (chamber scopes) are adapted to the microscope, these cameras can be
activated using the menu TV Inputs.

Clicking X-Ray... will load the SEM Control window and display the index Tab X-Ray (sce which
enables the presentation of analog EDX distribution images on the screen.

Al v Inlens Detectars #

Miring SEZ2 Mixing
T4 Inputs  # OESD
#-Ray... -

3.6 Menu: IMAGE

I Th: i “Image” contins routines and

Scanning  Stage Yacuum Tools  Help commands to be wused for adjustment,

Signal Adjust...
Hoize Reduction...

Ereeze

Image Proceszzing...

Second Image Window  »

Find mage

optimization and processing of live or saved
images. It also contains the functions Second
Image Window and Image Gallery for the
display and edition of stored images. The
function Image Processing... can be used for
image analysis.

Load From Digplay ... Chl+2
Laad Fram Ei|E:

Image Galleny

T oggle Second Image

3.6.1 Signal Adjust- Noise Reduction- Freeze

| The menu Signal Adjust provides the capability to adjust brightness and

|5ignam=5E2

E

Brightress = 87.0 %

4]

B H

Contrast = 33.0%

H B

[

contrast of the current detector.

The command Noise Reduction will load the SEM Control window, index
tab Scanning which displays routines to save noise reduced live images to
the image store (see 1.3.2}.

The command Freeze will freeze the current live image in the image store,
the sample will not be scanned any more. A frozen image can be unfrozen
by clicking on Unfreeze.
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3.6.2 Image Processing (Requires the Licence: IMMATH)- Second Image Window

The menu Image Processing contains basic routines for image processing such as filters for saved images or
detection of special gray values in the image. For further explanations of the different functions see

The function Second Image Window opens a second virtual window to load saved images. It is possible
either to load the current image from the screen using the command Load from Display... (or CTRL+2), or to
load an image from a storage medium Load from file. The image can be moved by clicking the left mouse
button and moving the mouse within the window. Clicking the right mouse button in the virtual window will
open another options menu e.g. the command Zoom Area. This command will load the reduced image to the
window Zoom Area. Dragging the left mouse button selects a clipping area which will be displayed
enlarged in the window Second Image. Once again, dragging the left mouse button will move the image to
display the selected area. Images stored in the intermediary memory (see) can be inserted by using the
command Paste. The command Copy Selection will copy the clipping in the window Second Image to the
intermediary memory. Copy Entire Image copies not only the clipping but the entire image to the
intermediary memory. Clicking Print... will print the image on the default printer.

B1SEM - MUSTERMANN] [BIX] e SEM - MUSTERMANNI _181x]
Eile Edt View Beam Delection Image Scanning Stage Vacuum Tooks Help Ei View Beam Detection Image Scanning Stage Vacuum Tools Help

(1B m B| |31]2]3]4 )5/ =ma]®

RO i (1024x768 F

= S leo32\images\mustermann'

“
i a8  [~8 : -~ an -8 [~
. 1um EHT = 20.00 kV Signal A = SE1 U Tum EHT =20.00 kV Signal A = SE1
MAG= 528KX || WD= 12mm MAGS Dok WD= 12mm

Forbieh, ress F1 iscc:ide BBRRL) -\ [Guniy/ EAT:y/  For ek, prss 1 iscc:de WEHRRL -/ Gurio/ ATy

3.6.3 Find Image- Image Gallery

The function Find Image produces an automatic focus research in connection with changes of the
magnification. If a passably focused image is displayed on the screen, clicking Abort can interrupt the
function. This function is designed to help inexperienced users get an acceptable image on the screen as fast
as possible. Fine adjustment will follow manually.

To get a rapid overview on all images contained in the respective image directory use the command Image
Gallery which will display all images of the respective directory in stamp size in a separate window. You
will find more detailed information on the image gallery in

Auto Fn = Find Image

ANENEEREERN
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3.7 Menu: SCANNING

_ The menu “Scanning” contains all necessary options for scanning

Stage “acuum Toolz Help the sample. Clicking Speeds will open a menu for the selection of
the different scanning rates. If the license SCANEXP is installed,

v Momal 15 different scan rates can be selected.
Eeduced The command Normal switches over to normal scan rate, which
o means that the scanned sample area is displayed on the total screen.
Spiit ) ) .
Dual Mag However, adjustments can be done using the function Reduced.
Ep.:.t Explanations on the different special scan modes such as Reduced,
Line Scan Split, Dual Mag, Rotate/ Tilt.. and Dynamic Focus... are

contained in 6.3

#-Fap Line Scan . .
There are several other special scan rates such as Spot, Line Scan

Rotate / Tilt... and X-Ray Line Scan: The Spot mode will freeze the image; the
Diwnarmic Focus. .. electronic beam can be positioned with a cross to a special sample
Tyt o . area. This function provides point analysis, which is of importance
Store Reszolution A12 =384 ..
L ____ . for EDX/ WDX applications.
W 1024 % 7EB . . .
2048 * 1595 When using Line Scan, the sample surface will only be scanned
07 * 9904 along a line and the corresponding signal displayed in a line profile

(see ). X-Ray Line Scan has the same function with the
difference that it displays the EDX signals (see .

Store Resolution sets the respective store resolution of the image. As a standard, processing is done with a
1024 x 768 resolution. A higher store resolution can be selected for special applications such as re-
magnification of SEM images for a poster or zooming into images.

3.8 Menu: Stage

I T i “Stage” containsall submenus necessary for

Yacuum  Tool:  Help control of the motorized stage. Depending on the kind

o o of stage and the number of installed licences, control of
the stage is possible in different ways to solve user
Stage Control... specific problems or to simplify the work.
Stare / Recall.. It enables simple controls such as center point, center
Centre Point  Crl+Tab feature or stage mapping, but also complex activities
Centre Feature  Clrl+Shift+T ab such as use of the compucentric software, scanning of
Stage Scan... areas or use of the survey mode. You will find a
Stage Map detailed chapter (se|§| 5) to explain these different

Survey

eftings ... applications.

Survey Mode

3.9 Menu VACUUM

_ The commands Vacuum Status... and Specimen Change... will open the SEM
Control- window, index tab Vacuum which contains the most important
parameters of the vacuum system. This menu also enables the venting of the

Secimen Ch sample chamber and the start of the pumping procedure. More detailed
PECTEn =Tanee. information (see )

LPEWINOl Tool: Help

Wacuum Status..
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3.10 Menu: TOOLS

Bun & Macro

tacra Editar...

Goto Control Panel... Chrl+5
Goto Panel ...

Image Capture Mode
[Eamfre o
[mEael Eapture Erequenscy..

Uzer Preferences. ..

Adrminiztratar

LED

The menu “Tools” contains separate submenus to load and store
macros, load special menu windows and grab images automatically in
a defined frequency. It also allows opening the User Preferences (see
to establish special user specific settings for the LEO user
interface.

Clicking on TOOLS > ADMINISTRATOR in the LEO user interface,
will start the program ADMINISTRATOR (verses START->
PROGRAM—> LEO-32-> LEO ADMINISTRATOR, on the
Windowsg interface). Login to this program is only permitted to
authorized persons (Supervisor- Privilege).

3.10.1 Run a Macro - Macro Editor

The LEO user interface contains a standard Macro Editor, which processes certain commands one after the
other or in a loop. It is also possible to store special settings of the SEM in macros and to load them later on.
For more detailed information on the editor see [0]

SEM Control Dialogs

Cancel |
Aperture Calibration
Bakeout
Bearm Shift
Calibrate Stage Centre
Calibrate Stigmation
Carmpucentric Set Up
Ext Scan Control LI

Clicking TOOLS > GO TO CONTROL PANEL will open the SEM
Control panel.

Clicking TOOLS 2> GO TO PANEL will open the selection menu
SEM Control Dialogs where different menus are listed. After
highlighting a menu and confirming with “OK” the corresponding
menu will be opened. In the table below you will find an overview of
the different menus.

Available Menus Explanation

4QBSD Control Control of the various operating modes of the four quadrant BSD (see .
Airlock Control of different airlock functions for sample exchange (see .

Bake out Control of the IGP bake out, selection of the heating and cooling times (see

Beam Shift Control of the electronic beam shift, and auto stigmatism (see 3.4).

Calibrate Stage Center Calibration of the stage center, essential for the use of Stage Horizontal
Alignment and Compucentric Set Up (see [5.9.1).

Calibrate Stigmation Calibration of the stigmators; (only available to LEO service staff).

Compucentric Set Up Calibration of the tilt correction for the compucentric software (see .
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Ext Scan Control

Switching to external scan control.

Input LUT

Loads the Input LUT panel (see [3.2.1). This menu enables special
adjustments of the input signal of a detector.

Magnification Calibration

Calibration of magnification to different output media (see .

Rotate/ Tilt Displays the control panel for Tilt compensation, Dynamic focus and Scan
rotation (see .
Signal Adjust Adjustment of brightness and contrast for a selected detector (see .

Specimen Current Monitor

Displays the control panel for the specimen current monitor. Requires SCM
option (see .

Stage Horizontal Alignment

This function allows the definition of a line on the stage by means of two
marks. The motorized stage will rotate to place this line horizontally in the
image plane. (see .

Stage Limits

Setting of limits for the motorized stage axes (see ).

Stage Points List

Storing or loading saved stage positions (see

Stage Registered Movement

Control of the stage in a user specific, defined system of coordinates (see

Stage Registration Definition of a user specific system of coordinates for the motorized stage
by means of two or three registration marks (see 5).

Stage Scan Imaging a sample area as a series of exactly defined, image areas (see

Stigmation Stigmator adjustment (see 3.4).

Water Flow/ Temperature Window to control the cooling water circuit (see p.6].

3.10.2 Image Capture Mode

The image displayed on the screen, (1.) Windowsg Overlay (status bar, toolbar etc.) and (2.) SEM image
(live image or stored image), is in fact a double image. The scan area of the Windowsgs Overlay is
transparent. The SEM image behind the Windowg interface is thus visible and can be displayed on the

screen.

For example, pressing “Print” on the keyboard will write a bitmap of the screen content to the intermediary
memory. This bitmap can be inserted into different Windowse programs. However, this image will only

show the Windowg Overlay.

The area containing the SEM image will be displayed as a green or orange

field. The reason is that the SEM image does not exist in the image store read by the Windowsg System.
To avoid this effect, select Image Capture Mode which freezes the current live image and stores it together

Image Update Frequency

Update

Itterval [rz]
Im 3 Cancel |
Enahled v

28

with the Windowse Overlay. This image can be inserted into other Windowsg
programs. The symbol for this stored image is a red triangle (7) in the lower
right.

Clicking the Pop-Up menu TOOLS-> IMAGE CAPTURE MODE will
activate the menus Capture Now... and Image Capture Frequency.... The
selection of Capture Now... will initialize the single execution of Image
Capture Mode. The selection of Image Capture Frequency... will result in a
continuous execution of this mode. This requires selection of TOOLS
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—IMAGE CAPTURE FREQUENCY. Enter an interval of 0.5 to 32 seconds in the field Interval.
Confirming with “OK” will close the window and execute the routine Image Capture Mode continuously in
the selected intervals(e.g. every 2,5 seconds). To close the routine, select again the TOOLS 2> IMAGE
CAPTURE MODE..

3.11 Menu Help

The LEO 32 interface is equipped with an extensive help. The different Help texts can be viewed using the
Pop-Up menu HELP. It is also possible to select a context sensitive help. More detailed information on the
different Help texts and on working with the Online Help see chapter E
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4 The LEO 32 User Interface

All parameters of the electron microscope can be set using the LEO 32 user interface. This user interface
consists of a Pop-Up menu, a status bar and a toolbar for the selection and adjustment of all functions and
parameters. Selection is by clicking the left mouse button on a special menu item or by activating a symbol
in the toolbar. Most of the symbols have a double assignment, which provides the ability to activate different
functions or parameters by clicking the left or middle mouse button (see .

4.1 Starting the Microscope in Stand-by Mode

To start the microscope from stand-by mode, press the START button on the plinth panel (or computer). This
boots the integrated computer and the operating system  Load the user interface by selecting START->
PROGRAMS > LEO 32> SEM USER INTERFACE, or double-clicking the LEO ICON.

The first step is to switch on the EHT (and eventually the filament). Click EHT in the status bar with the left
mouse button and select EHT ON, the GUN and then EHT will switch on and run up. After run up, the red
(X) will switch to a green (V), an accelerating voltage between 5 and 10kV should be set by clicking the EHT
symbol or double clicking EHT in the DATA ZONE.

an SEM - [SER¥ICE]
File Edit “iew Beam Detection Image Scanning =

234/

| m |
| Bl g5 1
EHT O
Gun EI: —fE Parameter ¥alue I:

Macro: Idle Fine  Maciy” [Gun: 3¢ EHT:Yﬁ - o= oo [KY]

fid

Cancel |

After selection of the corresponding high voltage open the SEM control window (CTRL+G) or TOOLS >
GO TO CONTROL PANEL). The index tab Detectors (see [4.3.1) enables the selection of a detector. For
working distances beyond 10mm select the SE2 detector for the signal source. It is recommended that

inexperienced persons have the signal set automatically at the beginning of their work by setting Signal
Adjust to Auto BC= BC (sce £.3.1).

4.1.1 Setting Parameters Using the Mouse

Adjustment of the focus. Activate mouse control by clicking the magnification/focus ICON with the left
mouse button. The status bar indicates the function of the mouse button. The left mouse button is for
magnification and the middle mouse button for the focus (see green and yellow fields).

@ LB: Mag= 790 ME:wD = 10mm [Macro: Idle Fine  Waciy” Guniy” EHT: ‘,.p:|
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The alignment is done by pressing the specific
mouse button and moving the moving the mouse
left or right. Similar to operating a potentiometer
the level increases or decreases depending on the
direction of the movement. The cursor of the mouse
has to be within the image area.

This concept is the same for all mouse-operated
functions.  Clicking on the ICON for
brightness/contrast (see) will reprogram the
assignment of the mouse buttons. The left mouse
button will be set to control the brightness and the middle mouse button will be set to control the contrast,
the status bar displays these changes. It is also possible to enter absolute values for a specific parameter. To
do so, click the corresponding parameter in the status bar with the left mouse button and enter the value.
Two settings are possible for the sensitivity of the mouse control: Coarse and Fine. Switching between these
settings is done by clicking Coarse/ Fine in the status bar or by using the tab key on the keyboard. The
inexperienced user may want to use, at high magnifications, the fine setting of the mouse control, as the
coarse setting will result in large changes with even small mouse movement.

1

7

decrease increase

4.1.2 Optimization of Images

After adjustment of the focus the area of interest on the sample can be selected. Depending on the kind of
sample, high voltage and aperture (see ) should be set. Adjustment of the working distance (focus)
should be done depending on detector selection and high voltage.

Imaging by means of SE2 detector:
Imaging by means of In lens detector:
- Imaging by means of BSE detector:
EDX analysis (depending on imaging angle):

>5mm WD

<= 10mm WD (depending on high voltage setting)
8-10 mm (Optimum of the BS electron detection)
9 mm WD

After optimum setting of the high voltage and the working distance for the respective sample, it will be
necessary to adjust the other parameters influencing the quality of the image, such as focus, correct aperture
setting and correction of the astigmatism. Brightness and contrast can be adjusted manually depending on the
image. Use of a reduced scan is optional for the adjustment of focus, aperture alignment (if necessary) and
stigmation.

After having reached an optimum brightness and contrast adjustment, the image will be saved into the image
store by means of noise reduction (see) and frozen there. Freezing of the image means that the content
of the image will not be updated. The electron beam will be blanked off the beam path by means of the
electromagnetic aperture switch and the sample will not be scanned any more. Setting of the blanking of the
electron beam is done in the User Preferences (sce ). The frozen image state is indicated by a blue dot
(®) in the lower right corner. Frozen images can be stored in a storage medium or printed using a printer.
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4.1.3 Closing the User Interface

After the end of the session, the user interface can be closed by clicking FILE-> EXIT or FILE> LOG
OFF using the Pop-Up menu. The user will be asked whether the set parameters are to be saved. Confirming
with “Yes” will store these parameters (signal source, high voltage, focus etc.) in a macro (Restore4.mlc) in
the corresponding user directory. This macro can be activated later on to reset the microscope to the saved
conditions. A confirmation with “Yes” should be used only if proper start up conditions are set on the
microscope, i.e. high voltage, selection of a detector and appropriate adjustment of the other parameters.
Activation of this macro will thus result in an immediate usability of the microscope. Clicking “No” means
that no macro will be created and no existing macro will be rewritten.

1 SEM Control ]

@ Do you want to save the SEM conditions?
Hao

It is not necessary to close the software for short interruptions of the work on the microscope. Switching off
the high voltage will be sufficient.

For longer periods, such as for the night or for the week-end, the electron microscope should be run down to
the stand-by mode by first closing the user interface. After that, close the operating system Windowsg and
switch off the integrated computer by using the Standby button (middle yellow button) on the plinth.

The voltage can be switched off for maintenance or repair works by using the red key. This will
/i\ switch off all electric or electronic components. Before switching off completely, run down the
cathode manually using the user interface.

4.1.4 Saving and Loading Special Instrument Parameters

As indicated in the conditions of the microscope can be saved in a macro at the end of a session.
Clicking FILE-> RESTORE in the Pop-Up menu will activate this macro to reset the data saved in the
macro. By doing so, the instrument will be reset to the operating conditions just used. Manual adjustment of
high voltage, detector and focus will not be necessary.

Save Syztem Conditions i

—Select conditions To Save S ave Macro To File |

v Save Configuration

W Save Gun Conditions Enter & File Mame IStE'ltE'I -l

v Save Setup Conditions

v Save Application Conditions OF. I Cancel

Cancel

It is also possible to save different special conditions while working with the microscope by opening FILE 2
SAVE STATE.... A window will open to determine the parameters to be stored. After confirming with “OK”
the macro can be given a separate name. This macro will be saved in the corresponding user directory,
allowing the storage of most instrument settings.
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To load specific operating conditions, click FILE=> LOAD STATE... to open a list containing the different

(macros) operating conditions saved in the user directory. Selecting a macro and pressing “OK” will start the
macro and reset the stored parameters on the microscope.

/i\ Stage coordinates will not be saved in these conditions. Please use the window for the storage of
= i stage coordinates as explained in
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4.2 The Standard Toolbar

The toolbar gives access to all frequently used functions and parameters. Activation of the ICONS in the
toolbar is by use of the left and the middle mouse button. Dragging the mouse cursor over a ICON will
display a short explanation (Tool Tip) on the function of the corresponding ICON at the lower side of the
mouse cursor (see.

m: SEM - [SERYICE]
File Edit “iew Beam Detection |mage Scanning Stage “acuum Toolz Help

Bl |:t1]2]3]4]5]¢/nL]E]Lf0@

Clicking on the symbols will activate either settings or control windows. The status bar will indicate the
assignment of the left and middle mouse button, such as magnification (left mouse button) and focus (middle
mouse button) in the example below. The status bar also allows the activation of commands for the vacuum
(VENT/ PUMP), the filament (GUN ON/ OFF) or the acceleration voltage (EHT ON/ OFF) by clicking
VAC, GUN or EHT. The sensitivity of the mouse control can be set using FINE/ COARSE. Certain macros

[_[5]x]

-

£

il

E

) 12 &8

of the software can be activated by clicking the window MACRO: IDLE.

Bun & Macro

sew Eurentlr Executing M acrolz]

ILB: Mag=_ 730 [MB: WD = 10mm [Macro: ldie Fine  [Wac: o [Gun: o EHT: o ,pj|

Name Symbol | Left mouse button Middle mouse button

Restore % Loading the last condition as saved | Opens the window to load a saved
when ending the program condition (Load State).

Accelerating d Setting of the desired acceleration Open of the index Tab Gun in the

Voltage = voltage SEM Control window

Specimen Change

o

Activation of this symbol will start

the pumps if the chamber is vented.

Activation in operating conditions
will run down the high voltage and
start the venting of the chamber. A
window will open allow to restart
the evacuation of the chamber after
exchange of the sample

Open of the index Tab Gun in the
SEM Control window

Pix Avg.1/
Cont Avg. 2

Pixel averaging at scan rate 2

Continuous image averaging at
scan rate 2

Pix Avg. 3/Cont
Avg. 4

Pixel averaging at scan rate 3

Continuous image averaging at
scan rate 4

Pix Avg. 6/ Cont
Avg. 6

Pixel averaging at scan rate 6

Continuous image averaging at
scan rate 6

Pix Avg. 9/
Frame Int. 5

BN =

Pixel averaging at scan rate 9

Image averaging at scan rate 5
(freezing of the image after
execution)

34
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Frame Int. 7/

Image averaging at scan rate 7

Image averaging at scan rate 8

Frame Int. 8 (freezing of the image after (freezing of the image after
execution) execution)
Faster/ Selects one faster scan rate per left | Selects one slower scan rate per
Slower mouse button click middle mouse button click
Freeze/ Freezes/unfreezes an image
Unfreeze
Normal Mode Normal screen mode, switch-off of
the wobbler. Assignment of the
mouse button: Left Mouse =
Magnification/ Middle Mouse =
focus
Reduced Raster Switches between reduced scan and

normal screen mode

Split Screen

Switches between split screen and
normal screen mode

Dual
Magnification

Switches between dual
magnification and normal screen
mode

Chamber scope

o sHbkE O =

Activation of the CCD camera,
mouse button assignment:
Brightness /contrast

Open of the index tab Detector in
the SEM Control window

Stigmation
Alignment

Activation of a reduced scan,
assignment of the mouse buttons:
Left Mouse = Stig. -X, Stig. -
Y/Middle Mouse = Focus

Activation of the wobbler and of
reduced scan if (Tools 2> User
Preferences. 2> SEM Conditions >
Focus Wobble> Reduced Raster
is switched to ON), mouse button
assignment: Left Mouse = Aperture
Align XY/ Middle Mouse = Focus

Point-point
text annotation

Inserts a point-to-point
measurement

Opens the text editor

Toggle INLENS/ ; e/"‘ Toggles between In lens and SE2 Opens the index tab Detector in the

SE2 s detector SEM Control window

Brightness/ (]D If Auto BC is deactivated in the Switches:

Contrast i Detector window, mouse Auto BC=ON (mouse button
assignment will be switched to assignment GAIN/OFFSET)
brightness/contrast.
If Auto BC is activated, mouse Auto BC=OFF (mouse button
assignment will switch to assignment Brightness/Contrast)
GAIN/OFFSET

Magnification Mouse button assignment: Opens the Auto Focus & Auto

Auto Focus/stig.

magnification/focus

Stigmator algorithms

LEO Electron Microscopy Ltd
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Export TIFF file

Saves the image as a TIFF file with
the assigned settings

Opens the Export TIFF window

Print Image

I &

Prints the image on the default
printer

Opens the Print Setup window

36
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4.3 The SEM Control Window

The SEM Control window contains all parameters necessary for the control of the microscope. This window
provides the ability to read and set all parameters necessary for the operation of the microscope. Open this
window by using the key combination (CTRL + G) or TOOLS 2 GO TO CONTROL PANEL. This window
is subdivided into seven index tabs containing the following components:

* Detectors:  selection of the detectors, signal adjustment, mixing of signals (requires the License:
SIGMIX), Gamma correction, inversion
* Scanning:  noise reduction, scan rates, spot, live and X-ray line profile

* Vacuum: Start of pumping and venting, displays values on vacuum system
* Gun: switching on and off the acceleration voltage and the filament, important settings of the
filament

* Apertures: selection of the aperture, alignment of the apertures and of the filament, emission mode,
image optimization

* Stage: stage coordinates, entering relative and absolute coordinate values, special stage settings

* X- Ray: Setting and starting analogous EDX mappings.

Below is a more detailed explanation of these components.

4.3.1 Detectors

Standard equipment on the LEO 15xx (except LEO 1525) is two secondary electron detectors(in-lens and
chamber (SE)). Reading and setting of all relevant detector parameters is via the index tab Detectors. The
chamber SE detector, Everhart-Thornley, is suitable for the detection of SE electrons at longer working
distances (> 5mm). By using the inlens detector, very good images are obtainable at low acceleration
voltages. However, this detector should only be used at short working distances (<10mm). Another
advantage of the Inlens detector is its high efficiency with regard to the detection of SE; electrons. These
electrons develop in the immediate spot center. The position of the InLens detector within the beam path
excludes the detection of back-scattered electrons and secondary electrons of the categories SE, and SE; .
Thus, imaging with the Inlens detector will give pure information on the surface of the sample. BSE
detectors of different types can be adapted optionally.

SEM Control =]

Gun | Apertures | Stage I =Hay |

Detechors I Scanning I Wacuum
— Detector PE

|Signal & = InLens | | Collector Bias = 300 InLens- Detector

1 B
ISignaIB=SE2 vl el 0 oo -
Signal = 0.6200

¥ Mising 4 _I _»I

i~ Signal Adjust Input LUT kode—— SE2-D
- Detector
| BSE- Detector
& Transparent
Brightness = 93.0% ' Gamma
A A ey B
8| C Irwerse
Contrast = 43.0 % C User
¢ ] Collector
Gamma = 1.000
= 1|
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Signal A= or Signal B= provides the ability to select the different detectors to be used as a signal source.
Signal A will always be the active signal displayed on the screen. Activation of the control box Mixing
allows mixing of two detector signals by means of the slide bar Signal in a range of 0.000 to 1.000 (0 -
100%). The example shows a 62% signal from the In-lens detector and a 48% signal from the SE2 detector.
Collector Bias will vary the collecting potential of the chamber SE2 detector between -250V -> +400V.
Signal Adjust selects the different adjustment modes for the detector signal (Auto BC=OFF: brightness and
contrast must be done manually, Auto BC= ON: brightness and contrast will be set automatically by the
system).

It is recommended that when beginning a work session use Auto BC and adjust brightness and contrast
manually after alignment and optimization of the image.

By selecting Gamma in the control box Input LUT Mode the transfer function of the input signal can be set
to non linear using the slide bar Gamma. This function is used to improve images containing a lot of
information within a small number of gray scales.

Selecting Inverse in the control box Input LUT Mode will invert the input signal. By selecting User, user
specific settings, which can be set and saved using EDIT 2 INPUT LUT, can be applied to the input signal.

There is a separate configuration window for the four-quadrant BSE detector. This window can be opened
using TOOLS 2> GO TO PANEL > 4QBSD CONTROL. Each quadrant of the detector can be set to one of
the three conditions Off, Normal or Inverted. Two predefined quadrant configurations are available. The
optimum material contrast (COMPO) will be obtained by pressing the key BSD: COMPO whereas the
optimum topographic contrast (TOPO) will be obtained by pressing BSD: TOPO. The selection of these
predefined conditions will switch the quadrants of the detector according to the illustration below. Some
applications may require a change to the quadrant configuration, set the individual segment settings as
required and press BSD: Set TOPO. These settings will be remembered and used whenever the TOPO
command is given.

The control window BSD Gain shows the current Gain setting of the amplifier. If the BSD Auto Range is
checked the signal contrast level automatically sets the Gain. For more precise setting of BSD contrast,
deselect BSD Auto Range and select a Gain setting suitable for the sample. The contrast adjustment range
now covers the selected gain range. The control box BSD Fast sets the bandwidth of the amplifier, it is
switched on for normal visual scan rates and switched off for slower scan rates.

COMPO TOPO
r— Duadrant

IQ'I = |rverted j IE!2 = |mverted j

|Q3=N0rmal j |Q4=N0rmal j

o Q2
Inverted Inverted

— Mode

BSD.COMPO |
¥ BSD Fast
BSD:TOPD |
L T

[BSD Giain = Law =l

Compositional (or Atomic Topographical imaging
Contrast) imaging

38 LEO Electron Microscopy Ltd



LED

Hlustrations with different signal sources:

ustration with the SE2 detector at a positive collector voltage (+ 400V). The
image shows a regular illumination of the sample and bright contours (edge
effect). The topography can be distinguished very well whereas the material
contrast is weak.

[lustration with the Inlens detector. Although the image shows a very flat
illumination of the sample, structures can be recognized which could not be
seen on the SE2 image. Material contrast and topography are weak..

The mixed image between Chamber SE Detector and Inlens SE Detector
shows topography and fine structures. The effect can be continuously adjusted.

Imaging with the SE2 detector at negative collector voltage (-250V). Only high
energetic back-scattering electrons are detected The image shows an extremely
strong topography with shadows. The material constrast is almost completely
absent

Imaging with a BSE detector. The image shows only small surface contrast,
but differences in material can be distinguished very clearly. The topography is
imaged weakly.
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4.3.2 Noise Reduction

The index tab Scanning provides all settings for optimum scanning of the electron beam and for noise
reduction as well as the selection of the different scan modes.

Operating Mode: Selection of the different screen displays (reduced scan, normal imaging, split screen,
emission image)

SEM Conirel Store Resolution:
o Setting Qf the store resolution of the image. The following four resolutions
Detectors Seanning | Wacuum are pOSSIble:
Operating Mode = Momal 5
:si — resgnlunmzmwm j 512 x 384 (required storage capacity of the image: 0,2 MB)
_ 1024 x 768 (Required storage capacity of the image: 0,8 MB)
;;’; . SR | 2048 x 1536 (Required storage capacity of the image: 3 MB)
I Spot Eyele Time - 334.00 ms 3072 x 2304 (Required storage capacity of the image: 7 MB)
mo S The selection of Store Resolution will produce effects on the Cycle Time
Noise Redction and on the required storage capacity of the images to be saved.
[Freeze on = Command = The normal resolution,1024 x 768, provides sufficient image quality even
o
o Fegoion—Focti 3 when printing in 82 X 11 format.
Drwvell Time = 100 ns i
I L Scan Speed:
el ] e Selection of the different scanning speeds.

Cycle Time:

Indicates the time necessary to enter the complete image into the image store. This parameter depends on the
selected Store Resolution, Scan Rate, Dwell Time and Line integration or averaging (N value). The Dwell
Time indicates the time the electron beam will remain on a pixel field (nano-second) during a scanning pass.

Line Scan:
Scanning activation of the electron beam along a defined line. The image will be frozen. A horizontal line
and a histogram will be displayed on the screen indicating the course of the signal along this line.

v Dark Blue
Doark Green
Turquoise
Drark Red
[rark Purple
el
Drark Grey
Wihite
Blue
Greeh
Light Blue
Red
Purple
b Listard

BT oG

——

Line Profile Off
Freeze Line Profile

Clicking the left mouse button on the line will allow the line to be moved to the desired sample spot. This
function is useful for the measurement of certain structures by means of the signal histogram. Two vertical
lines are shown within the histogram panel which can be dragged with the left mouse button. The upper left
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corner of the diagram indicates the distance of these lines from each other. Clicking the right mouse button
within the diagram displays a menu allowing special settings of the color of the graph and offering the ability
to freeze the line profile.This profile can be saved together with the image by activating the item Annotation
in the menu Export TIFF (see [1.5.1).

X-ray Linescan:

The selection of this function results in an image identical to line scan as explained above. However, this
diagram displays the intensities of EDX signals along the determined line. The different EDX signals
(corresponding to the energy of the selected emission line and thus to the atomic number) are defined in the
respective software of the EDX system. Special types of imaging can be selected within the diagram by
clicking the right mouse button.

Spot:

Selecting the Spot mode will freeze the image and display a cross on the screen. This cross can be dragged
arbitrarily in the image by pressing the left mouse button. This will position the electron beam onto the
selected spot. This function is intended for point analysis by means of an EDX system. .

Dual Mag:
Selection of this function will activate the clip magnification. The size of the respective clipping can be
modified from 1 to 10 by means of the slide switch Zoom factor = .

Noise Reduction:

Freeze on =: Determines the method of freezing the image. Selecting COMMAND, the user will decide
by pressing the key “Freeze” or “Scroll Lock” when the image is to be frozen. Selecting END FRAME,
will result in an automatic freezing of the image after scanning one complete frame.

Noise Reduction=: selects the type of noise reduction. Selecting Pixel Avg. will use the selected SCAN
RATE for the noise reduction. The higher the selected Scan Rate, the slower the scanning of the
corresponding sample area, thus reducing the noise level in the image. Selecting Frame Avg. will provide
noise reduction by taking several image frames and integrating them into the image store. When selecting
this function, SCAN RATE is a pseudonym for the number of images to be integrated (see table).

SCAN RATE | Number of | SCAN RATE | Number of
images images
1 2 5 32
2 4 6 64
3 8 7 128
4 16 8 256

As already explained, Dwell Time determines how long the electron beam is to remain at a pixel position.
The selections 100, 200, 400 and 800 nanoseconds are available. The image will be frozen automatically
when the selected number of images has been taken and integrated. The function Continuous Avg. is similar
to Frame Avg., the difference being that the image is not frozen automatically. This selection will update the
image store continuously. The selected number of images will be scanned continuously, the keys “Scan+”
and “Scan-" allow switching to faster or slower scan speeds. Pressing the key “Freeze” or “Scroll Lock”
will freeze the image in the image store and assign “Unfreeze” to the key.
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4.3.3 Vacuum

The index tab “Vacuum” displays the vacuum in the chamber and filament area and controls certain
functions and valve settings. The pressure measuring unit can be set to Mbar, Torr or Pa within the LEO 32
software (see p.1).

The key “Vent” allows venting of the chamber (with High Tension (EHT) off). After exchange of the
sample, pressing the key “Pump” will restart the pumping procedure. If you do not want the pumps to
continue working in standby mode, activate the function Partial Vent on Standby. This will result in a partial
venting of the chamber when the microscope is switched off using the Standby button. Partial venting will
assure that oil vapours from the roughing pump do not enter the chamber in standy mode. Starting the system
by pressing the “Start” button will automatically activate the pumping procedure.

/’\ When starting the bakeout of the IGP in stand-by mode, Partial Vent on Standby MUST BE
= % deactivated before closing the software!

System Vacuum: Vacuum in the chamber.

SEM Control =]
Gun | Aperues | stage | #Raw | . . . . .
Detsctors | Soanning Vastum Gun Vacuum: Vacuum in the gun and in the liner tube. Deterioration of
[System Vacuum = 2.906-006 mBar this vaccum to the upper 10°- level (8 79 X 10” mbar), indicates a
[Giun Vatuum = 4. 30e-008 B bakeout of the IGP should be performed soon (see 6.2). |:|
fivent inb. = Mane
ac Status = Freay Vent inh.: Status indication for the venting of the chamber.
|Colurmn Chanber valve = Open
[EFT Vo ooy ver Vac Status: Status indication for the release of the vacuum (chamber).
[Column pumping = Ready . . .
e o Column Chamber valve: Indication of the position (open/closed) of the V3
valve between liner tube and chamber.
[ Partial Vert on Standby
EHT Vac ready: Status indication of the high voltage release..
Column pumping: Status of the vakcuum release (gun and liner tube)

4.3.4 Cathode

A thermonic field emission cathode, Schottky emitter (ZrO/ W
cathode), is used to produce the beam. This Schottky FE cathode
consists of a finely etched, <100> oriented Tungsten Mono
Crystal with a sintered reservoir of zirconium oxide at the shaft.
The heating current (Fil. I) will diffuse the ZrO to the filament
tip reducing the work potential for emission of the electrons from
4,6 eV to 2,8 eV. Depending on the filament temperature and the
field strength generated at the filament tip by the tension of the
extractor electrode, equilibrium will develop allowing a stable
emission of the FE source.

The most important filament and high tension data as well as special presettings can be found and set in the
index Tab, Gun in the SEM Control window .

gun base

filament
suppressor electrode

extractor electrode
anode
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SEM Control =] EHT: . .
Indicates the current acceleration voltage in kV.

Detectors | Scanning I Yacuum |
Gun I Apertures | Stage | w-Fay

JEHT = 0.00 kv Extractor V:
[Estiactor v = 660 K Indicates the value of the extractor voltage.

[Estractor | = 270,30 pb

JFii= 22404 Extractor I:

[Boam Stete = ERT 0O - Indicates the current value of the extractor current

V¥ Leave Gun On at Shutdown

I EHT 0Off @ Log OFf Fil- I-'

E Targel = 2240 - Indicates the current value of the filament heating current
EHT Target = 10.00 kY

LI i 2l Beam State:

This menu switches on or off the EHT (EHT ON/EHT OFF). Selecting

Ellractor\p’ Target = 5.80 KV
“Shutdown” will slowly shut down the filament

|

Activation of the control box Leave Gun On at Shutdown will exclude shutdown of the filament when
closing the software and in standby mode of the system

In Leave Gun On at Shutdown, Shutdown refers to exiting the LEO-32 software and setting the
microscope to standby mode. In the menu Beam State, Shutdown means the manual shutdown of the
filament.

o=

EHT OFF @ Log Off:
Activation of this control box will automatically switch off the EHT when closing the software, using Log
Off or Exit.

Fil. I Target:
The filament heating current can be modified within certain limits by means of this slide switch. When
exiting the LEO-32 software, the modified value will be reset automatically to the initial value.

EHT Target:
This slide switch provides the ability to set the acceleration voltage continuously.

Extractor V Target:
Changing the extractor voltage as for Fil. I Target.

Clicking the right mouse button in the lower right side of this window will display the menu User Max

EHT... and allows the maximum value of the acceleration voltage to be set or changed. This setting requires
the privilege Supervisor (See .
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4.3.5 Apertures

This index Tab provides the ability to select the different apertures and to perform adjustments of the
apertures, filament and the electron beam..

Aperture Size:
Detestas | scaming | veewm || Selection of the different apertures
G“:pertweszze"m L (1) 30 um aperture: standard aperture to solve most microscopic and
1) 3000y - Standard | analytic problems
I FocusWabble [7 /osble Fac (2) 7.5 um/ (3) 10 um/ (4) 20um apertures: apertures for highest resolution
Iﬁlobb‘e e and beam sensitive samples
- - (5) 60 um/ (7) 120 um apertures: apertures for analytic problems requiring
I BeamBbnkes _ Erision | very high probe currents (e.g. EDS, EBSP).
tag / Focus | W
Apeture Ao | =] Focus Wobble:
Gun Alan_ | ] Activation of this control box will switch on or off the focus wobbler
Stignation_| i necessary for the exact alignment of the selected aperture in the beam path.
peanshit | [ T o] A lateral drift of the image when adjusting the focus indicates that the beam
is not passing through the aperture center. Activation of the Focus Wobbler
will result in a movement of the image in vertical and horizontal direction.
Perfect alignment is shown as an image which will defocus without image

shift.

Aperture adjustment:

1.) Activate the control box Focus Wobble, adjust the Wobble Amplitude by means of the slide bar and
adjust the Wobble frequency by activating or deactivating Wobble Fast.

2.) Clicking the key Aperture Align, assigns that function to the navigation box.

3.) Adjustment of the aperture in X and Y direction is by means of the slide bar in the navigation window
(or by dragging the mouse, in X and Y directions with the left mouse button pressed) or (by dragging the
red dot in the box with the left mouse button).

4.) Adjust both the X and Y directions until there is only pulsation of the image (no swinging to one side)

5.) Deactivate the control box Focus_Webble and refocus the image.

The optimum adjustment of the aperture in the beam path has a decisive influence on the resolution and
focus of the image. The aperture should therefore be realigned when image shift is present during focusing
(after an aperture change or large change in the EHT setting)

Beam Blanked:
The electron beam will be blanked off the beam path by means of the electromagnetic aperture switch (no
scan of the sample).

Emission:

This key activates the emission mode necessary to center the filament (SERVICE FUNCTION). The
emission image and a graticule will be displayed on the screen (after activation in User Preferences sce .
Clicking the key Gun Align will adjust the beam profile image to the proper position by using the slide bar
in the navigation window (or by dragging the red dot with the left mouse button). To do so, the aperture must
be centered. Re-clicking the key “Emission” will switch back to normal scan mode.

The emission mode is to be used mainly by service staff. If not careful the user may miss-align the
/j\ column and cause a decrease of image quality and resolution. The position of the optimum signal
output does not absolutely mean that the emission image is positioned exactly in the center of the
graticule.
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Key Mag/ Focus:
Switching the mouse button assignment (left mouse button magnification, middle mouse button focus)

Key Stigmation:

Switching of the mouse button assignment (left mouse button Sigmation X / Stigmation Y, middle mouse
button focus) and selection of the stigmator for the navigation window.

Local magnetic fields due to local electric charging on inhomogenious samples will produce an elliptic
electron beam and an inexact focussing of the sample surface as the elliptic electron beam will distort the
sample structure when focussing. To restore a rotation symmetry of the electron beam, an electromagnetic
correction field created by the stigmator will be necessary.

In order to obtain a correction of the astigmatism, an intermediary position between a under and over focused
image will be set by means of the focus control. The structures will be unsharp in the X and Y direction.
Clicking the left mouse button and dragging the mouse to the right or left or by means of the navigation
system, the stigmator will be adjusted in X direction. This will be done visually to obtain an optimum
imaging quality. After correct adjustment of the X direction the same will be done in Y direction (by
dragging the mouse up and down).It is also possible to adjust both directions at the same time. After the
correction, the image should be displayed in optimum sharpness

Key Beam Shift:

Switching of the mouse button assignment (left mouse button, Beam Shift X / Beam Shift Y), middle mouse
button keeps the previous assignment) and selection of Beam Shift for the navigation window.

By means of Beam Shift, The electron beam can be moved in the X and Y direction by 20um each. This
function is suitable for higher magnifications when an exact positioning of the area of interest by stage
movement may be difficult. However care should be taken that the stigmator may need to be readjusted if
the image is moved to the limits of the shift range. (large displacement in X and Y direction).
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4.3.6 Stage
SEM Control =| This index Tab Stage displays the current position of the stage, allows a
Detsctors | Seamina | veewm | | USer to enter absolute and relative coordinates or to activate or deactivate
= L T special pre-settings for the stage. The column Stage At indicates the current
. I% lﬁ e coordinates of the different axes. To enter absolute coordinates for the
| e e stage, double-click the value of the corresponding stage axes in Go To with
2 [azanm | [oonm | L2 the left mouse button. This opens a window allowing the user to enter a new
T 00020 | 000eg |1 value, the stage will then move to the new position. Relative coordinates for
R [70ea | [C0Des | A | the different axes may be entered in the column Delta by clicking the
1 [ | [T corresponding key. It is also possible to enter negative values.
Compu Mode =0 = The selection field Compuc. Mode activates or deactivates the
Stage s - die compucentric operation of the stage. However, this requires the license and
[ 2 move onVent [ Joystick Disable the calibration of this software option (see .
L= T The window Stage Is = indicates whether the stage is idle or busy.
W Clicking on “Stage Stop” will stop the stage immediately.
’7 Stage stop |

Z move on Vent:
Activation of this function will result in an automatic stage move to the lowest Z position whenever venting
of the chamber is initiated.

Track Z:
Selection of this function will provide automatic readjustment of the focus as the stage Z movement is
changed.

Protected Z:

Activation of this function will produce automatic comparison of the current Z coordinate to the new
coordinate when opening saved stage positions.. If the new Z position is higher than the current position, the
X/Y/T/R coordinates will be located before moving to the new Z position. If the new Z position is lower, Z
will be changed before the other coordinates.

Joystick Disable:
Switches on and off the hard panel joystick.

4.3.7 EDX Mapping (Requires the Licence: XRAY)

This Tab allows settings for binary EDX mapping and starting the record of mappings. By means of this
option, scanning and imaging of binary output signals of an EDX system are possible, provided that the
signal lines of the EDX system have been installed and configured correctly on the EDX interface of the
SEM. Each of the regions of interest sends pulses from the EDS system for a selected energy range (the
setup of the regions of interest is done through the EDS system). These pulses will be accumulated on the
base of the image pixels and give information on the element mapping.

A maximum of 7 channels may be scanned and displayed on the screen simultaneously. Clicking Energy
Window Setup will determine the channels to contribute to the mapping by activating the figures 1 to 8.

The windows WIN2 to WINS8 (WINI being reserved for simple mapping) allow asigning short names to the
different channels in order to create a reference to the numbers of the energy windows used in the EDX
system.

A different color may be contributed to each element to be imaged in the mapping. Clicking the keys
enables selection of the colors in a range of colors.

13 2
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Detectors | Scanning
Gun | Apertures | Stage H-Ray

r— Energy Window Setup———

1 e |
or e [ |
o s |
|
sr* e [ L. |
o e I |
7 fwing | [

o e |

| “Wacuum |

— Element Priarity -

High

Low

ove iy |
ove Do |

#-Ray Threshald = 1
1

Load... | Clear

Save.. | D efault

LED

The window Element Priority displays the activated channels with their
respective short names. This list determines the element priority if two or
more elements appear in the same pixel. This priority will decrease towards
the bottom and can be modified by selecting and short name and pressing
the keys “Move Down” or “Move Up”.

After assigning the channels, placing and starting the energy windows in the
EDX software, pressing the key “Start” will start the scan of the mapping. .
The mappings may be saved after ending the scan process by means of the
noise reduction (Freeze).

Key Load: Loading user specific settings.
Key Save: Saving user specific settings: The selected channels, the
Window names, the selected colors, the element priority and
the
value for X-Ray Threshold will be saved

Key Clear: Erasing the screen and starting another scan.

Key Default: Setting of the basic condition (see above).

Key Start: Starting the imaging.

Key Stop: Ending the imaging

X-Ray Threshold:

Entering a threshold between 1 and 254. This value will determine the number of
impulses to be sent from the EDX system before a corresponding colored image will
be displayed on the screen.
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4.4 The SEM Status Window

The SEM Status window provides another ability to view and set frequently used parameters. It can be
opened using the Pop-Up menu VIEW > SEM STATUS or by entering the key combination CTRL + I. The
status window lists combinations of operation parameters selected by the respective user. These values will
be updated continuously and may be controlled interactively. Every parameter can be activated or
deactivated by using the index Tab Select. Furthermore, the selected composition may be saved using File in
the corresponding user directory where the composition can be reloaded. This enables the user to create
specific parameter lists for the most different tasks.

The parameters and functions listed in Display can be controlled interactively, i.e. that the parameter Ext
Scan Control indicated in the example below can be switched from Off to On by clicking. It is also possible
to enter numeric values. Double-clicking WD, for instance, enables entering a fixed working distance that
may be adjusted exactly by means of the left mouse button. Several parameters are purely informative and
cannot be switched or varied (e.g. Filament Age, Output Dev etc.):

Display | Selectl File I Dizplay ~ Select | Filz |
C3Llensz | = 456,70 md, SEM Contral\All Parametersh,
Ext.5can Control = Off
Filament 4ge = 9.5 Hows — {| | O ED Too Hat =]
Hard Panel = &bsent (| | i e (Z) Ext. Spot Contral
Image=Libvee ! 1 i & E:tScan Contral i
Mew Filament=MHo =484  BE] i (20 Estractor |
Offget&=00% 1 1 i i () Extractar Trip
COutput dev = 20inch digplay (| | ¢ & () Estractor Trip Current
Output To =Display/Fle | | = () Exbractor
wo= 1w 40 e () Estractory Target
----- () FCF Setting -
4] 3
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4.5 Saving and Loading Images

After entering and freezing the image in the image store by means of the noise reduction, it can be stored on
the hard drive or on another storage medium as a TIFF file. The window Export TIFF may be opened using
the Pop-Up menu FILE 2> SAVE IMAGE, a right mouse click on the image = Export Tiff or by using the
key combination CTRL + E.

Key: Change Directory:

EFRoITI E e 2 ognl il= IEDEO 925034 =l Selection of the directory in which the images are to be
seve | satings| Das | filed. The list below indicates the images already saved.
: erg; rea Dimensiarn
Change Directary | o = \N"hole i
inogel g E:;m - cee | || v [P Control Box Merge:
Imagez tif rod
g e [1024
IStDre resalution = 1024 = 768 j u [ Annotation:
mﬂzge ‘ s Data zone, annotations and measurements etc. will be
g saved together with the image.
LI_I _’I User Text
Save Fieati | ’7 I

Overlay:
Only the data zone will be saved together with the image.

Color Merge:
Must be activated to store colored annotations or measurements together with their color in a gray image.

However, this will reduce the number of grays of the image (256) by 20 gray scales, as this storage area is
required for the information of the Annotation.

Data zones, annotations or measurements saved together with the image will be “burnt” into the
/j\ image. The image information behind the respective overlay will thus be lost.

Control Box Area:

Clicking on “WHOLE” will save the complete image.

Control Box Dimensions:

The upper left corner (X, Y), width (W) and height (H) of the image to be saved are listed. Selection of
Whole in AREA will always set the upper left to 0,0; the size will correspond to the entered Store
Resolution. However, it is also possible to save only a clipping of the image as a file by entering the
respective parameters in Dimensions. Clicking “Sef” will then display size and position of the grid on the
image corresponding to the clip to be saved. Size and position of this grid may be varied by using the mouse
—
(Left mouse button). By clicking the symbol
be selected by using the mouse.

in Annotation (see 4.7), a desired area in the image may

Selection Store Resolution: Clicking Store Resolution provides the ability to select the store resolution of
the image.

A special name for the image to be saved can be entered in the field File Name. It is also possible to add user
text to the image. This text may be entered in the field User Text and will be indicated later on in the window
Load Image (see together with the image without the necessity to load this image in the image store.
By pressing the key “Save(file name).tif” the image will be filed in the storage medium together with the set
parameters.
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4.5.1 Special Configurations of Images to be Saved

The index Tab Settings allows special configurations concerning the format of the image and the type of file
name.
Control Box Image:

Save  Seftings | Data I . .
o o o The image can ‘pe saved as a gray image (256 gray spales)
& i TR or as a colored image (16 millions of colors) depending on
2 - the selected format (Gray / 24 Bit Color). Normally this
IZ;;Z:” Y | conﬁgura‘iion should be set to Gray and only be modified
for special applications.
Reduction Hext 3 P pp
|‘| -

As Seen:

Reprocessing the images is possible by means of the
Display LUT (see). Activation of AS SEEN will store
the edited content of the screen.

*M.B : This format cannot be loaded back into the SEM Image

Palette: Activation of this box will save the image together with the color palette. This palette will be
applied automatically when reloading the image. This provides the ability to color images by means of the
Display LUT although storing them as gray image. The complete color information will be saved in the
palette and will therefore be available for further editing or for printing colored images.

If images are saved as colored images (24 Bit Color) they cannot be reloaded back to the LEO user
/j\ interface. However, it is possible to copy them to most of the Windowsg user programs. If SEM
images are to be colored and to be processed with the LEO user interface, it is therefore
recommended to save the images as gray images with the respective color palette.

Control Box Filename:

Four different formats may be selected for the file name. The selection Max 8 Chars will allow the
contribution of up to 8 letters or numerals for the file name. Selecting Max 30 Chars will offer the ability to
enter up to 30 letters or numerals. Both settings enable the addition of a successive number to the file name.
In the example above you will find a format of 30 letters. 1 has been selected for No. , 3 has been selected in
the field next. That means that 29 letters are available for the file name. The 30™ letter, a numeral, will be
added automatically by the software, in the example above “xx...xx3.tif”. On the next save this numeral will
increase by one and be xx...xx4.tif. This enables continuous saving without modification of the file name.
Numbers between 0 and 7 are possible for No. The numeral 0 indicates that no successive number will be
added. The parameter Next can be edited freely, allowing selection of the starting number as well as the
rewriting of existing files.

It is also possible to choose a file name consisting only of numerals by selecting the configurations Photo
Nr. and File Nr. When selecting Photo Nr. the file name will be composed of 4 numerals (XXXX.tif). The
start of the successive count is set using NEXT. After saving and printing an image, an addition to the
selected number will take place. 7 numbers are available for the selection File Nr. where an addition will
only take place if an image has been saved in a storage medium. These settings are global variables, i.e.
modifications made by a user in his user directory will also influence the configurations of another user
working in another directory. Filenames are always created with the entire number of digits (i.e. 0023.tif).
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4.5.2 Saving Additional Information with the Image

The index Tab Data can establish a user specific list of parameters, which will be saved together with every
image. Similar to the SEM Status window, where parameters are updated online.

The specific parameters can be selected from a list by pressing the key “4dd”. With every image store, these
parameters will be extracted from the microscope and saved together with the image. This enables the
reconstruction of important data concerning the image.

Creation of this list of parameters will only be necessary once; afterwards it will be saved automatically for
every image. Components can be removed from this list by pressing the key “Remove”.

Export TIFF [C:\Program Files\LEDOALED 32\images\] <]

Annatation SEM Parameter

Save iSettings Data i ;
e e Fleaze Select Required Parameter|z]

Beam Shit X B akeout State - |LI
Beam Shift ¥ Beam Blanked ﬂ
Beam Offzet % Canicel |

Femove i
Beam Time
Black Threshald
E!r_ig_htness ;l

4.5.3 Loading of Images

Using the window Import TIFF, TIFF images can be loaded back

Import TIFF [C:\Program Files\LEOALE D 32%imagesh] =] - . .

B L from any storage medlum.to the user 1pterface by using the key
nage Gy | Pl lemelon— | Loadal—— combination CTRL + O, right mouse click on the SEM image ->
— | T || _Cente | Import Tiff or the Pop-Up menu FILE> LOAD IMAGE. The left
—aigi—"-e—dﬂ—”‘H’“;g‘:l e\ field lists the TIFF files contained in the respective directory.
EEEEEEE = Cl'langing of the directory is possible by clicking “Change
Inage Reducton1 | Directory” if this option has been released in the Administrator (see
[ [L— :if _____ Ll B . The field File Information indicates type and size of the
L selected image. If user text has been added to the image, this text will

e S (O e st prs el

be displayed in the lower field User Text.
If the image is to be saved in the image store in reduced format, the
. desired reduction factor can be selected in Image Reduction. This
i e — provides an image-in-image display or of a composition of 4, 9, 16
Lo | etc. images in an entire image. Depending on the reduction factor, a
grid will be displayed on the screen indicating the position and the
format of the image to be loaded. Clicking “Center” “Origin” (upper left corner) or “X, ¥ (free positioning)
will select the position of the grid on the screen. If X, ¥ has been selected, the grid can be positioned freely
by using the mouse. Pressing the key “Load” will insert the selected image at the corresponding position
(see below).
The activation of Step Frame is recommended to represent e.g. four images as an entire image. This will
automatically position the images correctly. Before loading the first image, click “Origin” to position the
positioning frame in the upper left. Now the first of the four images can be selected and loaded using Load in
reduced format. The positioning frame will then automatically go the next area. Now the second image may
be selected and loaded
Activation of the control box Wide File List allows the presentation of the file names in full length (30
characters).

!Stnre resolution = 1024 = 768 ;!
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Store Resolution provides the ability to select the store resolution. If images with different resolution are to
be loaded together, an automatic adaptation can be realized by clicking Fit to Image.

E5SEM - (MUSTERMANN] TR [l . SEM - MUSTERMANN] HEE
File Edit View Beam Detection Image Scanning Stage Vaguum Iools Help File Edt View Beam Detection Image Scanning Stage Vaguum Tooks Help

Bl 2t ]2]3]4] 5@ L= &8 ][] e 2|2 B |t 1]2]3]4]5[ofn =D& R®|=e] |0 | &2
| 4 A 3 T - e — Y S

I - Ven

\ ‘o
P 1
L02d | Standord Dot UserDsta] &
Image Gallery Gl
Type  Palette
Change Directory Width 1024
Height 768

¥ StepFrame.

Image Reduction
Iz—l B
T~ Wide File List -«
oS0 Do 10 u1 1958 )
i
[Fe eotaon 1020758 5]
I Filoinage 3 on

le o »
[e—

Load | Standard Data
Inage Galery
Tipe Pallet Cente

CrangeDiectoy | | vian 1026 .
Mt 760 Loign |

I
 StepFiame x|
e
uﬁ B
T~ Wide File List
Iz

[Stere resaliion = 1024 768~

]

User Teat
Load SG2_0.1f | { g

-
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4.5.4 Image Gallery Function

The images contained in a directory can also be displayed as an album, i.e. in form of a gallery by pressing
the key “Image Gallery” . The software will then control whether a gallery file (*.gal) has already been
created in the corresponding image file. This file contains all information on the gallery. If such a gallery has
already been created, it will be opened and eventually updated. If the software cannot find a *.gal file, the
question will be displayed whether a gallery file from the user directory is to be loaded. Answering “No” to
this question will result in the creation of a file GALLERY.GAL in the current image directory.

The image gallery, displaying the images in thumb-nail format with the corresponding file name, gives a
rapid overview on the imges contained in the respective directory. A specific image from the gallery can be
loaded by double-clicking the corresponding image. The image will thus be loaded to the image store and be
displayed on the screen. Activating an image and clicking the right mouse button will open the menu
Properties which displays information on the image such as store resolution, date of storage or user text. The
command Print will result in printing the respective image on the default printer. By means of the command
Load as 2" Image the image may be loaded to a virtual second window (see 3.6.2). Delete will remove the
corresponding image from the gallery without deleting it from any storage medium. The only effect is that
the image will not be represented in the gallery any more.

It is also possible to print several images from the gallery together on one sheet. Images (not more than 6)
can be selected by pressing CTRL and clicking the image with the left mouse button. These images can be
printed on the default printer using the Pop-Up menu FILE - PRINT.
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4.5.5 Extracting Stored Parameters

Irpart TIFF [

Load = Standard Data I Iser Data

Operating Mode = Maormal File imagel . tif
Zohe [ Zone 1
EHT= 20,00 ki

Fill= 21594

Mag= B.37 KX

Output devw = Diefault Printer
Pisel Size= 17 nm
“Wh= 12 mm

Special parameters, as set on the SEM at the moment of image
storage, will be filed together with the image. These are the
standard parameters saved automatically by the system as well
as user-specific parameters which can be selected using the
window Export TIFF (see). These parameters may be
loaded by means of the index Tabs Standard Data and User
Data without loading the image to the image store.

Standard parameters are the acceleration voltage (EHT),
filament heating current (Fil. 1), magnification (Mag), output
device (Output dev), pixel size (Pixel Size) and working
distance (WD). This data is stored for the corresponding zone
of the image. In a Split Screen image, Zone 0 is for settings on
the left half of the screen, Zone 1 for settings on the right side.
In full image (normal) mode data will always be displayed in
the Zone 0 field.
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The user-specific data (User Data) depend on the parameters
selected in the window Export TIFF (see [4.5.2).
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4.6 Finishing Images by Means of Display LUT

Opening the LUT Editor by using the Pop-Up menu EDIT-> DISPLAY-LUT. The Display LUT allows
reprocessing of SEM images, e.g. by subsequent coloration, modification of brightness and contrast,
inversion or insertion of Gamma function. These settings will effect stored as well as live images.

After opening Display-LUT, a toolbar will be displayed together with a graph representing the LUT. The
transfer characteristic symbolizes the allocation of an input signal to a defined gray value. In the simplest
case it will be a straight line connecting the points (0,0) and (255,255). This straight line may be processed
by adding or displacing different points. It is also possible to refer certain operations to defined parts of the
curve or to bend the complete curve by using the Gamma function.

The different functions can be selected using the toolbar or by clicking the right mouse button within the
graph window. By doing so, a menu will be displayed which allows selection of the different functions.
Using this menu, it is also possible to switch on (Show Toolbar) or off (Hide Toolbar) the toolbar.

As modifications of the LUT will affect the stored as well as the live image, the Editor should be
reset to the basic settings using Reset LUT before working again on a live image.

B>

Dizplay LUT D LED-32 LUT Editor - [C:\Progra... =] E3

Fil= Help

Edit Mode r
[= LUT Functions Beszet LUT
% v Show Toolbar rT Step |

S Brightnesz & Contrast Sethings...
Open LUT Gamma z
Save LUT Az Lewel

e o Colour Selection

Irevert the Current LUT ——;10— Grey Wedge

Below, you will find an explanation of the different functions of the Display LUT.

/g Moving and deleting points in the transfer characteristic
(Moving: Position the mouse cursor to the point and displace by pressing the left mouse button.
Deleting: Position the mouse cursor close to the point and delete by pressing the middle mouse
button.)
.j-,g_ Adding or deleting points in the transfer characteristic (Adding: Position the mouse cursor within the
graph field and press the left mouse button. Deleting: Position the cursor close to the point and press
the middle mouse button).

Undoing last modification of the Display LUT

Loading special Display LUT settings and applying these settings to the actual image

Saving special settings of the Display LUT

=
—
x Resetting the Display LUT to the basic settings (use of the original data)
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Inverting the actual transfer characteristic

|.r'i Inserting a step function as transfer characteristic. This will change the transfer characteristic into a

regular sequence of gray scales. The height of each step (Amplitude), the position of the first step
(Offset) and the number of steps (Period) can be adjusted separately. It is also possible to continue to
modify the curve by adding or moving different points.

ULE0-32 LUT Editer M= E3 LUT Step Settings
File Help —Amplitude — — Period
d g e
: b
]
— Offzet
Min b ax
'_I\I 1 1 1 1 1 1 1 1 1
Jict
o] - Control
W Apply Directly to Current LUT
Min ~
Ready s

Opening the window LUT Step Settings to adjust Offset, Amplitude and Period for the step function.

Editing brightness and contrast.

The Gamma option enables the definition of the transfer characteristic as a curve to enlarge lower or
higher gray scales. This function may be used to improve images containing a lot of detailed
information within a few gray scales.

YLED-32 LUT Editor - I APsoaram - M=l Bl Adjust LUT E3

—Brightnesz —  — Contrast—— File Help — Gamma——

bam TS 5T

Min ~ in = Min \TI

Set new gamma and cloze dialog when done o

Inserting a gray wedge (continuous distribution of the gray scales from white to black) as an actual
image to adjust special output devices.
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9 Switching from RGB- to gray scale LUT.

The LUT Editor includes three transfer characteristics, one for every video color (red, green and
blue). If these three graphs are identical, the image will be displayed as a single color (gray) on the
screen. Switching to RGB LUT enables a separate modification of every graph of the different three
colors so that the complete image can be displayed in color.

E] | False color display
By means of this function different colors can be assigned to different gray scales. Before opening
this function, a step function should be set. After adjustment of amplitude, offset and period
switching to the false color display is possible. The colors of the different zones can now be edited
freely. To select a special color, double-click the corresponding zone to open a pallet of colors where
the desired color may be selected. By pressing the key “From Image”, it is also possible to select a
gray scale or color in the image which can be inserted to the corresponding zone.

D LED-32 LUT Editor - [C:\Program ___ [H[=] [E3

File Help

Edit Mode

Reset LUT
Inwert LUT

v Show Toolbar Step
Level Hide Toolbar TS Settings... | Hue: IE Red: lﬁ
e oy | 3l gl
i From Image | (] 4 Close | ColorlSolid Lur: W Blue: IW

Undo |

Setting the level of a point in the transfer characteristic, to do so, it is necessary to select a point in
advance.

Switching from gray scale LUT to RGB LUT and selection of the transfer characteristic for the color red.
All subsequent modifications of this transfer characteristic will only refer to the color red.

Switching from gray scale LUT to RGB LUT and selection of the transfer characteristic for the color
green. All subsequent modifications of this transfer characteristic will only refer to the color green.

¢ |8 B |\

Switching from gray scale LUT to RGB LUT and selection of the transfer characteristic for the color
blue. All subsequent modifications of this transfer characteristic will only refer to the color blue.

LEO Electron Microscopy Ltd 57



LED

4.7 Image Annotation and Measuring

The window for annotation and measuring can be opened using the Pop-Up menu EDIT-> ANNOTATION
or by means of the key combination CTRL / A. This window and its functions provide various image
measurement functions and the insertion of text and SEM parameters. Measuring may be done on the saved
image as well as on the live image. Inserted SEM parameters will be updated and can be stored as a file
applicable to another image later on. Below you will find the explanation of the different functions.

Selection of measuring and annotation options using a mouse-click

Annotation

Switching to adjustment of SEM parameters using a mouse-click

Eilrs

Undoing the last action

Loading saved measurements, texts, parameters etc. and applying these
functions to the actual image content

]

4
)H( H Saving measurements, annotations etc.
X =
T

Deleting all overlays (measurements, annotations etc.) on the screen

Selection of a determined zone of the image, which is to be saved as a file
when opening TIFF Export.

8 % (o [w] |

A| Open of the text editor to insert texts and numbers to the image. It is also possible to insert date, time

and respective user name into the image. Texts which have been written in other word processing
programs and which have been copied to the intermediary store using “Copy”, can be inserted into
the text by clicking the right mouse-button within the text field and selecting “Insert’. Frequently
used special characters are listed and can be copied to the text by pressing the corresponding key.
Selecting Word Wrap will allow a defined overrun by displacing the upper slider.

Annotation Caption

— Caption

inselt bext
Undo

[Euit
Lapy

[elete

Insertint Select All word Wrap Unda |
”Ii|°|9|1|2|3|©|®| Enabled [

Insert New |
TimeNowI DateNowl UserNamel ITI - | |
ance
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Fleaze Select an SER FParameter
Aperture Size = 30.00 um gEpeture Size B
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Opening the SEM parameter list. Most parameters of the SEM can be selected from a list and
inserted into the SEM image. It is possible to update these parameters continuously or to modify
them interactively. These parameters are particularly important for the individual design of the data
zone.

Annatation SER Parameter

Aperture at v -

.-’-'-.Eerture Ma. _I| Cancel |
Aperture Wwobble

Area Fraction

Auto BC

Auto Fr
Auto Yideo Mean ;I

M.B: Double Click a Parameter to Create it Immediately

Inserting bitmaps and metafiles into the image. Select the symbol with the left mouse button—>
Position the mouse cursor within the image where the graph is to be inserted and press the left mouse
button. (e.g. to add company logos to the data zone).

Inserting a line into the SEM image. Activate the symbol with the left mouse button—=> Drag the line
with pressed left mouse button. These lines may be appropriate to assign annotations to certain zones
within the SEM image. Form and color of the different lines may be chosen individually by selecting
the respective line with the left mouse button and pressing the right mouse button to open the
corresponding menu.

Inserting a quadrangle. Activate the symbol with the left mouse button—> drag the quadrangle by
pressing the left mouse button. Color design, thickness and form of the line can be selected using a
menu to be opened by means of the right mouse button.

Inserting a circle or an ellipse. Activate the symbol with the left mouse button=> Drag the
circle/ellipse by means of the pressed left mouse button. Color design, thickness and form of the line
can be selected using a menu to be opened by means of the right mouse button.

ld v Solid Background Maode -— 5 =
roperties
Transparent Backaround Maode T Properties Solid Background Mode

gz:g tBan:c:k -Etr|+- - }/ T v Transparent Background Mode
= N SendBack - Background Colaur...
. "
Delet Del Pen Settings... :
e 2 S |ngs - — - Delete Del Pen Settings...
Brush Settings... H — - T R e R e S
Bruzh Settings. ..

Feset P ti -
eset Properties Reset Properties

Shap to Grid Shap to Grid

Inserting an annotation panel, which may contain several SEM parameters or texts. After selecting
size and shape of this annotation panel, the different texts and parameters can be copied to this field.
After doing so, the annotation field must be activated with the left mouse button. By pressing the
right mouse button, a menu will open to select the different settings. If the field is locked by Lock
this Panel, the elements contained in the field will form one unit which can only be moved
completely. It is also possible to define such an annotation panel as data zone by selecting Make
Panel a Data Zone.
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Mag= 231X

Bring to Front
Bring Forward +

Salid Background kMode
Transparent Background Mode

Make Curent Data Zone

Background Colovr

Save as Data Zone...

Pen Settings...
Delete Del Brush Settings...
w Lock this Panel Cirl+L
Unlock this Panel Crl+H

Make Panel 2 Data Zone
Don't bake Panel a Data Zone

Snap to Grid

LED

Inserting a zone magnification. This is especially useful for a split screen presentation, as the
< magnification value will be calculated depending upon which half the panel is placed.

Inserting of a variable u-marker (automatic setting, adjusting for magnification)

Inserting a fixed p-marker (size to be selected by the respective user)

pi=% | Insertion of a point-to-point-measurement into the SEM image. The settings for the result window
P1] and for the measuring line can be selected using a menu which can be opened by marking the

corresponding object with the left mouse button and pressing the right mouse button. The selection
menu for the measuring line allows defining the presentation of the results.

Set Panel Font...

Bring ta Front  Chrl++
SendtoBack Cil+-
Bring Forward +
Send Back

v Solid Background Mode
Transparent Background Mode

Background Colour...

Pen Settings...
Bruzh Settings:

v Lock this Panel Chil+L
Unlock this Panel L+
Snap to Grid

Select Point to Point Results..

Bring ta Front  Chrl++ Fant...
Sendto Back Chil+
Bring Fonward +
SendBack -

Solid Text Background
Transparent Test Background

<

Delete Del Backaround Colour...

Pen Settings...

Reset Properties

Snap to Giid

Select Point to Point Results. If all parameters are listed in the window Current, the results will be displayed
in an annotation panel (see below). Depending on the parameters copied, using Remove, to the lower
window Available Parameters, the number of parameters listed in the annotation panel will be reduced. If all
parameters are removed from the window Current Selections, the result will be displayed close to the
measuring line. The parameter to be presented as a result can be selected using the window Reduced Display

Mode Parameter.
Current Selection
Fal :
Ph1
Remove i
Available Parameters
Ldd
Reduced Dizplay Mode Parameter
[Pat =l
e |
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Current Selection

Bemave |

Available Parameters

Fb1
Pal

Add

Reduced Display Mode Parameter
F‘a 1 vl

Fb1
5Ly | Tareel |

Insertion of an angle measurement. The settings for the lines and the result window are fixed in the
same way as for the point-to-point measurement.

Inserting a quadrangle measurement. The settings for the lines and the result window are fixed in the
same way as for the point-to-point measurement.

Inserting a circle measurement. The settings for the lines and the result window are fixed in the same
way as for the point-to-point measurement.

Insertion of vertical measuring lines. The settings for the lines and the result window are fixed in the
same way as for the point-to-point measurement.

Inserting horizontal measuring lines. The settings for the lines and the result window are fixed in the
same way as for the point-to-point measurement.

Inserting vertical adjustable measuring lines. The settings for the lines and the result window are
fixed in the same way as for the point-to-point measurement.

Inserting horizontal adjustable measuring lines. The settings for the lines and the result window are
fixed in the same way as for the point-to-point measurement.

Inserting a gray scale line profile. Measuring by means of the profile is possible.

Inserting a gray value histogram.

Inserting user data. This function is only active if user data have been saved together with the image
(see TIFF-EXPORT - DATA) see

=
BEAM SHIFT X = 62.3 % qsnalalonSERTIEPanet _
BEAM SHIFT Y = 47.9 % SNl _

Cancel

Add A1

Bemaove

Remove All

T
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4.7.1 Expanded Measuring Capabilities: (Requires the Licence: MEASA)

The horizontal and vertical adjustable measuring lines and the quadrangle measuring are part of the advanced
measuring option. The quadrangle measuring enables displaying and measuring both side lengths as well as
the angle to the horizontal line and the surface.

Furthermore, with the option “MEASA” four circle measurements are available instead of the default two
measuring possibilities. The point-to-point measurement can be opened up to 10 times. The default version
allows only two open. The adjustable measuring lines can also be opened up to 10 times (default: 2 open).

4.7.2  Basic Settings for Measurements, Annotations and Overlays

The user may fix pre-settings for the different measurements, annotations and for the Windowsg overlays
(Spot, Reduced Raster, etc.). These settings will define format and color of the different objects.

The window, Annotation Options, can be opened by pressing the right mouse button within the image panel.
Before doing so, it is important to activate the Annotation Toolbar. The window Annotation Options is

subdivided into three index cards. The index Tab Standard allows pre-settings for the text editor, Al, the

SEM parameters ¥ | the USER data and the different graph functions. \ . ﬁ
Using Font, font type, size and color of characters can be selected. In Text Background you may chose
whether the respective text is to be displayed with a
&%, SEM - [MUSTERMANN] . . .
Fil= Edit “iew Beam Detection |mage Scanning Stage Yacuum Tools Help transparent ora SOhd baCkground When SGIGCtlng SOIld

Llielll

% - @ 11213 | als <>mg @|D;|| the corresponding background color may be chosen

2l using Colors... Using the key “Line” thickness, color
and kind of line for the graph objects may be selected.
In the same way as for the texts, Object Background
allows to define whether the objects are to be filled with
a color (solid) or not (transparent).
By clicking “Reset” all settings will be undone to return
to the basic settings.
The index Tab Measurement & Results enables the
settings for the measured objects. Each measuring
function includes the measuring object with annotation
Sl (e.g. a circle with the denomination Dal) and the
it window displaying the results of the measurement. For

i
o

S TNERE
Wit | E B/ |+

i
£
=

Impart TIFF... e
e both objects, Measurement Objects and Results Panels

Reset Disslay LUT R make available the corresponding settings. Using Font,
x TEETIITe  font type, color, style and size of the characters may be

Hide

selected. Depending on the background selected for the
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annotation (transparent or with a background color), this setting will be done using Text Background.
Pressing the key “Line...” allows the selection of kind of line, thickness and color of line, of the measured
object. The key “Reset” will undo all settings in Measurement Objects and return to the basic settings.

Using Results Panels identical settings can be fixed for the results. The key “Font” will also refer to font
type, size, style and color of the character of the results. Again, a transparent or solid background for this
annotation may be selected using Text Background. The complete background of the results will be selected
using Transparent Background and Solid Background. The respective background color may be chosen by
means of the key “Colors...”. By clicking “Reset”, the settings of Results Panels will be undone to return to
the basic settings.

Annotation Options | @l :nnatation O ptiohs Annotation Optiohs

Standard i Measurement & Hesultsi Generalg Standard  Measurement & Besults 1 Generali Standard; Measuremnent & Results  General

~ Current Standard Annatation Settings——— ——— ~ Measurement Object: — Automatic Object Settings

e ] ~TextBackground ] V¥ Enter Select Mode on New Dbject

€ Transparent i i V¥ Select Dbjects on Creation
i Test Background————— Line.. || & Slid ¥ Apply Object Settings to All Objscts

L

| & Transparent Colour | |
= Sald I . E— ! —Shap to Grid

sl e I” Enable Snap to Grid Settings ;
~ Object Backaround-

| ~ | - Fesults Pargls—M — {4 L—n

el i~ Text Background———— |

| & 2oid Colour.. | = I |

| Soli | I | |

| | & Tranzparent

""" % | Colaur... i |
Colour.. | | Salid

Mote : Thege settings do not apply to
Measurement Objects or Results Panels

" Transparent Background
Fiesat i | % Solid Background s i

The index Tab General allows setting of the Windowsg overlay, positioning and editing the objects and the
kind of numeric result presented. It also provides the ability to save the different pre-settings in a file in the
corresponding user directory.

Automatic Object Settings allows the activation of three basic settings.

*  Enter Select Mode on New Object: After opening a function in the toolbar, the mode will automatically

!

switch to edit. e . If several measurements are to be inserted one after the other, this setting should be
deactivated. Thus, the respective function will remain active and switching to edit or another function
will have to be done manually.

*  Select Objects on Creation
After opening a function in the toolbar, the corresponding object will immediately be marked. This
enables an immediate opening of the settings for this object by clicking the right mouse button.

*  Apply Object Settings to All Objects
The settings selected in the index cards Annotation Options will immediately be applied to the objects
(even to those already selected). If this box is deactivated, the new settings will only be active after
opening a function of the toolbar.

Grid Settings

The box Snap to Grid allows the alignment of the respective objects by means of
a grid. Settings for this grid will be made by pressing the key “Settings”. For the
Cancel width, values between 2 and 1024 are possible, for the height, values between 2
and 768 may be selected.

~ Optionz —

bt

[~ Spacing—

Width 1100 |
HeightImD
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Raster Lines allows the setting of the kind of line, thickness of line and color of line for the functions Spot,
Reduced Raster, Split Screen, Dual Mag, Crosshairs and Graticule. The respective setting will be valid for
all these functions.

The setting in Results (Sig. Figs) will define the maximum number of figures for the display of the result of
the distance measurement. Selection is possible between 3, 4 and 5. For the um range, not more than 3
figures after the decimal point are possible. That means that a distance measurement of 3,452um will only
be displayed with 4 figures in spite of a setting of 5 in the box Results (Sig. Figs. In the nm range, no figures
at all will be displayed after the decimal point.

All settings in the menu Annotation Options will automatically be saved in the file “CURRENT.ANP” in the
respective user directory. It is also possible to save the different settings in a separate file by using the key
“Save”. After assigning a file name, the file will be saved in the actual user directory. This file and the
corresponding settings can be reloaded to the LEO user interface using the key “Load’. However, by doing
so, the actual file “CURRENT.ANP” will be updated with the new settings.

4.7.3 Editing, Storing and Loading Measurements and Annotations

Form, size, position and color of the different measuring, graphic or annotation objects may be varied
individually. The procedure is always the same: First, mark the corresponding object with the left mouse
button, then open the respective menu by pressing the right mouse button. It is also possible to mark a group
of objects by keeping the key CTRL or SHIFT pressed and marking the different objects by pressing the left
mouse button. Another option is to insert a quadrangle by dragging the left mouse button after selecting

El. All objects within this selected zone will be marked.

Below you will find the explanation of the most important commands to edit the mesuring, annotation,
graphic objects and pu marker.

w5 WS Q) 1 =i =] %] ]

Select Line Width Results...:

e Measuring objects

/\LIﬂ

SeletLine il et Provides selection of the parameters to be
\ ;'P - displayed in the annotation panel.
et Panel Font.
P N Solid Text Backaround Font .
l} Tianspaient T ext Background :" * .
\ S el Provides selection of letter font, color and
Salid Background Mode . . .
te! o size of characters for the line annotations
Backaraund Colaur Lal and Lbl
Line Settings.
'E'Dilh;‘:';lg;" il Set Panel Font...:
Urlock s Pane wev | Provides selection of letter font, color and
:E“'tp';p:'““ size of characters for the annotation panel
T

of the results.

Solid Text Background.:

Provides selection of the background color for the line annotations Lal and Lbl
Transparent Text Background.:

Provides selection of a transparent background for the line annotations Lal and Lbl.

Select Text Background Color...:
Provides selection of the background color for the line annotations Lal and Lbl.

Solid Background Mode:
Provides selection of the background color for the annotation panel of the measuring results.
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Transparent Background Mode:
Provides selection of a transparent background for the annotation panel of the measuring results.

Background Color...:
Provides selection of the background color for the annotation panel of the measuring results.

Line Settings...:
Provides selection of kind, color and thickness of line for the mesuring quadrangle.

Brush Settings...:
Provides selection of a pattern for the background color.

Lock this Panel:
Locking the annotation panel for the measuring results. That means the four results Lal, Lbl, Lc1 and Ldl
will be defined as one unit and will be processed identically when editing and positioning.

Unlock this Panel:
Unlocking the annotation panel. This enables the extraction of single results (e.g. Lbl) from the annotation
panel for separate editing and positioning.

Reset Properties:
Resetting all settings to the basic properties.

Snap to Grid-
Provides alignment of an object by means of a grid. The size can be determined using Annotation Options

(see[1.7.2).

Delete Del:
Deleting the measured object.

AlS &

e Annotation Objects

Detector = QBSD, — SEM Parameters...:
: T Selection of the parameters to be displayed (e.g. detector)
e e
Delete Del : TlanspaI;ntTez Backaround Font...:
T Select Text Background Colour... . . .
e Provides selection of letter font, color and size of characters for
Srop 01 the displayed parameter.

Solid Text Background. Provides activation of the
background color for the annotation panel.

Transparent Text Background.:
Provides activation of a transparent background for the annotation panel.

Select Text Background Color...:
Provides selection of the background color for the annotation panel.

Reset Properties:
Resetting all settings to the basic properties.

Snap to Grid-
Provides alignment of an object by means of a grid. The size may be determined using ANNOTATION

OPTIONS (see [1.7.2).

Send to Back:
If several objects are superimposed or overlapped, the corresponding objects can be moved to the
background or to the foreground using Send to Back or Bring Forward.

Delete:
Deleting the object.
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\ || @) £

T Rl Solid Background Mode:
é Sl e e oW | A otivating the solid filling color for the graph object.

e QGraph objects

SendBack - Eackground Colour.

v Transparent Background Mode:
‘ o e Provides activation of a transparent background for the graph object
Snap to Grid
Background Color...:

Provides selection of the filling color for the graph object.

Line Settings...:
Selection of the kind, color and thickness of line for the graph object.

Brush Settings...:
Provides selection of a pattern for the filling color.

Reset Properties:
Resetting all settings to the basic properties.

Snap to Grid:
Provides alignment of an object by means of a grid. The size may be determined using ANNOTATION

OPTIONS (see [.7.2).

Send to Back:
If several objects are superimposed or overlapped, the corresponding object can be moved to the background
or to the foreground using Send to Back or Bring Forward .

Delete:
Deleting the object.
¢m4| v
e U- Marker B
Popeites i Font..:
- e Selection of letter font, color and size of characters for the
: T annotation of the p marker..
Solid Background Mode
- ;k:;ilkg” i Solid Text Background.:
e Activating the background color for the annotation of the p
T marker.
Snap to Grid

Transparent Text Background:
Provides activation of a transparent background of the p marker.

Select Text Background Color...:
Provides selection of the background color for the annotation panel of the p marker.

Solid Background Mode:
Provides activation of the background color for the p marker.

Transparent Background Mode:
Provides activation of the transparent background for the p marker.

Background Color...:
Provides selection of the background color for the p marker.
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Line Settings...:
Selection of kind, color and thickness of line for the u marker.

Reset Properties:
Resetting of all settings to the basic properties.

Snap to Grid:
Provides alignment of an object by means of a grid. The size may be determined using ANNOTATION

OPTIONS (see [4.7.2).

If several objects are superimposed or overlapped, the selection of
Send Back and Send to Back as well as Bring Forward and Bring to

Front determines which object is going to be moved to the 7O ,--"'\
background or the foreground. Pa1=111pm B
The different measurement, graphic and annotation objects can also be Pb 1 =768 4 NDéa T
. Beschriffungsfeld

stored in a file . When loading this file later on to a live or saved ] ': Y Y \% ‘)

~ A e TR
image, , the measuring values will automatically be updated. By _ ' | Dai= j,ff .0 pm
doing so, the different objects need not be reopened and reformatted. B Db 1/,._:"95_3 prm?

This results in a considerable simplification of the work with the
Annotations, if certain objects must be opened frequently.

If the control box Save Selected Annotation Only is activated, only the marked objects will be saved in a
file. If not, all opened objects will be saved. Saving will be in the actual user directory.

B2 SEM - [MUSTERMANN]
File Edt View Beam D

o g Scanning Stage Vacuum &)
2 " )
l il @ 1 2 345 " l k 1 i Save Annotation [ 2] =]
/ i e Save jn Ia Mustermanin j ﬁl
')
B 8] Armotation] ann
x Pai=11.1pm AnnntahnnZ atn
| '
Pb 1 =2964 Deg
. _m Beschriftungsfeld
Q} o ¥y,
ﬂ( N d w |
AR . Dat=11.0 um File name: IAnnUIatiUnS Save I
i Db 1 =953 pm?
- . ’ Save az type IUser Annatation [*.ann) j Cancel |

474 Setting and Editing the Data Zone

The datazone is a useful tool for the presentation of important image data and the output of this data together
with the image. The software provides a standard datazone which can always be used, assuring that even
newly installed users will have a datazone although no user datazone has been created. In this case, the
default datazone will load. After closing the LEO user interface, a file “CURRENT.ADZ” will be created in
which the datazone will be stored and which can be used when starting the software again. Basically, there
are two ways to create a datazone: The first is to load the default datazone, to change it according to the
user’s specifictions and to save it again as “CURRENT.ADZ” in the actual user directory. The secons is to
create a completely new datazone and to save it with a new name.

The key combination CTRL + D or the Pop-Up Menu VIEW > DATA ZONE> TOGGLE DATA
ZONE will always load the file “CURRENT.ADZ” in the current user directory. If this file does not
exist in the actual user directory, the standard data zone will load.

B>
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e [Editing the Standard Data zone or an Already Existing Data zone

1.) Open the data zone using CTRL + D or using the Pop-Up menu VIEW=> DATA ZONE-> DISPLAY
DEFAULT DATA ZONE

\ |

Q

=
P1RF1 i

G,

iy

v Solid Backaround Mode
Tranzparent Background Mode

B ackground Colour...

Line Settings...
Brush Settings. ..

Cirl+L
Cil+M

®| 4
| W4 F (B

Bring to Front
Send to Back Chrl+-
Bring Farward +

Mag = 3X b\_ Send Back

Save az Data Zone...

Lrlack this Panel Delete Del LETMag = a5 M

Photo No. =

2.) Open the Annotation Toolbar by means of the key combination CTRL + A or using the Pop-Up menu
EDIT-> ANNOTATION...

3.) Mark the data zone (light blue squares) with the left mouse button; activate the menu by means of the
right mouse button and select the command Unlock this Panel

4.) Now different elements can be extracted from the datazone or newly created elements added.

HT = 0.00 kv
iD= 10 mm

Signal £
Photo N

.[ZDE,ESE]&[385,5?5],[295,555]:[1 B0=40] LB: Mag= 3

5.) Mark the complete datazone (no single elements), (light blue squares) with the left mouse button and
open the menu by means of the right mouse button.

6.) If you want to change the color of the datazone, the respective color can be selected using the command
Background Color... . 1If you need a uniform letter font for all elements in the datazone, setting is
possible using Set Panel Font... .

7.) Select the command LOCK THIS PANEL. Now the datazone is locked and can be activated or

deactivated by means of the key combination or using the Pop-Up menu. When closing the LEO user

interface, the settings of the datazone will be saved in the file “CURRENT.ADZ” in the current user
directory.

e Creating a New Datazone

1.) Open the Annotation Toolbar using the key combination CTRL + A or using the Pop-Up menu EDIT>
ANNOTATION...

2.) Select Sticky Panels @l in the toolbar and drag the desired annotation panel by means of the pressed
left mouse button.
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@
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3.) Insert the corresponding parameters to the datazone, e.g. magnification by selecting * | in the menu

H
SEM parameters, a |l marker using _| or a logotype by means of the function

L ———
i lInsert User Bitmap or Metafle K|
(1= A 5 &
RN | [ ¥\ P suchenin |3 Mustemann & et [
, ® | a
JENTON P 1 Limic it
L] P
Mag Cal Actal Height
il OD ing Col Al i =l
Aol s Y 7 =G,
g o m M.B: Double Clck a Parameter to Create it Inmediately | A 1
el - ;
M i ﬂi Dateiname. :Leulngnhmp . Biffnen |
Dateitp User Bitmap (~bmip) =] bbbrechen
| 2= 3l I

5 i
20pm

3 Set Panel Font
Ering to Front Crl++ v Salid Background Mode
Bring Forward + Tranzparent Background Made
Make Current Data Zone Background Colaur...
Save az Data Zone... % 2
Line Settings..

Delete Brush Settings.

Don't Make Panel a Data Zonhe

AL E B/ D=
! !

Snap to Grid

5.) Mark the complete annotation panel (no single elements) and open the menu by pressing the right mouse
button.

6.) Click PROPERTIES > LOCK THIS PANEL and then PROPERTIES > MAKE PANEL A DATA
ZONE.

=
&

NERE

- |Bel /| DA
1o @€ %)

et

Propetties

Ering to Front Cirl++
Bring Forward +

Dilete
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7.) There are two methods to convert the annotiation panel into a data zone. The commaand Make Current
Data Zone replaces the contents of the file “CURRENT.ADZ” with the actual settings. A window
opens, asking if one wishes to replace the data zone. Selecting Yes removes the old data zone from the
monitor. Selecting No keeps the old data zone on the screen, however only as a normal annotation field.
The new data zone may be switched on and off via the Pop-Up menu or CTRL + D.

Save n I 23 Mustermann j ﬁl
Annotation Cunent ADZ

DataZanel ADZ

Wiarning - This Diata Zone will replace anp Existing Current Uzer Data Zone. DataZane2 ADZ
DataZone3. 402

Are You Sure You Wish To Replace The Current D ata Zone

Ja

File name: IDaIaZDne4| Save I
Save as type: IDataZone [*.adz] j Cancel |

8.) The second way is to save the datazone using the command Save as Data Zone with an own file name. It

may be reloaded later on using the Pop-Up Menu VIEW > DATA ZONE > LOAD USER DATA
ZONE... (see .
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4.8 Editing Images on the Default Printer

Frozen or stored images which are reloaded to the image store using FILE > LOAD IMAGE... can be edited
to the standard printer using the command FILE-> PRINT SETUP.... 1t is also possible to reach the
following window by pressing the right mouse button within the image area and selecting SEND TO->
PRINTER.

In this panel, the settings in size, position and design of the image to be printed can be entered.

Control Box Print Setup:

ANNOTATION AND MEASUREMENT:
Printing the data zone as well as measurements, annotations etc. together with the image

SEM Overlay:
Printing the data zone together with the image.
Color Merge:
Printer. HP DeskJet B30C Series Printer on LPTT: Must be activated if colored annotations or measurements are to
be printed. The number of gray scales (256) will be reduced by
s Pasion—— .. 11 20 when printing the image.
¥ Annaotation and Measurement

¥ SEM Ouverlay " hiddie Print ! .

[ Colour Merge " Bottom o Control Box Size:

~Size . .

' Fitto Page e e || Fitto Page: . ,

£ Zom | ] [o Adjusting the image to the maximum width of the page.
Printer Mag 173X Help |

Zoom:
Entering a reducing factor for the printout of the respective image. The respective magnification under
consideration of the reduction will be displayed using Print Mag Ref.

Control Box Position:

TOP: Printout of the image on the top of the page.
MIDDLE: Printout of the image in the middle of the page.
BOTTOM: Printout of the image on the bottom of the page.

In Print No., A number may be entered for the printout. This number increases automatically by one at every
printout. This parameter is a global variable and valid for all users. It may also be selected using SEM

Parameter (see and, e.g., be added to the data zone.

Using the key “Printer” the printer used as output media will be selected. Pressing the key “Print” will start
the output.
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5 Stage Functions

The different stage functions can be opened using

SEM Control

e the Pop-Up menu STAGE. Many of thg different
Gun | Apetues  Stage | Aay routines are not implemented by default in the user
Stagedt  GoTo Delts interface and therefore require a license.
X 52300 mm_52.300 mm - Entering absolute and relative coordinates and
| i B 70 setting of certain presettings is done by using
e fzsomn fhesone 10 SEM Control -Tab Stage (see 4.3.6). In this
LT R r window it is also possible to open special
: I_Iizﬂ[):i I—IEZDD:?“ ill functions by pressing the right mouse button in the
lower right part of the window. Using Backlash,
CDmDuC Mode = Off K N
W —— | the backla'sh correction for the motonged stage
Conay = - may be activated or deactlvatgd. A selection of the
. T | DoBsken | AXCS where a backlash correction is to be done can
I FroleciedZ _ Unds Stage 6ot | Ealien be preset in User Preferences (see. . Using the
’7 Stage stop | Ezrznol;ct:rg:;i:ﬁ commqnd 20 Backlash a smgle backlash
e | correction can be performed.
T 1 It is possible to limit the travel of the different motorized axes of the
Ci T o e stage. This is especially useful when working with very big samples
% | Nore {11 0.000 mm f125.000 or if options have been adapted to the SEM, which may affect the
i Nene_JEH 0,000 mm 100,000 travel of the stage. By assigning defined minimum (Low User Limit)
o B 000000 R <5 000 and/or maximum values (High User Limit), the travel may be limited
T Nore BN 000< 1800 Dec and collisions prevented. After opening the function Limits... a
. | DN | | [ETE || O window will open indicating the lower and upper limits of the

| different axes. By double-clicking the left mouse button on one of
these values, a new value may be entered. These limits are user-specific values and will be saved separately
for every user.

5.1 Initializing the Stage (STAGE INITIALISE

If the instrument has been switched off completely (red key) or if the stage loses its initialization for another
reason, the stage must be re-initialized using the Pop-Up menu STAGE > STAGE INITIALISE or by
opening SEM Control - Tab Stage. The stage can also be initialized by pressing the right mouse button
within the lower right part of the window and selecting the command Auto Initialize Stage. The stage will
be driven to the limit switch to define the point of origin. Afterwards, the stage will automatically drive back
to the central position.

/i\ Even if the initialization has not been lost, it may be useful to re-initialize the stage in order to ensure
= 1 exact driving of the stage.
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5.2  Storing of Stage Coordinates (STORE/ REOPEN)

This software enables storing stage positions together with magnification and working distance, so that the
user can drive to these positions later on. The window is opened using the Pop-Up menu STAGE - STORE/

RECALL

Each position can be given a symbolic annotation. If the current magnification and working distance are to
be stored together with the position, activate the parameters Set Magnification and Set Working Distance in
the field On Go To. Activating the parameter Move XY Only will result in displacing only the X and Y

coordinates of the stage.

Stage Points List

File QURYEllGN Dislogs

Set Magnification
v Set'working Distance
™ Move 27 Only

Add | Delete |

[_ [T

Edit I

~ Goto

First | Next | Praviuusl

Selectedl Undo Stage Goto

Point Data Dialog E3
Label: W
¥, [ W
¥ (mm) IW
Z [mm) W
Tea) [iga5
RiDesl [1za7s
M [rim] IW
Mag (] 230
WD [ramn) IW

Cancel |

/N

When storing the actual stage position, the coordinates of the current position
may be assigned a separate name which will be displayed in the stage points list
by pressing “Add”. 1t is also possible to edit the different storage parameters
subsequently by selecting the corresponding name in the list and pressing the
key “Edit’. Deleting positions in this list is done in the same way, by pressing
the key “Delete”.

Moving to special storage positions is done by using the key in the control
panel Go To or by double-clicking the specific position with the left mouse
button.

First:
Moves to the coordinates of the first assigned position in the list

Next:
Moves to the coordinates of the next position in the list.

Previous:
Moves to the coordinates of the previous position in the list.

Selected:

Select a special position in the list by means of the left mouse button. After
pressing the key “Selected”, the stage will drive to the coordinates of this
position. The respective magnification and the working distance will be set on
the microscope.

Undo Stage Go To:
Undoing the last stage movement..

The positions grouped in the list can be stored as a file using the Pop-Up menu
FILE > SAVE and be reloaded using Load.

If you experience problems when driving the stage to the co-ordinates, you should check whether the
parameter Move XY Only has been deactivated in On Go To .

Another way to save stage coordinates is to open the SEM Control window and to open the sub-menu
Record by pressing the middle mouse button (see above).
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SEM Control List Clear:
Deleting various positions from the

Detectors | Scanning I Wacuum I
Gun I Apetures Stage I #-Ray

Stage At GoTao Delka 11St
% [3230mm  [3230mm -
v [57.700mm  [57.700 mm List Load:

Z 12500 mm 12.500 mm Z |

Loading coordinates from a separate
T [130Deq 13.0Deg T I g p

A [om — [@30% 8| file.
b J0omom 000
Compuc. Mo = 0 - List Save As:
[agelozige b2 Bl The annotations contained in the
W Zmowonvet T Joysick e stage point’s list may be saved as a
":T"”"Z Urdotoge oo | E':n"tlpuinwea.we , separate file in the respective user
Frotected 2 Calibrate Stage Centre .. 1
B e | e directory.
List Clear
L Mark Position:
o The coordinates as well as
e magmﬁca‘uon and working dlstapce
B (if activated) of the corresponding
e position will be added to the list with
oo | the annotation “M_X”  without
dfE U assigning a special name. The letter

“X” stands for a consecutive number,
which will be increased by one at
every open.

Label Position:
Assigning an individual annotation for the actual position.

Position List:
Opening the window Stage Points List (see above).

Go To First Point:
Drives the stage to the first position in the list.

Go To Next Point:
Drives the stage to the next position in the list.

Go To Previous Point:
Drives the stage to the previous position in the list.

On Go To Point:
Setting additional information, which is to be saved together with the coordinates for the actual position.

The stage point’s list is user-specific and will be saved separately for every individual user. It is also
/j\ possible to introduce global positions, which will be available for all users. This can be useful for
working with a sample air-lock to save the respective stage position for the transfer of the sample.
These positions will always be created with the annotation “$ + Name” (e.g. $exchange). Creating
global positions requires the privilege “Supervisor” (see .
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5.3 Centering a Point (CENTER POINT)

This function enables the user to mark an object within the image panel which will be driven automatically
to the center of the image. After selecting this function using the Pop-Up menu STAGE 2> CENTER POINT
or the key combination CTRL + Tab, a cross will be displayed on the screen which can be positioned by
means of the mouse. After selection of a point center by pressing the left mouse button.

5.4 Centering a Feature (CENTER FEATURE)

This function enables the user to select a feature in the image area which will be centerd and magnified
automatically so that the corresponding feature will fill the complete image panel. Selecting this function
using using the Pop-Up menu STAGE 2> CENTER FEATURE or by means of the key combination CTRL
+ Shift +Tab. A cross will be displayed on the screen which can be positioned by means of the mouse. By
pressing the left mouse button, a frame may be created. When releasing the mouse button, the content of this
frame will be centered and magnified.

Shift or the Stage may be used for centering. It is also possible, depending on the magnification ,to
use both. The selection will be done using the SEM Control- Tab Stage. Press the right mouse button
in the lower right part of the window. This will open a menu where the different possibilities can be
selected in Center Point/ Feature .

/\ There are three different setup selections for the functions Center Point and Center Feature. The Beam
'

Stage And Beam: Use of stage and Beam Shift for centering.
Stage Only: Use of the stage for centering.
Beam Only: Use of Beam Shift for centering.

For special applications (see [5.9.2) it may be advisable to use only one axis (X orY) for centering.
This may be performd by selecting Stage X Only or Stage Y Only.

SEM Control

Detectors I Scanning | Yacuum |
Gun | Apeitures Stage | #-Fay

Stage At GoTa Dielta

% [szsoomm  [zs0mm
¥ [orrnmm o rmomm
2 frasomm | [2som 2|
T [1300es |[1300e0 | |7
R [230es | [1230e0 L]
| e oo

Hy

Compuc. Maode = Off ¥
[Stage Is = Idie z -
Auta Initialise Stage
v Z Went Joystich ey
¥ Z move on Yerl I Joysticl P s
I Track 2 Limits..
o Undo Sty 2 1 A v Stage And Beam

Calibrate Stage Centre ... Stage Only

Stage stop | Compucentic Setup. Beam Only

Horizontal Alignment ...
- Stage = Only

Becord
2! Stage 't Only
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5.5 Scanning a Field (STAGE SCAN) (Requires the License: STAGESCAN)

This software option allows the examination of a sample area as a series of exactly defined, regularly
dispersed image fields. This function is particularly suitable to tracking particles or other objects in a large
sample area, as it will ensure that no part of the interesting zone will be omitted. The function may be opened
using the Pop-Up menu STAGE - STAGE SCAN. This will open the window represented below to select
the different settings for the fields and to start the function.

Four scanning patterns and several methods to determine the scanned area are available. After selecting the
scanning pattern, position and size of the fields, the fields can be scanned by using different commands. The
scanning pattern will determine the sequence of the scanned fields.

Stage Scan [ =]
¥ Y z FIELD OVERLAP:
StatCo-ord {23000 mm | {14.000 mm | | 0.000 mm
; : overlap % i i
FieldSize  [1173mm | |0880mm | [Field Dverlap= 0.0% . Field 1 Ficld 2
Fields |2?‘ I‘IE Stage Scan =X Boustrophodaon [ 0 %
EndCoord {54000 mm | [28.000mm | [Stage Scan nvalid = No
: +60 %
At Field |'| |1 |Stage Scanning = ldle
Stage Scan Start Here | Stage Scan ends here I Select Area
- 60 %
Stage calc scan | Stage start scan I [ Stage sz
StaneEreykeld | Stager Heqtheld I [~ Stage Backlash

Start Co-ord:

Indicates the XYZ position where the scanning of the fields will start. If the command Stage Start Scan has
been selected, the stage will drive to this position. The values may be entered manually (by clicking the
corresponding field with the left mouse button), by using Select Area (selection by means of Center Feature)
or by using Stage Scan Start Here.

Field Size:
The parameters X and Y will define the size of a single field. These values can be entered manually (by
clicking the corresponding field with the left mouse button) or by selecting the command Stage calc Scan.

Fields:

The parameters X and Y will define the number of fields which the stage will scan in the respective direction
for the whole pattern. These values may be entered manually (by clicking the corresponding field with the
left mouse button) or by selecting the command Stage calc Scan.

End Co-ord:

Indicates the XYZ position where the scanning of the fields will end. The values can be entered manually (by
clicking the corresponding field with the left mouse button), by using Select Area or by using Stage Scan
ends here.

At Field:

The parameters X and Y will indicate the field in the pattern where the stage is positioned at present. These
parameters may be used in annotations (see or can be saved as user-specific parameters together with the
image. To do so, the SEM parameters Stage at Field X and Stage at Field Y must be selected in the

parameter list (see .
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.Field Overlap =:
This parameter can be set manually. It is used in the function Stage calc Scan to fix the scale ov overlapping
between the fields.

Stage Scan =:
Clicking this control field will select the respective scan pattern.

Scan Pattern

X Boustrophedon X- Scan Y Boustrophedon Y- Scan
1 2 3 1 2 3 1 6 7 1 4 7
6 5 4 4 5 6 2 5 8 5 8
7 8 9 7 8 9 3 4 9 3 6 9
Stage XY+Z:

Is necessary for the use of the Tilt Compensation. If the control box is deactivated, the stage will not move
in Z direction. If the control box is activated, the stage will move in Z direction in relation to the Z start
coordinate if a movement in tilt direction is performed.

Stage Backlash:
Activating this control box will result in a stage backlash correction with any stage movement

Stage Scan Start Here:
By pressing this key, the actual stage coordinates will be taken as start coordinates.

Stage Scan ends here:
By pressing this key, the actual stage coordinates will be taken as end coordinates.

Select Area:
This function is used to set the start and end coordinates if the complete scanned area is visible at a suitable
small magnification. To select the area, press this key and continue as explained in

Stage calc Scan:

This function makes the following calculations:

*  The fields will be calculated by means of the actual magnification in relation to start and end coordinates
(in consideration of the field overlapping).

*  The number of fields will be calculated by means of the start and end coordinates and the field size.

Stage star scan:
Pressing this key will start the scan mode. The stage moves to the start position (Field 1/1).

Stage Prev Field:
Pressing this key will drive the stage back to the previous field in the scan pattern.

Stage Next Field:
Pressing this key will drive the stage forward to the next field in the scan pattern.

There are different methods to determine the scan area:

1.) Start and end coordinates are entered manually. Using Stage calc Scan a calculation will be made using
the actual magnification.

2.) Start coordinates, field size and number of fields are entered manually. Using Stage calc Scan the end
coordinates will be calculated.
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3.) Drive the stage manually to the position where the scan is to be started. By selecting Stage Scan Start

4)

78

Here the actual coordinates will be taken as start coordinates. The end coordinates may be selected in the
same way. After doing so, it is possible to select a magnification as suitable for the individual problem.
Selecting Stage calc Scan will result in calculation of field size and number of fields.

If the complete scanned area is visible at a suitable lower magnification, the interesting area can be
selected using Select Area (use of Center Feature). Then a magnification may be selected which is

necessary for the individual problem. By selecting Stage calc Scan the field size and number of fields
will be calculated.
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5.6 Stage Map (Requires the License: CENTER)

This function provides the use of a frozen image in Zone 0 as an overview mapping for the selection of stage
positions. Before opening this function, the interesting sample area should be moved to and be displayed in a
suitable low magnification.. This setting will be the overview map. After setting and adjusting the desired
area, select the Split Screen- mode using the Pop-Up menu SCANNING-> SPLIT or using the
corresponding symbol in the toolbar. Then, the function Stage Map can be activated using the Pop-Up menu
STAGE > STAGE MAP. This will freeze the left part of the screen. The mouse cursor on the left half will
be displayed as a cross. Moving the mouse cursor to the right screen will allow the adjustment of
magnification, focus etc. Then returning to the left screen, the cursor will again form a cross. Now the
interesting points on the sample feature can be selected by pressing the left mouse button. The selected
position will be displayed in the right part at the selected magnification.

End this mode by selecting Normal in the Pop-Up menu SCANNING or by activating the corresponding
symbol in the toolbar.

Zone 0: Zone 1:

Frozen image with Active image with

map magnification. individually selected
magnification.

Select interesting
positions by means of | Mouse cursor:
mouse cursor:

+ s
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5.7 Survey Mode (Requires the License: SURVEY)

The Survey Mode provides the capability to save two microscope settings regarding magnification and
working distance and to switch between these two settings. Example: For low mag. scanning of samples it
may be necessary to select a longer working distance. By doing so, a lower magnification can be set which
allows the imaging of large areas of the sample surface and to select certain interesting zones within this
area. After selection of such a zone, it will have to be examined at higher magnification to distinguish
detailed information. For higher magnification, it may be useful to select a smaller working distance in order
to improve the signal / noise ratio and the total imaging quality. This means that you need two working
conditions, which differ in magnification and the working distance settings (in relation with the Z movement
of the stage). The Survey Mode can be used to automate these two

Survey Resolution | settings.
Before switching between the two modes, the settings for the
Mag << Mag working modes Survey Mode (high working distance, small

magnification) and Resolution Image (small working distance, high
WD >>WD i magnification) will have to be set.

The window Stage Survey tab can be opened using the Pop-Up
menu STAGE-> SURVEY-> SETTINGS... or using STAGE->
STAGE CONTROL... and selection of the index Tab Stage Survey

tab
SR The following procedure is recommended for defining both settings:
Stage Points List tab | Stage Properties tab I
Stage Navigation Tab | Stage Status tab | . . . . .
e o 1.) Set a low magnification and a large working distance on the microscope
Dl and open of the window Stage Survey tab.
WD [ e 2.) In the upper part of the window, the settings for Survey Mode may be
S I;:'S i) defined now. Clicking the keys “Get Current” will enter current values for
v Remember Changes Auto Focus . . . . . . .
= lmimm';—lj ‘ magnification and working distance. It is also possible to enter the desired
e values manually. When selecting. Lowest Mag, the system will
Mag (G GelCunen automatically set the smallest possible magnification.
ﬁDm F 4 Get uren] 3.) Now a higher magnification should be set at small working distance
4 T (modification of the Z drive of the stage). These values can be entered by
"EKI[SUIVE}I Mode ‘ preSSIHg the key “Get Current”.
I Macra ITE Reduced vl
e e 4.) The selection of additional functions is possible for both modes.
e e Selecting Auto Focus will result in an automatic focus adjustment after
activation of the respective operation mode (Survey Mode or Resolution

Image). It is also possible to select certain macros, which will have to be
processed after setting the corresponding operation mode. In the upper example, a reduced scan (see macro:
TB Reduced) will automatically be displayed in the operation mode Resolution Image. When switching
back to Survey Mode, the normal mode (screen displays the complete scanned area) will be re-set
automatically. If a macro has been activated in Exit Survey Mode, it will be processed automatically when
finishing the Survey Mode (remove of the check in the box Survey Mode).

Working with the window_Stage Survey tab:

After setting both operation modes, the Survey mode can be activated using the Pop-Up menu STAGE >
Survey > Survey Mode or by activating Survey Mode (put a check) in the above window. This will set the
corresponding magnification, the working distance and drive the stage to the respective Z coordinate. In this
survey mode, interesting sample zones can be examined. When opening Center Point (see or Center
Feature (see , the stage will be moved to the Z coordinate of the operation mode Resolution Image after
execution of the corresponding function. At the same time, the corresponding magnification and the working
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distance will be set automatically. If additional functions have been defined for this mode, these functions
will be processed automatically after selection of the settings for Resolution Image. In the example above,
the macro “TB Reduced” would be activated to display a reduced scan.

To switch back to the operation conditions of the Survey Mode, press the function key F4. Now it will be
possible to research an interesting area and to switch to the operation mode Resolution Image by using
Center Point or Center Feature.

End the Survey Mode by using the Pop-Up menu STAGE > Survey—> Survey Mode or by deactivating
Survey Mode (remove check) in the above window. If a macro has been selected and activated in the
window Stage Survey tab in Exit Survey Mode, this macro will be processed now. In the above example no
macro would be executed as the macro “TB Reduced” has been selected no check has been entered in the
control box “ Macro”.
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Stage Registration (Requires the License: STAGEREG)

For special samples or tasks, the software option Stage Registration provides the user the ability to create a
unique coordinate system in the horizontal axis using two reference points. Within this coordinate system, it
is possible to drive to separate sample zones or to save certain stage positions.

The new coordinate system is defined in the window Stage Registration. The stage can be moved in the
user-specific system using the window Stage Registered Movement. Both windows will be opened using the
Pop-Up menu TOOLS> GO TO PANEL or using Dialogs in the window Stage Points List (see .
Creating and working with user-specific coordinate systems will be explained in the following example.

v

30

64,14 -

57,074 --=--mmemms

P/(0,10)

Py(10,10)

XEroo

. P2(10,0)

The sample is a square with a side length of 10mm. This
square will be turned 45° in the scan direction and will
be used as the limit for the new coordinate system.

After opening the window Stage Registration, the
annotation Regl will be selected in the list Stage List=.
This label identifies the user-specific coordinate system.
The software allows the definition of up to 9 different
systems (Regl- Reg9).

Individual names for the sample and the coordinate
system may be entered in the fields Registration Name:
and Registration Units:

First, drive the first point of the sample (P;), by means of
the joystick, to the center of the screen. Pressing the key
“First Point” in Record Stage Position will define the
first reference point.

The corresponding absolute coordinates of this point

42,93 50

L

will be indicated in Absolute Stage Position: First

Stage Registration

|5lage List=FReg 1

j IHegistratiDn =es

Registration Mame: IF'mhe1 Registration Units: IQuadrat 45°

Congtant

’7 Tilt Angle: [Deg] IIJ Ratation: [Deg] |45

I¥ Siage Backlash

= A b i
Absolute Stage
Position: [mm] IED I50 I50 IE‘L1 .
Mapped Position ID IU I'IEI |1|]
Mave &xis i~ Aecord Stage Position—— i Go to Absolute Position—
e | First Paint | First Paint I

r— First Reqistration Point—

— Second Registration Point

Biotate |

Second Paint |

Second Point |

Load From File |

Save To File |

Register |

Registration Point ( example: X= 50, Y= 50). If the
actual rotation and tilt values differ from those listed in the field
Constant Axis you will be asked whether the new values shall
be taken. Answer this question with “Yes”.

Now center the second reference point (P;”) by means of the
joystick. Press the key “Second Point” in the field Record
Stage Position to load these values.

The actual values will be displayed in Absolute Stage Position:/
Second Registration Point (in the example: X= 50, Y= 64,14).
By doing so, both reference points of the new coordinate system
are defined.

Now the software needs the relative start and end coordinates of
the new system as a calculation base. In the above example the
new coordinate system is to begin at X'= 0/ Y'= 0 and to end at
X’=10/ Y'= 10 (see P3"). These values must be entered in the
fields Mapped Position. First Registration Point will thus be
the origin coordinates (0,0) and Second Registration Point the

maximum values for X and Y (10,10). When pressing the key “Register” the software will try to perform a
coordinate transformation with the entered values. If a correct calculation is possible, this will be indicated in
the upper part of the window with Registration= Yes.

LED Server : Warning <]
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Now stage control is possible using the window Stage Registered Movement. If the stage is to move to the
center of the new coordinate system, click Sample Go To X with the left mouse button to enter 5 for the X
and Y coordinates. This will drive the stage to the absolute position X= 50 Y= 57,07, that means to the
center of the square. If you want to go to P;" , enter Sample Go To X= 10 and Sample Go To Y= 10.
Entering Sample Go To X= 1 and Sample Go To Y= 1 will drive the stage Imm in X‘ and 1lmm in Y*
direction. If smaller steps are necessary you may enter the values X=100 and Y=100 (instead of X=10 Y=10)
in the field Second Registration Point as append Position. Re-clicking the key “Register” and entering
Sample Go To X= 1 and Sample Go To Y= 1 would move the stage by 100um in X" and Y* direction in the
new coordinate system.

Control of the stage is also possible by using the arrow keys in the window Stage Registered Movement.
Clicking the big arrow key will result in a 10 steps® movement in the corresponding direction. The small
arrow keys will displace the stage by one step each.

Selecting Stage List=Regl in the window Stage Points List will save stage positions so that the stage may
drive to these positions later on.

Stage Registered Movement |_ ] %] Stage Points List =& B Stage Points List == B
File 0OnlGoto Dialogs File  OnGoto el
IStage List =Rea 1 j IHegistralion ="es S,
Stage List = Stage - Stage List =5 T Y YT E——
o = 50— [ron Geo = 500 = -
—— sechange
[3ample at ' = 5.000 [3ample Gota'r = 5.000 Fieg 2
Feg 3
Feg 4

Reg b
Feg 6
Feg 7
Feg 8

el

[ =

s | o et | aid | e | Eq |
il ~ Goto ~Goto
First | i [ | F'rewousl First | =t | Previousl
Selectedl Undo Stage Gota | Gelected | Unda Stage Goto |

The settings of the new coordinate system may be saved in the window Stage Registration by selecting
“Save To File’. By doing so, a file name can be assigned to save the settings in this file. When reloading
settings to the application by clicking “Load From File” it is possible to drive to the positions for the
constant axes T and R by pressing the keys “Tilf’ and “Rotate” in the field Move Axis.
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SEM Contral

| Wacuum

Detectors I
Stage | H-Ray

Scanning

Gun | Apertures

Stage At GaTo

= |4B.DDD mm I 0,000 mm

Delka

e oo |
2 [T w2 |
T [000es [000e | 1|
R [s00es | [3400e | 7|
o s

Compuc. Maode = OFf -

I~ Track 2
Undo Stage Gato |
I Protected 2
Stage stop |
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Compucentric Software (Requires the License: COMPU)

The compucentric software provides rotation-eucentric or tilt-eucentric
control if the stage is not eucentric. This control refers to driving the stage to
absolute and relative coordinates using the SEM Control window Stage (see
and to the use of the function Stage Horizontal Alignment (see
When examining a sample area, which is not placed in the rotation center of
the sample stage, the interesting sample area will shift on rotation of the
stage. The Compucentric software will try to compensate this shift by
adjusting the X and Y coordinates. A similar condition will appear when
tilting the sample. If the interesting zone of the sample is placed exactly in
the center of the screen, a tilt upwards or downwards from the horizontal
line can be watched. This tilt can also be compensated within certain limits
when using the compucentric software.

Before starting to work with this software a calibration of the rotation center
of the stage (Calibrate Stage Center) and of the sample height is necessary
(Compucentric Set Up). Both calibrations are done using two separate
menus. The rotation center must be setup at every stage initialization (see

. The calibration of the sample height from the tilt axis is sample-specific and must therefore be adjusted
for each sample. After performance of the calibrations, it is possible to select the corresponding operation
mode using Compuc. Mode= in the SEM Control- window Stage (see above).

Off:

Tilt:
Rotate:
Tilt & Rot:

Switching off the compucentric software

tilt-eucentric control of the stage by the software
rotation-eucentric control of the stage by the software

tilt- and rotation-eucentric control of the stage by the software

If calibration is only done for the rotation center (Calibrate Stage Center), rotation-eucentric control
of the stage is only possible in the horizontal line (tilt = 0). This is also valid for stages without
motorized tilt axis (e.g. LEO 1530). In these cases, adjustment of Calibrate Stage Center will be

done at a 0° tilt. Rotation-eucentric control will be possible in these operation modes.

Below you will find the explanation of both calibration routines.

84
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5.9.1 Calibrate Stage Center

Open Calibrate Stage Center by using the Pop-Up menu TOOLS > GO TO PANEL... or using the SEM
Control window Stage and clicking the right mouse button within the lower right part (see . When
calibrating, a distinguishable point positioned within the image field will be driven to the center of the scan
area. After a 180° rotation of the stage the same dot will be re-centered. The software will then calculate the
rotation center of the stage using the difference of both positions to the scan center. The calibration may be
repeated for different magnifications (30X, 200X, 500X, 1500X and 2000X).

Calibrate Stage Centre [ %]
Centre % Pos [mm] [E]
Centrz Y Pos [mm] ad Cancel |

Instruction

Please insert calibration grid into the sample
halder. Once fitked click on the NEXT button

< Bach | Next > |
Calibrate Stage Centre [ %]

Centre ¥ Pos [mm] |5D—
Centrz Y Pas mm) |72 [arce] |

Instruction

Please wait while spstem is initialized for
calibration

Bt | Nzt |
Calibrate Stage Centre [ %]

Centre ¥ Pos [mm] |5D—
Centrz Y Pas mm) |72 Cancel |

Instruction

Centre paint a distinguishable mark. when done
click o the Nest button

< Back Next > Load defaults
Calibrate Stage Centre [ %]

Centra ¥ Pos [mm] |50 oK |
Centr Y Pos [mm) |77 Cancel |

Instruction

A rotate of 180 degrees clockwise will happen.
Watch selected mark wery carefully. Click MEXT
button to continue.

con|[ows ]

For the calibration a single sample holder should
be used. It is recommended to use a calibration
grid or a TEM grid sample.

After opening the calibration routine a window
will open where the last measured values for the
center can be entered in the upper part. The stage
will be initialized when pressing the key “Next”.
The stage will then drive to the X and Y values
as entered above.

After initialization, the magnification will
automatically be set to 30X and a graticule will
be displayed on the screen. Now a
distinguishable point positioned outside the
center should be selected within the imaging
area.

Move the distinguishable point to the center by
means of the joystick or using Center Point.
Clicking “Next” will drive the stage to the start
position.

Click “Next” to rotate the stage by 180°.
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Calibrate Stage Centre [ %]
Ceritre ¢ Pos [mm) |50 e |
Centr Y Pos mm) |20 [Eatice] |

Instruction

Fiatating - watch the mark VERY carefully.

>0

o
Calibrate Stage Centre [ %]

Centra ¥ Pos [mm] |50 oK |
Centr Y Pos [mm) |77 Cancel |

Instruction

Centre paint your mark then click on NEXT
buttan

o |
Calibrate Stage Centre [ %]

Centre ¥ Pos [mm]  [51.05
Centrz Pos (mm) |71 Cancel |

Instruction

Centre paint found - to cantinue refining the
centre point position click NEXT buttan.
Othenwise click OF. button.

<-Back |
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Observe the mark carefully during the rotation of
the stage to identify it easily after the rotation.

Re-center the distinguishable point by using the
joystick or the function Center Point. After
centering, confirm with “Next”.

The software has now calculated the new
rotation center and will indicate the values for X
and Y in the upper part of the window.

Clicking “Next” will return the stage to the start
position and the next calibration can be
performed at the next higher magnification
(200X). This procedure may be repeated for the
magnifications 200X, 500X, 1500X and 2000X.
When clicking “OK” the calculated values will
be used for the stage control. The calibration
routine is finished.
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5.9.2 Compucentric Set Up

Open Compucentric Set Up by using the Pop-Up menu TOOLS> GO TO Panel.. or using the SEM
Control- window Stage and clicking the right mouse button in the lower right part (see [5.4). When
calibrating, a distinguishable point positioned within the imaging area will be driven to the center of the scan
area by means of the X-axis and the rotation (move to the horizontal line). After a 2° stage tilt the same point
will be re-centered using only the Y-axis. The software will calculate the tilt center of the stage in regard to
the sample height by using the difference of both positions to the scan center. As the tilt center depends on
the respective sample height, the calibration Compucentric Set Up will have to be performed for each
sample.

The calibration can be repeated for different tilt angles (2°, 8°, 15°, 30° and 45°).

When centering a distinguishable point, only the X-axis must be used for the
horizontal shift. Adjustment of this setting is possible with the joystick or by
means of the function Center Point. The software will automatically switch to
Stage X Only (see .

(T)R Vertical shifts are only allowed by use of the rotation. To ensure a correct
calibration, changes of the Y coordinate are prohibited.

Due to mechanical tolerances, a centered point may drift when tilting from the
vertical line. As with the second cycle (8° tilt) this drift can be compensated by
means of the function Compu. Tilt Error.

To ensure a correct calibration, this drift must not be corrected by means of the
X coordinate.

B — A

The calibration of Compucentric Set Up can only be done after calibration of Calibrate Stage Center (see

.9.1)!

After opening the routine Compucentric Set Up a window will be displayed
Sanpie gkl [2141 | ok | | indicating in the upper part in Sample Height (mm) the distance of the sample
e g oot o voret | __ G | | surface to the center of the tilt axis (calculated value of the last calibration).
{:s;{;;g;gmeahc::‘gggﬁ proraligs This value will be calculated by the software using the calibration. It is specific
e et ten for the respective sample. If the value is known and if no modifications have
Lot || Nt | been performed on the miproscppe (installat@on of a spgce.r), the value may be
entered manually. The calibration can be finished by clicking “OK”. To start a

new calibration, click “Next”.

The sample stage will now drive to the Y coordinate of the rotation center. The
Sarpe Height (. [7577 o tilt will be 0°. A small magnification (30X) will automatically be set on the
Fjﬁ'g‘:gi_nﬁaw t | | microscope and a graticule will be displayed on the screen.
G- B [
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Compucentric Set Up [ %]

Sample Height [mm]: IZEI.'M‘H o] 4
Instuctions ————————————————— Cancel
Please select a poink that is
distinguishable anywhere on the %
axis [you may rotate if required) and
centie it. Do not change the ' axis.
< Banh Mest ->

Compucentric Set Up [ %]

Sample Height [mm]: IZEI.'M‘H o] 4

Instuctions ————————————————— Cancel

Ensure this mark is accurately
positioned. [Use rotate to move point
in* direction - Do NOT use Stage )

= |

Compucentric Set Up

Sample Height [mm):

1~ Instructions —

' The selected mark will now tilt 2
| degrees. Click the Mest button to
| continue.

¢-Back | |2

Compucentric Set Up

Sample Height [mm):

1 Instuctions ———

' Tilking paint to 2 degiess - please
| watch carefully

w.......]\. el

Compucentric Set Up

Sample Height (mm): [251411

el

' Please center point the mark - this wi
| move asis only., Press Nest when |

. ready.
<~ Back

Compucentric Set Up

Sample Height (mm): [251411

el

' Ensure mark is accurately positioned
| then Click Next button

.

Compucentric Set Up

Sample Height [mm): |2

1~ Instiuctions ———

: The stage will now be tited to 8

| degrees. Altematively if pou do not
| wish to calibrate at higher tilt angle
| pleass press OK

¢-Back | |2
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Now the calibration sample must be moved to the scan area by means of the X
and R coordinates. . Position a distinguishable point in the center of the scan
field. After positioning clicking “/Next” will continue the calibration.

Be extremely careful not to move the Y-axis of the stage but only the X
and R axes.

A higher magnification (500X) will automatically be set on the microscope to
ensure that the point has been centered accurately. Fine adjustment by means
of X and R axis is possible.

After positioning, continue the calibration by clicking “/Next”.

The magnification will automatically be reduced on the microscope. Clicking
the key “Next” will result in a 2° tilt.

Tilt will be 2°. The centered point will drift upwards on the screen.

The distinguishable point must be positioned back to the center by using only
the Y coordinate of the stage. Use of the joystick and of the function Center
Point (Stage Y Only will be set automatically by the software) is possible.
After centering, clicking the key “Next” will continue the calibration.

A higher magnification (500X) will automatically be set on the microscope to
ensure that the point has been centered accurately. An eventual fine adjustment
by means of the Y-axis is possible.

After positioning clicking “Next” will continue the calibration.

The software has calculated Sample Height and indicates the new value in the
upper part of the window. If the calibration is to be ended after the first
iteration (2°) the window may be closed by clicking. To continue the
calibration, click the key “Next”.
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Compucentric Set Up [ %]
¢

Sample Height [mm]: IZ?.'I 179

Instructiores

Please accurately centre mark.
Centre point will move ¥ only. To
carect X position use the scrall bar,
Press Mext when ready.

Compu. Tilt Error = 1.000
FERE

Compucentric Set Up

Sample Height [mm): |27.1 179

Instructiores

Sample Height Caleulated. Click on
the: 0K, button to finish

<-Back

0K
Cancel
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If you want to use the compucentric software also for higher tilt angles, it is
recommended to perform the calibration for the next higher tilt angles, too The
stage is to be tilted to 8° now. An eventual drift from the vertical line can be
corrected by means of the scroll bar Compu. Tilt Error. Clicking the key
“Next” will continue the calibration for the following tilt angles in the same
way as explained above.

Further iterations are possible (8°, 15°, 30° and 45° tilt).

When all iterations of the calibration routine have been done, this window will
open at the end of the procedure. The calibration has been completed and can
be finished by clicking “OK”.

The stage moves back to the initial position.
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The function Stage Horizontal Alignment, aligns an object imaged in the scan area automatically to the
horizontal line. For this, two points of the respective object must be defined. Open this function by using the
Pop-Up menu TOOLS 2 GO TO PANEL... or using the SEM Control- window Stage and clicking the right

mouse button in the lower right part (see .

Precondition for the use of this function is the calibration of the rotation center (see .

Stage Horizontal Alignment [ x]
Instruction
Centre Point the first reference point to horizontal align.
‘When done click MEXT' button PZ\
cea | RS Cancel_|
P1
C\ P2
Stage Honzontal Alignment [ %]

Instruction
Centre Paint the second reference point to horizontal align.
‘when done click on the NE=T' button,

< Back | Cancel |
Stage Horizontal Alignment [ x]

Instruction
’VAIignmEnt complete. Click Finish button

P1

< Back | Firish | Cancel |

i e—

After opening this function, a graticule will
automatically be displayed on the screen. One
of the two points must be centered now.

To do so, you may use the joystick or the
function Center Point. After centering click
the key “Next”.

Now the second reference point must be
centered by using the joystick or the function
Center Point. After centering click “Next”.

The respective object will be positioned
horizontally on the screen by aligning the
corresponding stage axes. The second
reference point will be in the center. Finish
the function by “Finish”.
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5.10 Stage Control

The window Stage Control is opened using the Pop-Up menu STAGE 2 STAGE CONTROL. 1t contains
important stage functions. The window is subdivided into six index cards.

Stage Manage
T I I Stage Survey tab (see [.7):
Stage Points List tab Stage Properties tab . . . .
Stage Naviaion Tab | Stagestasten. | | Definition of the Survey parameters as well as starting and ending the
Stage Scanning tab Stage Survey tab Survey Mode
— Survey Mode

f;.”wes'mlgar_ - Stage Status tab (see 5.10.1):
— Indication of the actual stage positions, scanning of fields, absolute and

relative coordinates.

¥ Remember Changes [~ Auto Focus

2 s H ‘ Stage Navigation Tab (see :

—Resolution lmaging—————————————— . . fgl .
. o Navigation help for the position of the sample holder in the sample chamber.
wp [ Getuen Stage Properties tab see :

Lo Pre-settings for the motorized stage and definition of limits for the different

¥ Macro lm :
stage axis.

" Exit Survey Mode

acro SOUCE| o . .
L [T Rediced - ‘ Stage Points List tab (see :

¥ Survey Mod o . . .
o o Saving and scanning stage coordinates.

Load | Save |
Stage Scanning tab (see :

Definition and scanning of special image fields.

5.10.1 Stage Status tab

The index Tab Stage Status tab contains, as does the SEM Control window Stage, the values of the actual
stage positions in the fields in Stage At. Using Go To or Delta, absolute and relative coordinates, for the
stage may be entered and scanned.

The field Field Movement allows scanning the predefined image fields of

o _ the function Stage Scan (see[5.3) by means of the arrow keys if the control
SogeFunsLitdh | - StsePusetestsb | | 1x  Move using Stage Scanning fields has been activated. If not, the arrow
age Scanning tab | Stage Survep tab | K K A .
Stage Navigalion Teb Stage Status tab keys will refer to the respective image feature displayed on the screen.
Stage At GoTo Deta Clicking the corresponding key will displace the stage in horizontal or
% [73.450 mm [73.450 rom ical li h . f
Hy vertical line, dependant on the respective feature.
Y [57.650 mm |57.650 rom
2 [15.000 mm [15.000 mm z | . . .
| T " Clicking the pause kf:y. will 1mmed1ately stop the stage mqvement. .
e — o In Compuc. Moafe.= it is possible to select the corresponding operation mode
M 5000 Fo.000 o i of the compucentric software.
Field Movement
1' il :l il ﬂl The field Stage.ls = defines the status of the motorized sample stage (Idle:
S e stage at stand still, Busy: stage moving).
e W ol < 1| The movement of the stage can be stopped immediately by clicking “Stage
Stage Iz = Idle .
! ga t e stop” whereas “Undo Stage Go To” will undo the movement to the last
age stop ndo Stage Goto ..
position.
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5.10.2 Stage Navigation Tab

The index Tab Stage Navigation Tab provides the ability to get a visual impression of the position of the
sample holder in the sample chamber and to control it in direction of the X, Y and R coordinate. The upper
field Side-on shows the side view of the sample holder. The blue quadrangle symbolizes the limits of the
stage for the Y and Z-axes. The tilted horizontal line indicates the sample height (settings on sample height

and sample holder see )

The lower field Perpendicular shows the top view of the sample holder. If

Stage Manager

e e the stage is not tilted, the horizontal line will also be indicated. The

Slage Searringtab | Stage Suveytab intersection between horizontal and vertical line symbolizes the position of
. e the electron beam on the sample holder (not displayed in the example!).
.. ¥ Double-clicking the left mouse button on a position of the sample holder
ol will drive this point to the intersection by means of X and Y axes. Double-
s okl Tha. clicking the middle mouse-button will drive the point to the corresponding
EE.L;ZT?.%::ESIEF % ' position by means of rotation.

;" . If limits have been set for the X and Y-axes, these will be indicated as a blue

s quadrangle within the field. The thick blue line shows the position of the
This view shows a chamber door.

b If imaging fields have been defined (se), they may be indicated in the
ol & field Perpendicular by activating Show Fields. The red grid will symbolize
S position and size of the fields in reference to the stage center.

5.10.3 Stage Properties tab

The index Tab Stage Properties tab allows different settings for the sample stage and for the sample holders.
In the upper field General basic settings for the sample stage may be selected, in analogy to the SEM
Control window St

age (see [£.3.6).

Stage Manager Zmove on Vent..
Sst‘:;::::j;'::ntj:h || Ss‘f:::;:i - l Activating this function will drive the table automatically to the lowest Z
StagePontsListah | Stoge Propertestab position at any venting of the chamber.
UI;‘ ;I:Dve on Yent I” Protected 2 Track Z_‘
e B Activation of this function will result in the attempt to readjust the focus
F 2:2: f:;zam Bl Stace Backlash automatically at any change of the Z coordinate.
Sampls Holdsr Stage Backlash:
ﬁsamp'e“mde’ﬁ'”gb | ﬂl‘ Activating this control box will perform a backlash correction at any stage
Centre Point Function movement.
|:Centra Paint = Stage+Beam j
Mkl Stage XY+Z:
e O This setting will affect the routine Stage Scan (see). If the control box is
Stage onb Y] not activated, the stage will not drive in the irection when scanning the
, ‘ t activated, the stage will not d the Z direct h g th
f ,’g ”g — different fields. If the control box is activated, a Z movement (dependant on
W e L the value Tilt Compensation) will be performed in relation to the Z start
coordinate if movement is in the tilt direction.
Protected Z:

If this function is activated, the actual Z coordinate will be compared to the new coordinate when loading
saved stage positions. If the new Z position is higher then the actual position, the stage will first move to the
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X/Y/T/R coordinates and then to the new Z position. If the new Z position is lower, the stage will first move
to Z and then drive to the other axes.

Joystick Disable:
Switching on and off the joystick on the hard panel

Using Sample Holder= the adapted sample holder may be selected. This affects the kind of display in the
window Stage Navigation Tab. 1t is possible to select between Single (single sample holder), Multi (eight-
fold sample holder) and Generic. By means of the function “Settings” different settings for sample holder
and respective sample may be entered.

Sample Holder Settings |_ (D] x] Spacer Thickness'-
Is_placermckness= 5000 e The entered value of the thickness of a used spacer.
4

|
Sample Holder Offset:
2| The entered value of the offset angle for the sample holder.

Iialmpla Hoider Offsst = 45.0 Deg
4

E&clmen Height = 2.000 mm j Specimen Height.’
The entered value of the sample height.

M.B: Double click to enter values manually

The operation mode to be used for the functions Center Point and Center Feature (see[5.4) can be selected
using Center Point Function.
Setting limits (see E}, for the different motorized axes of the stage is possible using Set Limits.

5.10.4 Stage Points List tab

The index Tab Stage Points List tab provides the ability to drive to saved
stage positions or to save new positions. New stage positions may be added

Stage Manager

Stage Scanning tab | Stage Survey tab

Stage Navigation Tab. | Stage Stalustab to the list by clicking “Add”, to delete or to edit a selected position from the
o e list click “Delete” or “Edif’. Moving to a saved position is possible by
tage List = Stage | double-clicking the left mouse button on the corresponding annotation in the
Eef:hange list or by using the arrow keys and the key “Go to Selected point” in the
M5 lower part of the window. Pressing the key “Undo Stage Go To” will undo

Paosition2
Position3

the movement to the last position.

i~ Edit paint

Add | Delete | Edt |

— Nawvigation

PRI

GGio to Selected point I Unda Stage Goto I
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5.10.5 Stage Scanning tab

Stage Manager

Stage Points List tab |
Stage Navigation Tab I
Stage Scanning tab

Stage Properties tab
Stage Status tab
Stage Survey tab

243 Fields, at (2.3), with 15.0% Overlap

i~ Field M avigation

i o]

— Stage Scan Pattern o
Setup Wizard
i | it
Advanced |

Define Scan Fields Wizard Step 1 of 4

To define the Stage Scan Fields you must first select the
area for the scan fields to cover
Select this area preferably at low Magnification.

Press "Next »'" to define this area with the mouse.

*'ou can skip mouse selecting by choosing ta enter the
co-ordinates manually

™ Set minimumn tagnification before selecting area.

™ Enter co-ordinates manually [default i screen areal

LED

The index Tab Stage Scanning tab summarizes the different functions of the
software option Stage Scan (see . The upper part will show the defined
fields, horizontal and vertical lines will indicate the respective overlapping.
Driving to a special field is by double-clicking the left mouse button within
the respective field in the graph or by using the arrow keys in Field
Navigation. Clicking the key with the double arrow will drive to the first or
last field. The other two keys allow a one by one movement from field to
field. It is also possible to double-click the left mouse button on at field in
order to drive to a separate field by entering the X and Y position. Using
Stage Scan Pattern selection of the different scan patterns is possible.

Two possibilities are available for the definition of a defined sample area
and for the calculation of the fields. Clicking the key “Advanced” will open
the window Stage Scan (see When activating the key “Setup Wizard”,
the user will be helped to go through the definition of the fields.

Opening the function Setup Wizard will first open a window
to perform two pre-settings. Activating Set minimum Mag...
and confirming with “Continue” will automatically set the
smallest possible magnification. By means of the function
Center Feature a corresponding sample feature may be
selected. Selecting Enter co-ordi... and confirming with

< Back I Next > I

“Continue” will automatically switch to the second window.
In this window the start and end coordinates of the respective

Cancel

Define Scan Fields Wizard Step 2 of 4

You have how selected an area with the following
co-ordinates. Yaou can madify them by mouse-click-
ing on the edit boxes.

% s z
Start [82801 mm [51.497 mm [ 0.000mm

End |81.733 mm 52178 mm

sample feature will be entered manually by double-clicking
the left mouse button on the corresponding figure. Clicking
the key “Continue” will close the window and set
automatically the function Center Feature on the microscope.
After selection of a corresponding sample feature, the second
window will be opened.

This window indicates the start and end coordinates of the
sample feature. Editing the coordinates is possible by double-
clicking the corresponding figure with the left mouse button.
4 | After confirming with “Continue” the next window will open.

Define Scan Fields Wizard Step 3 of 4

*rou must now 200m in the selected area to determine
the Field Size. Make sure you see a satisfactory
amount of detail. From the field size the number of
Scan Figlds will be calculated.

The Magrification is assigned to the left mouse button
Keep the buttan pressed and move the mouse to the
right ta zaom in.

Press "Next > to start zooming in

Press the "Done'” buttn o canfiim your magrification

In this window the user will find the explanation of the
following procedure.

Clicking on “Next”, will automatically assign the function
Mag to the left mouse button. The actual window will be
closed. Now the user may set a special magnification From
this field size the number of scan fields will be calculated. .

Clicking “Done” will accept the magnification and switch to
the next window.
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Define Scan Fields Wizard Step 4 of 4

xX—>

S

“fou have now defined the scan fields.
*rou can redefing the fisld overlap

® hd
Mumber of Fields |6 5
Field Owerdap = 15.0 %

—<

< Back I Finish I Cancel

Magnific:ation adjustment

The last window indicates the calculated number of scan
fields in X and Y direction. When double-clicking the left
mouse button on Field Overlap =, a percent value may be
entered for overlapping of fields. Depending on this value
there may be modifications in the number of fields.

Pressing the key “Finish” will finish the definition and close
the window.
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6 Special Applications and Settings

6.1 User Preferences

The function User Preferences provides the ability to enter special pre-settings for the user interface. The
window, which is subdivided into six index cards, is opened using the Pop-Up menu TOOLS-> USER
PREFERENCES.

1.) Privileged User Directory Setup:

Enables modification of the user directory if this option has been authorized for the respective user in the
Administrator (see . When loading user-specific parameters (e.g. Load state, Load Annotation, Macro
Library etc.), this directory will be used.

2.) Privileged Image Directory Setup:

Allows modification of the image directory (see|2.1)) if this option has been authorized for the respective
user in the Administrator. Enables loading images from this directory or saving images to this directory.

3.) SEM Conditions:

Emission Mode allows selection of automatic brightness and contrast of the detector image when switching
to the emission mode. If Auto Signal is switched Off, the user settings will be used for the respective
detector. Selecting Crosshairs you may select whether a graticule is to be displayed automatically when
selecting emission image. Two presettings are available for the focus wobbler. Activating Reduced Raster
will switch automatically to the scan mode reduced scan when selecting focus wobbler. Using Scan Rate you
may select the scan speed of the electron beam for scanning the sample.

When activating Beam Blanking the beam will be blanked by using the electromagnetic aperture system
after freezing the image. Thus, the sample will not be scanned while the image is frozen, minimizing beam
damage.

Preforence Selection
Frivileged User Directory Setup | Frivileged Image Directory Setup | Privileged User Directary Setup | Privileged Image Directory Setup |
Preseurs - Language - User Level - Enior Messages | Stage | Magnification Table  SEM Conditions Pressure - Language - User Level - Entor Messages | Stage | Magnification Table | SEM Condiions
i~ Emission Mode i~ Focus ‘Wabble i~ Beam Blanking Aperture Align Please Make & Selection
el B — _ Reduced Raster Wﬁl W Pressure Unit Language User Access Level  Eror Meszages
| 0N JTTEF [ON LaFF | ‘ Blarks the beam The macro Save | Novicz | Pap Up OnWating _|
e || saveineun o _mBa | _Fech | _Ewer | _ SumessWaring |
aperhure settings
_ON [OFF [OH" oFF| - Beam ShitMag |

Centring functions
use beamshift if
ahave defined

mag.

542

Magnification Display
’Vﬁ‘ Current Output Device € Polaraid 545 ¥ Feset LUT on unhesze

0K | Cancel Lpply Help 0K | Carcel Lpply Help

The selection Aperture Align provides the choice to select whether the settings for Aperture Align and Gun
Align, of the different apertures, are to be saved when storing special instrument settings using Save State

(see f.1.4).

The selection, Beam Shift Mag., allows pre-selection of the magnification above which the center functions
Center Point and Center Feature are to be performed only by means of the beam shift.
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The field Magnification Display provides the ability to select the output device for the calculation of the
magnification. Selecting Polaroid 545 means that the magnification index refers always to the size of a
Polaroid. Modifications of the parameter Quiput to in the SEM Status- window will therefore not affect the
magnification index. If however Current Output Device has been selected, the user may decide on the output
device, which the magnification shall refer to. For this purpose, the parameter Output to may be selected in
the SEM Status- window. Double-clicking the left mouse button on this parameter will select the respective
device.

4.) Pressure — Language — User Level — Error Messages:

By clicking the different selections in Pressure Unit the pressure unit may be switched to Torr, Mbar and
Pascal.

In Language you may select the language to be used for the display of menus, parameters and for the
navigation texts. At present, switching to German and French is only partially possible for menus and
parameters. The navigation texts are only available in English for the moment.

The settings in User Access Level refer to the parameters and commands which can be selected e.g. in the
SEM Status window (see @) or using the annotations (see) .The respective level can be set by clicking
Novice, Expert or Service.

Novice: frequently used parameters and commands.
Expert: parameters and commands which might be useful for an advanced user
Service: Activation of all available parameters and commands

The selections in Error Messages offer the ability to select how the software is to handle error messages

Acknowledge on event: Indication of error messages. If this key is activated, a window appears at each error
indicating the error to the user. Work can only be continued after acknowledgement
deactivating this key will write the respective message in a list of error messages. In
the SERVER, this list can be checked using Review Unacknowledged Messages or
deleted by clicking Clear Errors + Warnings.

Pop Up on Warning: If this key is activated, a pop up error message will appear for each error. If not, the
dialogue window will remain in the background.

Suppress Warning:  If this key is activated the Warning message will be displayed in a dialog window. If
the key is not activated no Warning message will appear, however a message will be
written into the list of Errors and Warnings.

42 LED SRV-32 _ O] x|
Hestore 01.00 =
Hove Parameter Manag
§|_2§ _ nager Version X0.;
Minirmise Hanager Version :X
P aimise Parameter Manag,

Successfully
i i ne ‘Yersion Numbe
Clear Emars+warnings stully
Help ger DLL, X01.09, 2
er X0.201
Always On Top z

A

& Beviewl nacknowledaed kessages

About LEO
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5.) Stage:

The selection field Backlash allows the selection of the backlash correction for the different motorized axes.
This will increase the travel precision of the stage. When scanning certain sample areas, it may be advisable
to use a higher scan rate during the stage travel. If a corresponding area has been identified, you should
switch back to a lower scan rate to get a noise free image. Such a presetting is available using Fast
Scanning. When switched On, the system will switch to the scan rate selected in the selection bar whenever
the stage is moved. When the stage movement stops, the scan rate will be switched back to the value set
before stage movement began. The same function is valid for the use of noise reduction. (Noise Reduction).

6.) Magnification Table:

Up to 10 fixed magnification values can be entered into the magnification table to be activated later on by
clicking the key “F4”. The system will advance continuously from one magnification to the other. Each
clicking. of the key “F4” on the keyboard will set the next magnification value. By means of the key
combination. Shift + F4 operating with the magnification table will be completed and the original
magnification will be reset on the microscope.

Preference Selection Preference Selection
Privilaged Llser Directory Setup | Privilaged Image Ditectory Setup | Privilaged User Director Setup | Privileged Image Directory Setup
Pressure - Langusge - User Level - Evor Messagss  5tage | Magnification Table | SEM Conditions Pressure - Language - User Level - Enor Messages | Gtags  Magnificstion Tabls | SEM Canditions
- Please Make & Selection G
fitecid Enabled
[~ Backlash —Fast Scanning -~ Moize Reduction M agnification I_ nabled |
0N OFF | 0N OFF | Magrification 1500 Enshled |
Scan Speed 1 hd 5000 Enabled
If the:stage is maving, the beam Manifialion —
* Backlash is on and the image is not
— If the stage is maving. the frozen, then naise reduction wil Magnification 1000 Enabled
4l Directions | ¥ beam is on and the image is be switched off o
nat frozen, then the scanning 7 Bisabled |
Z Backlash 1ate will be sat to the highest Maanification izable
— possible [less t_han or equal to ‘When the stage stops maving
4] Directions | ¥ the rate defined above] the noise reduction wil be Magnification 542 Disabled |
‘Wwihen the stage stops ot
T Backlash moring then the scanning Magrification B2 Disabled |
&) Directions ™ rate will be restored.
Magnitication B Disabled |
R Backlash
OFF - Magnification EE Disabled |
— Magrilication R Disabled
4| Directions ¥
oK I Cancel Anply Help Ok I Cancel Apply Help
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6.2 Bake out of the Ion Getter Pump (IGP)

Evacuation of the gun head is by means of a ion getter pump whose pumping ability will decrease in the
course of time. Regeneration is possible by heating to increase the pumping capability. Under normal
conditions, the vacuum in the gun assembly will decrease continuously. Once the vacuum has decreased to a
value in the upper 10” range (8 to 9*10” mbar) the IGP should be baked out. This bake out procedure can
only be started by authorized personnel (supervisor privilege see .

Bake out:
1.) Switch off the EHT and the gun.

2.) Remove the high voltage cable from the gun head, the EHT supply cable is attached by a plug
connection locked by a black cap with bayonet joint or by four screws. To remove the cable turn the
black safety cap to the left, or loosen the four screws and remove the plug straight upwards with the
cable . IN ORDER TO AVOID ANY MISALIGNMENT OF THE GUN HEAD YOU SHOULD
TRY NOT TO EXERT ANY SIDE FORCE.

3.) The cable plug on the gun head should be covered with aluminum foil to ensure the cleanliness of the
gun area. It is also recommended to protect the high-tension plug on the cable, against contamination by
covering it with aluminum foil or by using an antistatic bag (i.e. PCB foil packaging).

4.) Open the Bake out- window using the Pop-Up menu TOOLS 2> GO TO PANEL > BAKEOUT.

In the window Bake out four different bake out cycles may be selected:

Quick: 2 hours heating/1 hour cooling
Overnight: 8 hours heating/2 hours cooling
|Bakeout State = dle | Weekend.: 40 hours heating/3 hours cooling
User: Individual setting of heating and cooling time. When

|Bakeout Heat = 50.00 Hours double-clicking the left mouse button on Bake out Heat a value between

1 and 200 hours may be entered. The same procedure is applicable for
Bake out Cool. Cooling periods from 1 to 5 hours will be possible.

IBakeuut Cool= 200Hours

5.) After selection of the desired bake out cycle, the bake out procedure may be started using Bake out
State. Start of the bake out process is only possible for users with supervisor privilege. In the User
Preferences (see p.1) the USER ACCESS LEVEL - SERVICE must be activated.

6.) At the end of the bake out re-insert the plug into the gun head, a pin has been fitted to the plug, which
will allow the cable to only fit in the correct position. After insertion of the plug the electric supply will
be locked again by means of the black protection cap with bayonet joint, or the four screws. AGAIN, BE
CAREFUL NOT TO EXERT ANY SIDE FORCE ON THE GUN HEAD!

7.) Now gun and EHT can be switched on again.

Bake out of the IGP is possible in normal operating or standby modes. If, after start of the bake out, the user
interface is to be switched off and the instrument set to standby mode, deactivate the function Partial Vent
on Standby, in Vacuum in the SEM Control window. When partially venting the sample chamber, the bake
out procedure will automatically be stopped.

/!\ When baking out the IGP intense heat will develop. You should therefore be careful not to place any
= | flammable objects on the protection grid behind the electron-optic column
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6.3 Special Scan Modes

Different scan modes are available in the LEO 32 software, used for adjustment procedures, imaging of tilted
samples or the display of different detector signals. These different options can be opened using the Pop-Up
menu SCANNING or by activating the corresponding symbol in the toolbar.

6.3.1 Reduced Scan (Reduced) @

The reduced scan should be used especially for adjustments such as focusing, stigmation or for use of the
focus wobbler. After selecting reduced scan, a frame will be displayed on the screen. If the license
REDUCED has been installed, size and position of this frame can be varied. The frame will define the area
on the sample, which will be scanned by the electron beam. It can be burnt in a saved image if the control
box Annotation (see has been activated when storing the image. In the stored image, this frame will be
represented as a white square.

6.3.2 Split Screen E (Requires the Licence: SPLIT)

On selection of Split Screen, the image area will be subdivided in two zones. Each zone can be assigned
different detectors, and each zone can be frozen independantly from the other. The anchor symbol will
determine which zone detector selection, setting of brightness and contrast or the freezing/deleting will apply
to. Depending upon the side where the anchor has been placed (move the anchor by holding the left mouse
button and dragging the anchor to the desired side), all parameter settings will apply to this area. Double-
clicking the left mouse button on the anchor symbol will assign certain settings to both zones simultaneously
et Parameter modifications will only apply to et Parameter modifications will apply to
"o "  one image zone ":I.l/‘ both image zones.

6.3.3 Magnification of a Feature (Dual Mag ) @\ (Requires the Licence: DUALMAG)

The function Dual Mag enables the imaging of a zoomed image in the Split Screen mode without freezing
the image during the basic magnification. Upon selection of this function, the screen will be subdivided into
two zones and will therefore have the same appearance as Split Screen. Moving the mouse cursor to the
vertical line in the center of the screen will create a double arrow. The size of the frame can be varied by
holding the left mouse cursor and dragging it. In the right image field, the selected area will now be
displayed in the zoomed magnification. It is also possible to change the position of the frame. Another option
- to enter a zoom factor is via the SEM Control- window Scanning (see
. The frame may be burnt in a stored image if the control box
Annotation (see has been activated when saving the image. This frame
will be represented as a white square in the stored image.
The dual mag is useful to point out a specific detail in an image when
observing an image of the sample at low magnification.
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6.3.4 Dynamic Focus (Dynamic Focus) (Requires the Licence: DYNFOCUS)

The function Dynamic Focus enables a dynamic adjustment of the focus [IREWAL: M= E
during the scanning of the beam on tilted sample surfaces. The window will P

be opened using the Pop-Up menu SCANNING > ROTATE/ TILT or 2>
DYNAMIC FOCUS. Using the control box Dyn. Focus the dynamic focus Ii:|F Settng= 0.0%
can be switched on or off. As the dynamic focus is effective in the Y g il L
image direction , the sample surface must be tilted so that the upper image % Sean Flot

border is placed at the sample point with the highest working distance, the
lower image border must be positioned at the sample point with the Scan Fotation = 64.0 Deg
smallest working distance. If the sample surface is not tilted in the proper 1 Fo i
direction, compensation is possible by use of Scan Rotation.

Setting up Dynamic Focus: |2i Angle = 0.0Deg
q

17

Open and activate the function Dynamic Focus

Check if FCF Setting has been set to 0% _ _

Select reduced scan : ‘

Adjust the reduced scan to a thin horizontal line ™ .

Adjust the focus of the image in the center of the screen (use of the e

hair-cross) at a slow scan rate

After focusing the image center, move the reduced scan to the upper or

lower image border

Adjust the focus, of the reduced area, by means of the scroll bar FCF

Setting at a slow scan rate (min. Scan Speed 10). The normal focus

must not be used for image optimization any more!

= Switch off the reduced scan and scan the entire image using noise
reduction

= Switch off the dynamic focus

L

U

U

6.3.5 Tilt Correction (Requires the Licence: TILTCOMP)

This function corrects the perspective reduction caused by the scanning of
tilted samples. At high tilt angles, the electron beam will scan a larger part
of the sample in the tilt direction. This will result in a distortion of the
image. An adjustment of the scanning amplitude in the tilt direction can
compensate this effect.

As with Scan Rotation, the window will be opened using the Pop-Up menu
SCANNING > ROTATE/ TILT. The tilt angle correction can be switched
on or off using the control box Tilt Corrn. The respective tilt angle may be
entered by double-clicking the left mouse button on Tilt Angle or by using
the scroll bar. . Just as for the use of the dynamic focus, you must take into
consideration that the sample surface must be inclined in the screen Y
direction. The adjustment will be performed in the same way as dynamic
focus. For strongly tilted samples, the tilt correction should be used
together with the dynamic focus.

If the sample surface contains steps or other elevations, they will be more
distorted when using the tilt correction. A successful application of this
function is therefore only possible with relatively flat samples
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6.3.6  Scan Ratotion (Requires the Licence: SCANROT)

Scan Rotation allows an electronic rotation of the image by rotating the scan
direction. This window may be opened by means of the Pop-Up menu
SCANNING > ROTATE/ TILT. Using the control box Scan Rot the scan
rotation may be switched on or off. Enter the required rotation angle by
double-clicking the left mouse button on Scan Rotation or by using the scroll
bar. The entered value will be saved when switching off the scan rotation and
reset when switching back on.

6.4 Image Processing (Requires the License: IMMATH)

The functions of Image Processing offer the ability to manipulate mathematically the content of the image
store: e.g. by use of Kernel functions, by adding or subtracting images or by detecting gray scale
distributions. They also allow simple calculations of surface fractions. Two image stores are available:
Buffer A and Buffer B. The image store A is permanently displayed on the screen whereas image store B is a
background store.

The window can be opened using IMAGE 2 IMAGE PROCESSING.

6.4.1 Manipulation of Images (Image Maths)

SEM Image Processing Control El Click the key “Execute” to apply the preset operation to the respective image
R | e e Il store. By clicking Undo the last action can be undone. Depending on the
settings for Source and Destination, the operations will be performed from A

to B or vice versa.

Source Destination

Buffer & =l [putter (Stare) 7]

Opsration Copy To: Copying the content of an image store to another image store
Copy Tor 0 .
ConrTo _ Exchange With:
Exchange ‘with .
had Exchange of the contents of two image stores.
Mir
Add:
Adding the contents of both image stores. The result will be saved in image
Erecue | uro_| store A. If the sum of gray scales of Pixel A+B is superior to 255, 255 will be

result value.

Subtract: Subtracting the content of both image stores. The result will be
stored in image store A. If the difference of gray scales of Pixel A+B is
inferior to 0, 0 will be result value.
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Min:
Identifying the minimum of each pixel in A and B and saving in A.

Max:
Identifying the maximum of each pixel in A and B and saving in A.

6.4.2  Gray Scale Detection (Threshold)

Threshold defines the threshold criteria.. Selections are: Black, White and
2D Filters I Image Maths I
Threshold | Histogram l?quahsat\nn Gray

o Black:

IiTk Thiesold = 31.0 % Each pixel in the image store with a value inferior to the black threshold will
: 2 be colored red. (Black Threshold).

“white:

Iﬁrite Thieshold = 100.0 % White:

4 »

Each pixel in the image store with a value superior to the white threshold
(White Threshold) will be colored red.

Gray:
— Each pixel in the image store with a value superior to the black threshold and
Update | [reaFraction= 629 % |
p inferior to the white threshold will be colored red.

The scroll bars Black Threshold and White Threshold allow setting the threshold values for black and white.

If certain gray scales are colored red in the image, the area fraction can be calculated by clicking the key
“Update”.

If stored images are processed by means of this function which contain annotations and measurements, the
/\ gray scales of these objects will be integrated in the calculation and display.
i

6.4.3 Histogram Equalization

Clicking the key “Histogram Equalization: Store” the image store will be opened for the calculation of a
gray scale distribution which will improve the contrast of the image.

SEM Image Processing Control =]

2D Filers | Image Maths |

Thieshald [ Clicking the key “Histogram Equalization: LUT” will transform the image
by using a Display- LUT so that work can be done with a live image.
Histogram Equalise: LUT
= Reset LUT will reset the calculated Display- LUT

LEO Electron Microscopy Ltd 103



LED

6.4.4 2D Filters

The function 2D Filters provides selecftion of a kernel which will be applied to the image in image store A
or B. The result of this tranformation will be normalised to the gray scale range 0 to 255. All predefined
kernels are based on a 3x3 matrix to which whole numbers have been assigned. Furthermore, an editor is
available to define matrices up to 5x5.

Using Source the store will be selected which the transformation is to be applied to. Nine predefined filters
are available. After selection of the filter start the transformation by clicking the key “Execute”. The last
calculation can be undone by pressing the key “Undo”.

SEM Image Processing Control =] Sm00th"
Threshold i Hiztogram E qualization i Wlll smOOthen the lmage
20 Filters | Image Maths
Sharpen:
i L Will increase the focus
Buffer A l] User Defined... _‘_‘
User Defined...

Sharpen 2:
Will increase the focus

Smooth
Sharpen
Sharpen 2
Horizontal Edge
“ertical Edge
Edge Detect
Edge Detect 2
L aplaciar

Horizontal Edge:
Will detect horizontal edges in the image

Vertical Edge:
- ! i I Will detect vertical edges in the image
Edge Detect:

Will execute a nondirectional edge detection by means of a combined
detection of horizontal and vertical edges in the image.

Edge Detect 2:

Will execute a nondirectional edge detection by means of a combined detection of horizontal and vertical
edges in the image.

Laplacian:
Will detect edges in the image by performing a Laplace transformation using the four neighbor pixels.

Laplacian 2:
Will detect edges in the image by performing a Laplace transformation using the four neighbor pixels.

Pre-defined filters:

Smooth Sharpen Shampen 2
1 21 -1 -1 -1 0o -1 0
2 3 2][16 -1 8 —l] [—l 5 —l]
1 21 -1 -1 -1 0o -1 0
Horizontal Edge Vertical Edge Edge Detect
2 2 2 -20 2] 12 1 -1 01
0 0 0 -2 0z V] Ol+f-2 0 2{]/2
-2 -2 -2 -2 0 2 [—1 -2 —1] [—1 0 1]

Edge Detect 2 Laplacian Laplacian 2

11 1 -1 01 o -10 -1 -1 -1
o 0o o0 /2 -1 4 —l] [—l 2 —]
-1 -1 -1 0o -1 0 -1 -1 -1

+[-1 0 1

101
If you want to use user specific filters, User Defined must be selected in the menu Filters. After pressing the
key “Execute” a list will be displayed (Apply User Defined Filter) indicating any already existing filters. If

104 LEO Electron Microscopy Ltd



LED

no user specific filters have been defined yet, a warning message will first be displayed. After confirmation
of this message the window Apply User Defined Filter will be opened where already created filters can be
selected, edited or deleted and where new filters can be created by clicking the key “New”. Each filter can be
assigned a separate name. The Filter Kernel Matrix allows the user to define a new filter.

Apply User Defined Filter Edit User Defined Filter E3

IMPROC [=] Iter Mame

= Eilter Mame

£ [Filter3

Cancel

Filter Foernel b atriz

it

O o o
i D 2 T o
o o
New.. [ 2 o
o

[

(] 4 I Cancell Help |
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6.5 Editing the Toolbar

Editing the toolbar can be done according to customer need. The toolbar editor is opened by using the Pop-
Up menu EDIT-> TOOLBAR. The left list will indicate all available symbols (52 at present). The symbols
of the actual toolbar will be listed in the window User Toolbar. Arranging the different symbols within the
toolbar is possible by selecting the corresponding symbol and clicking the “Move Up” or “Move Down”.
New symbols may be selected in the window Available Button Images and added to the actual toolbar by
clicking Add. In the same way symbols can be removed using Remove.

Edited toolbars can be saved using Save As with a file name. If toolbars have already been saved as a file
they can be loaded to the user interface by using Load. Clicking the key “Default’ will load the standard
toolbar for the user interface.

If you want to modify the assignments of the different symbols, the corresponding configuration can be
edited by selecting the index tabs Left Mouse Click Button Assignments and Middle Mouse Click Button
Assignment. Selecting a symbol in User Toolbar Buttons will automatically display the respective function
assignment in the window Select Button Action. Activating another function in the selection list will modify
the assignment. It is also possible to attach a short explanation to the different symbols. This explanation will
pop up for a short time below the mouse cursor when positioning it on a symbol of the toolbar. This text will
give information on the actions performed on activating the corresponding symbol with the left or middle
mouse button.

Explanations for the already existing symbols can be opened using the selection window Tip Text. They are
also listed behind each symbol in the window User Toolbar. Entering new text or editing an already existing
text is possible by clicking the key “Resource” in the window Tip Text. It is recommended to separate the
descriptions for left and middle mouse button by a (/).

Modifications of the toolbar will have to be confirmed by clicking “apply” and “OK” to load the respective
modification to the user interface.

Tools Customise

Tools Customise %]

User Toolbar | Left Mouse Click Button Assignments | Middle Mouse Click Bulton Assignmets | User Toolhar ~ Left Mouse Click Button Assignments | Middle Mouse Click Button Assighments |

Available Button Images: User Toolbar i User Toolbar Buttars: i Select Button Actian: i~ Middle Mouse Button Adjustment
= - R — MaciashTE Change Specimen None
Separator — H Restore Conditions/Load 5ta—] Restare Conditic
- - = ’ SEM Control - Q SEM Control
& Undefined \/ Accelersting Yoltage/Gun Co \/ Accelerating ol 4% Commands Mouse
& A Didlogs R Nore
X, Unidefned Specimen Change/Macuum [ Specimen Chars ® Macres
I+ . (D) abiced Gplit
é Undefined 1 Pix &g 1/Cant &g 2 e 1 Pix Awg 1/Cont s O Estoff
efault Fixe
C%D Undefined 2 Fusug3/Cont bvg 4 2 Pabvg3/ont O Exln
-+ Fremze At End
o " Default O Freeze Now
- Undefined Pix &vg B/Cant &g & = Pix Ava B/Cont ¢
SN 3 3 O MOUSE APERTUR
! Undefined Add 4 Fisvasraneins Mave Lp 4 Fisvassmiame -0 MOUSE STIGMATIE
-2 RESUME EXCHAMI
Undefired — Remove 5 Frame Int 7/Frame Int & Move Down 5 Frame Int 7/Frar (2 SPECIMEN CHANG
O TB align
Jub  Undefined " Faster/Slower Load " Faster/Slomer O T énnotation Text
— _ O TB BRIJCONT
Y [ Freeesvrteszeiscanning —— ] [rimagen = O TB A2
d = Slower O TB CA
y Undefined g Mormal/Scanning v=— . 1 Splt Screen O TB CAB
Foid Common Stage G TB Chamberscope
Ay Undefined E Pedused Raster/Apertures oo Stamation iz = [
Toagle In Lens: O TB DualM
0 Undefined m Split Screen/Detectors "Varable Pressu |- ual Mag
ToolTin windawing Mo ~(0) TB Expant TIFF .
E Undefined @\ Dual Magnification/Detectars HFay = Sl L TRFIS | LI—I
TipTest: | Specimen Chaj —
Undefined g ChamberScope/Detector Cur‘
_'_I Source: Resource I I
| - | | — L
0K | tencel | sl | Hem 0k || cencel || s Help

106 LEO Electron Microscopy Ltd



LED

6.5.1 Setting a New Symbol (Example)
The addition of a symbol to the actual toolbar and the assignment with special routines will be explained

0

Clicking the left mouse button: left mouse button assignment: Beam Shift
Clicking the right mouse button: Opening the 4QBSD detector window.

below by means of an example. The assignment of the symbol will be as follows:

First, click the corresponding symbol in the left bar with the left mouse button and copy it to the actual
toolbar by pressing the key “Add” . Then edit the assignment for the left mouse button by switching to the
index Tab Left Mouse Click Button Assignments . In the list SEM Control you may now open the different
submenus.

Tools Customise Tools Customise
User Toolbar | Left Mouse Click Button Assignments | Middle Mouse Click Button Assignmets | User Toobar  Left Mouse Click Button Assignments i Middle Mouse Click Buttan Assignments I
Available Button Images: User Toolbar i~ User Toaolbar B uttars: —Select Button Action: ——————— [~ Middle Mouse Button Adjustment ————
] =] i ] Mone Mone
Undefined Restore Conditions/Load Sta Restore Conditic

g ) g/ _ g/ -4 SEM Control W SEM Contiol

W Undefined \-/ Accelerating YoltageGun Cg \/ Accelerating Val % Commands e I ousze

E Undefined @% Specimen Change/Macuum [ ﬁ% Specimen Chant 3 a::gz e

e ) . . Moaouse
Undefined 0 Undefined e Q ndefine % None
‘l Undefined 1 Pix frvg 1/Cont fivg 2 ——————————je b 1 Pix frvg 1/Cont s 4 Parameters
e Special Functions

l’ Undefined D Pidvg 3Cont kg 4 il 2 Finsvg 3Cort. 2 Tongke

A & . Undefined | Add | 3 Pix Awg B/Cont Avg 6 Move Up |
Commands: Contains various commands (e.g. EHT On, Scan Speed 3, etc.).
Dialogs: Contains the commands to open menus and windows in the LEO user interface.
Macros: Lists all macros, which are part of the standard macro library. If user macros have

been implemented to the library, they will be listed in this section.
Mouse: Contains various parameters to be set or adjusted by means of the mouse.
Parameter: Lists various commands to read or set important parameters of the microscope.
Special Function: Contains the two routines Restore The System Conditions and Save The System
Conditions (see|3.1.1).

Toggle: Lists digital parameters to be used as a switch (e.gScan Rot, Spot, etc.).

As the left mouse button shall be assigned the function Beam Shift and as this function can be performed by
means of the mouse, double-click the submenu Mouse and select the listed command Beam Shift X. A
rhombus in front of the denomination will symbolize the selection.

Tools Customise EZ |ll T ools Customise
User Toolbar - Left Mouse Click Button Assignments | Middle Mouse Click Button Assignments | User Toolbar | Left Mouse Click Button Assignments  Middle Mouse Click Bubton Assignments |
i~ User Toolbar Buttars: i~ Select Button Actior; —————————— — Middle Mouse Button Adjustment 1~ User Toolbar Buttons: | Select Button Action: = Middle Mouse Button Adjustment———
" Mouse\Beam Shift % Mone | || Dialogs\4QBSD Contral L
Restore Conditic Restore Condilic= | b e o
o $ Mouse ;l Q SEM Control " [ SEM Contral = Q SEM Control
.~ Aoosleraling Vol O Aper lign ¥ Only A Mouse | 2 Aceelerating Val =1 1A% bnuse
- Aper Align¥ Only - None | | R Mene
Specimen Chary O Apeture AlignX f"\ Specimen Chany |
O Aperture Align'y |
Undefined I i
Q ndefine ) Aperturo at % | 0 Undsfined | Q) Aperture Calibration
Aperhure at'v | O Aperture Control
Pis A 1/Cant © Pisdva1/Conts | | P
1 8 e 0 Auto Video Mean A piusug et ]
2 Piy g 3/Cont » - Auto Video peak
~() Bakeout Cool
3 Pix Avg B/Cont s O Bakeout Heat
Lo £ o Shift <
A i bva YFrame - () Beam Shit'y

When activating the submenu Mouse, the right list Middle Mouse Button Adjustment will be activated
simultaneously. As many mouse functions can be aligned with only one mouse button, it is possible to assign
the middle mouse button to another routine.

Now for the assignment of the middle mouse button. First, select the index Tab Middle Mouse Button
Assignments. Open the menu for the LEO user interface by means of the middle mouse button, open the list
Dialogs and select the command 4QBSD. If you wish to add a short explanation for the symbol, switch to the
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index Tab Left Mouse Click Button Assignments and click the key “Resource”. This will activate the field
Tip Text: where you can enter the desired explanation text (e.g. Beam Shift/ 4QBSD).

To save the modifications in the actual toolbar, close the editor by clicking OK..

The symbol will now be displayed in the toolbar. By clicking it with the left mouse button, the mouse button
assignment will switch to beam shift. That means that the image field can be moved when pressing the left
mouse button. The middle mouse button will keep its original assignment. Clicking the symbol with the
middle mouse button will display the 4QBSD menu on the screen. (see .

Left b Click Buttan A I i i
User Toolbar  Left Mouse Click Button Assignments | Middle Mause Click Button Assignments | .ilI 5 E H _ [H u 5 T E H HA“ N ]

~ User Toolbar Buttons: ~Select Button Actior: ————————— — Middle Mouse Button Adjustment

Restore Condilc e e File Edit “iew Beam Detection |mage Scanning 5
o Mouse =] Q SEM Contral
. Aoosleratingfol O Bper Align X Orly A Mouse
. - Aper Align Y Only A Mone
@ Specimen Chan, - <> |Beam Shit :f-"
~ Beam Shifty

0 Beam Shit? 408

O Black Threshold
O Brightness I
-0 CCD llumination

q i 1/con;

2 Pis g 3/Cant » ~) Collectar Bias
~2) Contiast
3 Fisewg/Conts QO Cursor Height
O Cursor Width
4 Ficevo3iFne O Dudl Mag Gain
- Focus
5 Frame It 7/Frar <O Frame gl Cal
-0 Fiames to averag
<> Faster/Slower O Baind
- O GanB
4" S """“i]—l O Gamma
-~ HRRU Bright,
Locked | Hrltcked -0 HRRL Contrast
~ HRRL Gamma

- TadlTip O Line g Court

i1 Lk int e r_'_l
TiTet: [am Shit/ 40BSD] RV I
Saurce; User Text I I

aK I Cancel | Apply Help

6.5.2 Use of Bitmaps as Icon Symbols

It is also possible to use bitmaps in the toolbar. Each symbol available by default in the LEO user interface
has an internal number. The numeration of these symbols is listed in the table below. If you want to replace
one of these symbols by bitmap, the corresponding bitmap must have the file name Tooln.bmp. The letter

“n” will be the number of the replaced symbol. If you want to replace the symbol @ by the symbol

the file name must be “Tool30.bmp” .

User bitmaps can be created by means of the program MS Paint part of the Windowsg operating system.
When creating a symbol it is important to file it with a size of 32x31 Pixel. This size can be set in MS Paint
in the menu Image > Attribute (breadth 32- height 31 Pixel). After creation of the bitmap, it must be saved
as a 16-color-Bitmap.

Depending on the settings in the Administrator (see the bitmap will have to be copied to the following
directories.

1. USE COMMON TOOLBAR is not activated:

a) To the corresponding user directory if the symbol shall only be available to the user.

b) To the directory “C:\Program Files\LEO\LEO32\Distrib” if the symbol shall be available to all users
excepting those which must use the COMMON toolbar

2. USE COMMON TOOLBAR is activated:
To the directory “C:\Program Files\LEO\LEO32\USER”.
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ami SEM - [MUSTERMANN]

File Edit “iew Beam Detection |mage Scanning Stage Yacuum Tool: Help

&

o

~

Al [ofe]1]2(3[4]s e/ =] @]

ot | 2 || B

If you want to delete a symbol from the toolbar, it must be deleted in the corresponding directory
user interface must then be started again.

. THE LEO

H Symbol 1 Lk Symbol 14 |_++-s-r-.| Symbol 27 Symbol 40
@ Symbol 2 "y Symbol 15 i Symbol 28 Symbol 41
@\ Symbol 3 w Symbol 16 % Symbol 29 Symbol 42
ggx Symbol 4 | =g |Symbol 17 @ Symbol 30 Symbol 43
& Symbol 5 0 Symbol 18 @ Symbol 31 Symbol 44
(]D Symbol 6 | | Symbol 19 Symbol 32 Symbol 45
E%; Symbol 7 # Symbol 20 4" Symbol 33 Symbol 46

a4
Symbol 8 | Symbol 21 | @z Symbol 34 Symbol 47
& L] |
?zai&‘: Symbol 9 o Symbol 22 ﬁ Symbol 35 Symbol 48
i ) ——
Symbol 10 - Symbol 23 Symbol 36 Symbol 49
w i =

: e/"‘ Symbol 11 ll Symbol 24 1 Symbol 37 Symbol 50
g Symbol 12 ‘ l Symbol 25 2 Symbol 38 Symbol 51
Symbol 13 l} Symbol 26 3 Symbol 39 Symbol 52
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6.6  Macro- Editor

By means of macros, certain control commands and routines of the SEM can be combined in a list. When
starting the macro, they will be processed one after the other. It is also possible to insert loops in a macro so
that certain conditions of the microscope will first be read before starting a routine or a command.

The Macro Editor will be opened using the Pop-Up menu TOOLS > MACRO EDITOR.

MLED Macro Editor -- c:\program files\lec\leo32\useridefault\current.mil

File Edit “iew Insert Library Debug Generator Help

0[5]s] @l [l o]

P[0 | oojmm| | walem) 4|

¥ macro for left button of #2 icon *f

If : TV Input=0ff Is Not True

Normal

Endlf Statement

Scan Speed 3 b
Pixel Noise reduction

F* In case there is a change in noise reduction mode set speed again *}

Scan Speed 3 i
4| | »

[Cumrerit Line: | Current Status : |Last Error ; A

Menu: File
The menu File contains commands and routines necessary for creating, editing and saving macros. A macro
can be saved as a file on a storage device (Save Macro to File) or be implemented in the macro library (Save

Macro to Library). The macro library contains a composition of all macros available in a specific user list.
These macros may also be used for the assignment of symbols in the toolbar (see and for programming

function keys (see .

New Macro:  Creating a new macro. The macro must be given a name and a version number.

Edit Macro:  Editing a macro in the macro library. Selecting this menu will open a window where the
corresponding macro can be selected from a list

Delete Macro: Deleting a macro in the macro library. Selecting this menu will open a window where the
corresponding macro can be selected from a list

Clear Editor:  Deleting the content of the Editor

Save Macro To Library: Saving the macro in the macro library

Save As Macro To Library: Saving the macro in the macro library; the corresponding macro may be
assigned a new name before storing

Load Macro File: Loading a macro file from the actual user directory
Save Macro To File: Storing a macro in the actual user directory with the same name.
Save As Macro To File: Saving a macro in the actual user directory. The corresponding macro may

be assigned a new name before storing
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If the macro is to be available to other users, it will be saved as a

Macro Locations [ %]

abic/ Splt; Librany

ia

Centre Paint : Library

execute - ALeod2ser MLF

Et off : Librany

Ext On: Library

Freeze At End - Librany

Freeze Mow : Library

HY_DETECTOR : . A\Leo324Distib\ MLF
mouze aperture align ;. ALeo32hDistib: MLF
mouse stigmation : . \Leo32\Distriby* MLF
RESTORE4 : User Directary [*MLC)
resume exchange : Library

Specimen Change : Library

standard : . \Leo324U et MLF
standard] ;. A\Leo32\Distrib\= MLC
standard? ;| A\Leo32\Distrib\= MLC
standard3 : ALeo32\Distribl= MLC
StateFile : User Directory [*.MLC)

common macro in the directory C:\Program Files\Leo\Leo32\User.

Macro Locations...:

List of all available macros in the actual user directory, the directory
C:\Program Files\Leo\Leo32\User, the directory C:\Program
Files\Leo\Leo32\Distrib and the actual macro library (Library).

Rename Macro: Change the name of the actual macro

TE align : Library

TB Annotation Test : Librany
TB BRI/CONT : Library

TB CAZ: Librarny

TB Cad : Librany

TB CaE : Librany

TEB Chamberscope : Library

Print...: Printing the macro text on the standard printer
Print Setup.... Open of the printer setting
Exit: Exits the macro Editor

Menu: Edit

The menu Edit provides the ability to edit or delete different program lines, to copy the content of the macro
editor to the buffer store or to insert the text in another Windowsg application.

Undo:
Edit Item:
Delete Item:

Clipboard:

Timeout...:

Menu: View
Toolbar:
Status Bar:

Menu: Insert

Undoing all modifications in the macro Editor since last storage

Editing a selected program line of the macro

Deleting a selected program line of the macro

Copying the macro text to the buffer store

Setting digital and analog parameters (see below) and editing of commands must be done
within a certain time. If within this space of time (timeout) the corresponding parameter
cannot be selected/modified or if a command cannot be edited, an inquiry will be displayed.
The user will now have to decide whether he wants to exit the macro, to ignore the command
and to go to the next program line or whether he wants to wait for the next timeout. Although

this timeout is set to 10 seconds by default, it can be modified using the command
Timeout....

Switching on and off the toolbar

Switching on and off the status bar

When activating the menu Insert, the different program lines of a macro will be inserted. It is possible to
insert commands, loops, decision structures, digital and analogous parameters or to open special window
within the Leo32 user interface. Within a macro, it also provides the ability to open another macro, which is
part of the macro library by clicking Open Macro. Furthermore, other Windowse may be started using the
command Execute Program.
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Decision Structure:

Two different kinds of loop constructions are possible. The IF THEN loop will enable a selection between
different instruction sequels depending on a condition status.

IF “condition” = true (or not true: IF NOT) then
Instruction sequel A
Optional: ELSE- instruction
Instruction sequel B (for the ELSE- part of the loop)
END IF

Example:

A macro is to be created which will allow automatic switch between SE and QBSD detector. First open the
Command New within the Pop-Up menu FILE. Assign a name to the macro (e.g. detector). Now select the
parameter Detector using INSERT-> DECISION STRUCTURE - IF THEN and set it to SE2. This will
define the condition for the If loop. The next step is to define the instruction sequel A. Using INSERT >
DIGITAL PARAMETER - SET DIGITAL STATE the parameter Signal A= will be set to QBSD.

Digital Parameters For 'IF* Statement
— Select & Digital Parameter &nd Select & State CiptallRarameters (]
Farameter IDetector j Select & Digital Parameter And Select & State
Paramneter ISignaIA j
State [sE2 =l
State [{E]1E]
Ok, I Cancel |

Ok I Cancel |

If you want, you may insert an ELSE instruction. Example: The detector QBSD has already been selected
and you want to switch back to the SE detector using the macro. To do so, INSERT-> DECISION
STRUCTURE-> ELSE. Now the instruction sequel B can be defined (INSERT-> DIGITAL
PARAMETER-> SET DIGITAL STATE-> Signal A= SE2). To define the end of the IF loop, select
INSERT-> DECISION STRUCTURE-> END IF . Then define the end of the macro by clicking
INSERT-> END A MACRO.

This macro can be added to the macro library by selecting FILE > SAVE MACRO TO LIBRARY. Thus, the
macro can also be used for a symbol of the toolbar (see p.5.1).

By means of the WHILE loop, a sequence of instructions can be repeated as long as an entered condition is
still true.

WHILE “condition”= true (or not true: NOT WHILE) then
Instruction sequel
END WHILE

Example:

You want to create a macro switching to the function Center Point for map magnifications (Mag Range=1).
After centering a point, the macro will wait a short time. In this time, the user can modify the magnification,
e.g. to magnify a detail. If the magnification is still small, the system will switch again to the function Center
Point , and the macro will wait again. This instruction sequel will be performed until a respective detail has
been centered and magnified in a higher magnification.

First, open the Pop-Up menu FILE and select the command New. Assign a name to the new macro (e.g..
Center Point). Now click INSERT-> DECISION STRUCTURE - WHILE and select the parameter Mag
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Range that will be set to 1. This will define the condition for the WHILE- loop. The next step will be to
define the instruction sequel. Click INSERT=> SPECIAL UIF FUNCTION and select the function Center
Point.

Parameters For While Statement
o Special Functions
— Select & Digital Parameter And Select & State ———
' ~Select & Function—————————————————
Parameter ; tMag Range .I.j

State ' : iEentreF’oint .:j

Data jo
Select For NOT while [ i

ok i Cancel ;

Cancel ;

To be sure that the mouse button assignment is set to Mag/Focus, click INSERT-> MOUSE and assign the
magnification to the left mouse button and the focus to the middle mouse button. Then select INSERT->
DELAY to insert a waiting cycle which will enable the user to center a point and, if necessary, to modify the
magnification.

Mouse Adjustment Parameters

 Select Left Button Parameter — |

ESeIect !Mag ;j .

Delay

Flease Enter The Required Delay In Seconds

IH
i~ Select Middle Buttan Parameter—————————
| = | oK. ] Cancel I
»| |

éSeIect ; Focus

(1]4 i Cancel l

Finish the WHILE- loop using INSERT-> DECISION STRUCTURE > END WHILE.

Finally, define the end of the macro by clicking INSERT-> END A MACRO. The macro can be added to the
macro library using FILE > SAVE MACRO TO LIBRARY. By doing so, it will also be possible to use the
macro for a symbol of the toolbar (see p.5.1).

MLED Macro Editor -- c:\program files\leo\Meo32\uservdefaults .. =] B3 MLED Macro Editor -- c:\program files\leo\Meo32\uservdefaults .. =] B3

File Edt “iew Insert Library Debug Generator Help File Edt “iew Insert Library Debug Generator Help
DJ = & [ ) |"/_xj ¥ || @] | || %] o DJ = & [ ) |"/_xj ¥ || @] | || %] o

If : Detector = SE2  Is True While :Mag Range =1  Is True

Signal A = QBSD Function : Centre Point

Else Continue From Here Left Mouse Button : Mag :: Middle Mouse Button : Focus.

Signal A = SE2 Delay For 5 seconds

Endlf Statement End¥hile Statement

End Macro Detektor End Macro Centre _Point

4 | _'J"I | | .'.l"I
| Current Line | Curreht Status : Editing | Last Errar :Macra Finished Executing | | Current Line | Current Status : Editing | Last Eror :Macro Finished Executing 7

LEO Electron Microscopy Ltd 113



LED

Digital Parameter: Inserting digital parameters in a macro.

Analogue Parameter:  Inserting analogous parameters in a macro.

Command: Inserting a command in a macro.

Stage: Inserting instructions for the motorised axes of the sample stage.
Panels: Opening and closing windows of the LEO 32 user interface.
Open Macro: Opening a macro in the macro library.

Display Message:

The Routine Display Message provides the ability to display message on the screen. After confirming this
message with “OK” , the macro will continue to be processed. It is also possible to perform a Yes/No inquiry
within this message by clicking Enter A Message and activating Yes No Box. The result of this inquiry can
be saved in a flag to be evaluated later on.

Example:

A macro is to be created which will first ask whether the stage has been initialised. If it is not, the user shall
be asked a YES/NO inquiry . Answering “Yes” will initialise the stage; answering “No” will finish the
macro.

First, click the Pop-Up menu FILE and select the command New. Assign a name to this new macro (e.g.
Display Message). Now click INSERT-> DECISION STRUCTURE - IF THEN and select the parameter
Stage Initialized which will set to NO. By doing so, the first inquiry will be realized. Now, insert the user
inquiry using INSERT-> DISPLAY MESSAGE. In the upper part of the panel Message, you may enter a
message or a question. The YES/NO inquiry will be established by activating the field Yes No Box.

T e e
— Select A Digital Parameter And Select A State——— = Enter & b ge
GEEEET S tage |nitialised

State |Mo j

Select For IF HOT* € ¥ esNoBox

IFIag 1] ‘l
Ok I Cancel ITI CANCEL |

The result of the inquiry will be saved in the variable Flag 0. Using INSERT-> DECISION
STRUCTURE=> IF THEN a new loop will be inserted evaluating the variable Flag 0. If Flag 0 = 1
(answering YES to the question), the stage must be initialized. Click INSERT-> COMMAND and insert the
command Stage init. As the macro is to stop if the answer is “/No”, an ELSE instruction will be inserted in
the second IF THEN loop (INSERT-> DECISION STRUCTURE - ELSE). After the ELSE- instruction,
ending the macro will be inserted using INSERT-> END A MACRO . The two IF THEN loops will be
closed after selecting twice, INSERT-> DECISION STRUCTURE > END IF.
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Digital Parameters For 'IF* Statement
—Select & Digital Parameter And Select & State——— =
Select a Command
Parameter  ({EaYI] -
State I‘I j Stage init.

Select For IF NOT'
Ok I Cancel
Ok I Cancel

Finally, define the end of the macro using INSERT-> END A MACRQO. The macro may be saved to the
macro library by selecting FILE-> SAVE MACRO TO LIBRARY . 1t will thus be possible to use this
macro also for a symbol of the toolbar (see .

Available Macros MLEI] Macro Editor -- c:\program files\leo\Meo32\userdefaulthc .. B[] B3

Fil= Edit “iew Inzett Libraw Debug Generator Help

7.

t [w] o] | =[] +] |

|'SelectAMacm [ | w’f’l E"‘l @l.__;%l J\

ITI Cancel If : Stage Initialised = No  Is True

YesMo Message: Flag 0 :Soll der Tisch initialisiert werden?
If :Flag0=1 |Is True

Stage init.

Else Continue From Here

End Macro Display Message

Endlf Statement

EndIf Statement

End Macro Display Message

=
1] | 3

|Cunent Line | Current Status : Editing |Last Eror :Macro Stopped By User 2

Special UIF Function: Opening functions in the LEO32 user interface.

Mouse: Programming the mouse button assignment.

Knob: Programming the encoder of the hard panel (planned for Hardpanel Mark 2).

End A Macro: Inserting the instruction for ending a special macro.

Pause: Inserting a pause function in the macro. If this function is opened on processing the macro,

an inquiry will be displayed. The user will have to decide whether he wants to end the
macro, to ignore the command, to go to the next program line or to wait for the next timeout.

Delay: Inserting a delay loop in the macro.

Comment: Inserting a comment in the macro.

Execute Program: Open an external program using a macro.

Look Up Table: Open the Input- or Display-LUT and undoing the respective LUT.
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Configuration Conditions:

Gun Conditions:

Setup Conditions:

Application Conditions:

Menu: Library

LED

Inserting the Configuration Conditions in a macro.

Inserting the Gun Conditions in a macro.
Inserting the Setup Conditions in a macro.

Inserting the Application Conditions in a macro.

Load User Library: Loading a user specific macro library (*.MLL). The actual macro library will be
replaced by this library.

Merge Libraries: Combination of the actual macro library with a user specific macro library. If both
libraries contain macros with the same name, the user will be asked which macro is
to be used for the new library.

Load Standard Library:

Merge Standard Library:

Loading the standard library.

Combination of the actual macro library with the standard macro library.
Macros with the same name will be replaced by the macro in the standard

library.
Save Library As: Saving the actual macro library in a file using a separate name.
Menu: Debug
Run: Starting the macro in the Editor.
Step: Processing the macro step by step in the Editor.
Continue: Going to the next instruction in the macro
Stop: Stopping the actual macro.
Stop All Macros: Stopping all running macros.

Menu: Generator

Save System Conditions:

Menu: Help

Open of the help function.

116

Saving the actual system settings in a file.
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Many functions of the Pop-Up menu can be opened using the toolbar. Below you will find a list of the

different symbols.
Symbol Explanation Symbol Explanation
[ Creating a new macro ¥ Inserting an inquiry
= Loading a macro from the library 52 Inserting a delay function
= Saving a macro to the library == Inserting a delay function
@ Inserting a command UF Inserting an IF THEN- loop
_EE Inserting a digital parameter Inserting END IF
IJ’\ Inserting an analog parameter Inserting the function ELSE
;r‘x Inserting an analogous pair of 7 Inserting a WHILE- loop
coordinates
¥ Inserting a macro B Inserting END WHILE
UIE Inserting a function UIF 2 Editing a macro
1) Inserting parameters which can be 5. Processing a macro step by step
adjusted with the mouse
o Inserting a comment ® Stopping the macro
6.6.1 The Macro “START”

When starting the LEO user interface, the software will browse the directory C:\PROGRAM
FILES\LEO\LEO32\USER for a macro with the name START.MLF. If this macro is not available, the
system will search in the actual user interface. If the macro exists, it will be processed immediately after
starting the LEO user interface. This enables the user to activate certain routines or external programs
immediately after the start.

Example:

The external program RemCon32, necessary for the communication between the SEM and another computer
(e.g. EDX system) shall be opened automatically after start of the LEO user interface..

1.) Click FILE-> NEW and enter the name “START”.
2.) Select INSERT2EXECUTE PROGRAM. The corresponding file can be selected using Browse.
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MLEU Macro Editor - c:\program files\leohleo32\users. .. =] [E3
Fil= Edit “iew Inzertt Library Debug Generator Help
=S| el AV «[w]e] ¢ [mE-
IE'\ngram FileziLeotLED324emcon32 exe j
aK Cancel Execute C:\Program FilesiLeo\LEOQ32\remcon32.exe
End Macro START =
kX s _'I_I
|Cunrent Line | Current Status = |[Last Ermor : G

3.) Select INSERT-> END A MACRO.
4.) Save the macro using FILE> SAVE AS MACRO TO COMMON FILE.

The macro will now be saved in the directory C:|PROGRAM FILES\LEO\LEO32\USER as file
START.MLF and will be available for each user. If only one specific user shall have access to this macro,
the file must be copied to the corresponding user directory and deleted from the directory USER.

6.6.2 Assignment of Macros to Function Keys

Using the corresponding function keys of the keyboard can also open macros. For this, the macro must be
assigned the name of the corresponding function key and be implemented to the macro library. The function
keys F5 - F8 und F11 and the key combinations Shift + corresponding function key are available.

Example:

The panel Specimen Current Monitor is to be opened by using the key combination Shift + F6.
1.) Open FILE-> NEW and enter the name “Shift F6”.

2.) Select INSERT2PANELS > SHOW PANEL > SPECIMEN CURRENT MONITOR.

3.) Click INSERT-> END A MACRO.
4.) Save the macro using FILE-> SAVE MACRO TO LIBRARY.

MLED Macro Editor -- c:\program files\leo\leo32\uszer. .. [H[=] E3

Eill= Edit “iew |[nsett Libray Debug Generator Help

0|l a] S| x |or o] e ®|=]-

]

Show Specimen Current Monitor Panel

End Macro SHIFT Fb =
Rl | L|_I
| Current Line | Current Status : [Last Error ; o
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6.7 Saving Images in BMP and JPEG Format

The menu for image storage in BMP and JEPG format can be opened by clicking the right mouse button

within the scan area. After se

lection of Send to> BMP File... or Send to> JPEG File... the different panels

will be opened. Both windows are subdivided in two index cards.

As in the panel Export TIFF (seel4.5.1)), existing files will be listed in the index Tab Save. A file name may
be assigned and the file saved in the corresponding image directory by clicking the key ”Save”. The other

settings in the fields Merge,
User Text to these formats.

Comrands

Area and Dimensions will be as explained in4.5.1{ It is not possible to assign

The index Tab Settings allows selection of the format of
; i the file name as well as an eventual Reduction.

Impart TIFF...

TIFF Fie... If SEM images are stored in BMP or JPEG format, they
BMP File. will always be saved as gray image with the corresponding

Feset Dizplay LUT

User Calibration Enable

JPEG File... . . . . .
Qlipboa::. : pallet. Saving the image as a colored image is not possible

FErinter...

Expart BWP [C:\Program Files\LEOSLED:

HRRL...

Save ; Settings; Save Settings
s Merge . —Area 1 Dimensions - e — JPEG Quaity———
..._..-...__..i | ¥ Annotation V wihole w o
Image0D.brp ¥ Overlay 0 Eanck iMax 30 Chars v;
Imagell2 brip v
Imagel03.brp i“‘““““’
Image004.bmp i __j W [1024 | Mo W
Store resolution = 1024 * 768 - | 1““““““" | :
.
;--iFﬂe Mame et ! | Bl Mext noos
| {Image i‘“—“—-:;
| 1 *
[~ 'wide File List
1 ! ! __’__i i~ Lser Text *M.B : This format cannot be loaded back into the SEM Image
Save [Fil005.bmp | | Ii.!

The field JPEG Quality allo

ws setting a value between 5 and 95. The smaller this value, the higher the

compaction (small storage need). By default, JPEG Quality 75 will be set.

Export JPEG ogram LECHLED g ] Export JPEG [C:\Program Files\LEDSLE
Save ; Settings | Cave  Settings ;
: i i~ Merge & :
Ch Diirech | - Filename —JPEG Quality———
R ¥ Annotation w
|mageDD1_ipg v Overlay v o Eanck iMax 30 Chars v;
Imagell2 jpg | I Colour Merge
Image03.jpg 1 L |
Image00d.jpg | i“‘““"‘“‘“““‘“‘"‘}] |
[Store resolution = 1024 ~ 768 B Mo 3 [75
il Reduction Next 005
ilmage = |
I~ ide File List
A ! ! _:_j —User Text ] * M.B : This format cannaot be loaded back into the SEM Image
Save [Fie)05ipg | | Ii! H
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6.8 Magnification Calibration for Different Qutput Media

The magnification is defined as the ratio of edge length of the image displayed on an output device to edge
length of the scanned area on the sample surface. This value will therefore depend on the corresponding
output device. If a certain area of the sample is scanned and then displayed on the screen, the magnification
will have the value X;. If the same area is scanned and displayed on a Polaroid, this magnification will have
the value X,. Both images show the same sample area, but they have different magnifications. The value X,
will be 3-4 times less than the value X; (depending on the size of the monitor), as a Polaroid will be 3-4
times smaller than the image area on a monitor.

The desired output device can be selected in the SEM Status- panel (see . If the parameter Qutput to is
listed in the index Tab Display, it can be modified by clicking the left mouse button. Selection of Display/
File (screen magnification), HRRU (photo unit) and Printer (standard printer) is possible. Depending on the
selected output device, the magnification will be calculated and displayed.

Another option is to open the User Preferences (see in the index Tab SEM Conditions. The field
Magnification Display allows selecting the output device for the calculation of the magnification. Selecting
Polaroid 545 will always refer the magnification value to the size of a Polaroid. Modifications of the
parameters Output to in the SEM Status- window will not affect the magnification value. When selecting
Current Output Device , the calculation of the magnification will refer to the corresponding output device
(Output to).

6.8.1 Calibrate Output Device Magnification

For the calibration of the output device, the menu Magnification Calibration is opened using the Pop-Up
menu TOOLS-> GO TO PANEL-> MAGNIFICATION CALIBRATION to display the window
represented below. Calibration can be done for the monitor and for the photo unit (HRRU). Calibrating the
printer is not necessary as the software will automatically read the corresponding data in the printer driver.
First, click Cal Mode= to select the setting Output Device. On the screen, two vertical lines will be displayed
whose position can be changed by means of the left mouse button. Click Qutput To= to select the desired
output device (Display/ File or HRRU). The distance of both lines will be measured. This value must be
entered to the field Queput Dev cal actual. Clicking “OK” will save the calibration and close the window.

To calibrate the photo unit, select the setting HRRU in OQutput To=. Clicking the key “Photo” will edit the
image together with the vertical lines on the photo unit. Now the distance of both lines will be measured in
the photo to enter the value in the field OQutput Dev cal actual. Clicking the key “OK” will save the
calibration of the photo unit and close the panel.

M agnification Calibration == E3 Magnification Calibration = B3

ICaI Mode = Output Device j
IDutput Ta = Display/File ¥l IDutput Ta = HRRU ¥l
IDutput Dew cal actual = 198,000 mm |Dut|:-ut Dev cal actual = 0.000 mm
Phota |
Ok Cancel | oK | Cancel |

6.8.2 Calibrate User Magnification

The selection of User Magnification in the field Cal Mode= provides the ability to calibrate the
magnification by means of a calibration standard. These standards are available for the various magnification
ranges and with different precision.
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After selecting User Magnification two vertical lines will appear on the screen. These lines will be
positioned in an image area where the exact distance is known (documents on standard). This distance will
be entered in Mag Cal Actual Width. Clicking the key “OK” will save the calibration and close the panel.

By default, calculation and setting of the magnification will be done when calibrating the SEM in the factory.
If you want to use the user specific calibration, click the right mouse button within the scan area and select
the command User Calibration Enable . Calculation and setting of the magnification will then be done using
the user specific calibration. This mode is symbolised by a star on the u marker (see below).

To switch off the user specific magnification, select again User Calibration Enable.

M agnification Calibration (=[] [::;!\ Commands 3
IEaI Mode = Uzer Magnifization j send to ;
Import TIFF...
IDutput To = Dizplay/File j v User Calibration Enable

Resst Display LUT
[Mag Cal Actual width = 10.00 g Baismis e

100pm*

Ok, Cancel I—l
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7  The Help System

The LEO 32 user interface includes an extensive help system offering explanations on the operation of the
microscope, additional options and optimization of images. There are several ways to open the help texts.
Using the Pop-Up menu HELP the different help texts can be selected.

By clicking HELP-> HELP ON HELP a panel will pop up containing general explanations on the use with
the help texts

Help Topics: Windows Help EHE
Help On Help Cartents | Index | Find |
Search ...

Release Naotes Click a book. and then click Open. Or click anather tab, such as Index

LEO Help F1 ':Q Using Help

Getting Started... @ Finding a topic in Help

How Ta... [3] Getting information in a diglog bos
Keys Help Fg @ Copying infoimation from a Help topic

@ Frinting a Help topic

About LED'BZ-- Wiewing a list of topics you've seen
About Dialog Manager... L% Uising the Find tab

About Image Manager... 0 Customizing Help

About Tabbed-Dialog Manager. .. [2] Changing the fort and color in a Help tapic

@ Specifying whether Help staps in front of other windows
Adding a comment to a Help topic

@ Putling a bookmark. in a Help topic

Open I FErint... | Cancel |

When clicking HELP-> SEARCH the window above will be opened, listing important basics on the work
with the SEM in the index Tab Contents. Double-clicking the left mouse button on a book symbol will list
the explanations available on this subject. Opening of the corresponding help text is by clicking “Open’. The
index Tab Index contains an alphabetic list of all help texts. Clicking the index Tab Search allows browsing
the help texts for a special keyword.

Help Topics: Leo-32 Help Help Topics: Leo-32 Releaze Motes
Cantents | index | Find | Cantents | index | Find |
Click a boak, and then click Open. Or click another tab, such az Index. Click a topic, and then click Display. Or click anather tab, such az Index.
@ LE0-32 Help =]
m Getting Started Feleaze V0203
@ Start Here Actions required on inztallation
@ The samplz Bugs Fixed
@ Adjusting the Image @ Mew Functionality
g and Final To @ Changes
Initialize the Stage LED 400 Series hardware requirements
@ Move the S pecimen LED 1400 Seriez hardware requirerents
@ Improve the Moise Level LED 1500 Series hardware requirements
@ Annotate the Image @ Fiestictions
@ Save the Image @ Wo2.02
@ Record the Image @ wo2.m
[2] Piint the Image & vozoo
@ Shut down the Instument @ W10
@ oo =
Close I Frint... Cancel | Cloze I Pririt... Cancel
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The panel Leo-32 Release Notes provides important information on the different software version. It
contains the explanation of new functions, eliminated software errors and particularities of the different
versions. Clicking the Pop-Up menu HELP -> RELEASE NOTES will open this window.

If no menus are opened in the LEO 32 user interface, opening HELP-> LEO HELP or pressing the function
key “FI” will open the window below where the user will find basic information on the SEM and on the

handling of the software. Clicking the different titles with the left mouse button will open the respective
explanations.

& LEO_1500 Series [_[o]]
File Edi Bookmak Opfions Hep
Contents| Index [ ok [ Bint [ o [ o |
Contents LEO-32 Help
LED :|
=d The LEOQ Scanning Electron Microscopes are completely software contrC T e ar u (=[]
For help call Context Sensitive Help. File Edt Bockmark Options Help
. i Conterts| Index | Back [ Pint |
Important Information Getting Starttl =4 ntants: How To...
. The following are easy to follow, step by ii
Operation of Instrument How ED step guides to frequenthy-used operation

sequences of the SEM

- HOW TO ...
Description of the Instrument Restore/Save the System Conditions
Exchange the Specimen (Airlock not

Interfaces fitted)

- Exchange the Specimen (Airlock fitted)
. . g N

Operating Principles Release Notes | Sasig HowTo

Use Stage Functions
Autemate Airlock Specimen Exchange
Accessories Run up the Electron Beam

Align the Electron Beam
Care, Maintenance and Trouble Shooting

Glossary Select Magnification
Adjust Focus

4 Select and Align the Aperture
Correct for Astigmatism
Select the Detector =

Selecting HELP-> KEY HELP or clicking the function key “F9” will indicate help texts for the use of the
keyboard. Many key combinations are also used in the LEO 32 user interface, e.g. combinations to open

menus or to start different routines. The help text LEO Keys will offer explanations for these different key
combinations.

& LED_1500 Series [_[O]x]

Fie Edt Bookmal Options Help
Contents| Indes | ok | Bt | o [ o | |

Menu Help Keys Help

& LED_1500 Series [_[O]x]
File Edt Bookmak Options Help

=

Bl Type <K> to open Keys Help Contents| Indes | Back | Bt | < | o | |

B Keyboard Key:EIE I = ]
Click on Keys Help to open Keys

® File Edt Bookmark Options Help

INAOWS:!

Cursor Movement Keys o e | [ B Lz I ]

Keys Help explains the use of keys for st Dialog Box Keys LEO Keys
through Windows95 software and LEO a Editing Keys
keys Help Keys
Menu Keys The following keys are shortcut keys and have special meaning
To jump there click on Keys F&aln Swstem Keys

t Selection Keys <F2> Toggles Tool Bar on/off
xt Selection Keys prr——
<F2 + SHIFT> Hysteresis removal
indow Keys —
ition keys for special ce| SE2” Closes all windows except the
50 Ke \; et P Tool Bar and Status Bar
i e Reved <F3 + SHIFT> Toggles PC Plane ONIOFE
<F4> Step to next Magnification Table
entry, or Undo Centre Feature Magnification
<FA + SHIFTS Fuit fram Maanificatinn Tahla ll

If menus are opened in the LEO 32 user interface, clicking the function key “FI” will open the help text for
the specific menu. This provides the advantage that an explanation of the corresponding menu is now
possible during the operation of the SEM. Selecting Option 2> Keep Help on Top = On Top using the Pop-
Up menu of the corresponding help panel will position the indicated help text in the foreground. Selecting
Standard will automatically displace the help window to the background when switching to the LEO 32 user
interface (clicking the menu bar or the scan area by means of the mouse); the help panel will not be

displayed on the screen any more. It will appear back on the screen when clicking the Windowse- task bar or
using the key combination, ALT + TAB.
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SEM Control

Detectors |  Scanning | Vacuum |

Gun | Apertures Stage | MRy |
Stage At GoTo Delia
% [rzoo0mm | [l2ooos | |

<2 SEM Control [_ O] x]
v [13s0mm | 13 Fle Edt Bookmak Options Help

Z [aooomm | [0 [[Contents| Index | Eocl [ Bint |

T [&===5 SEM Control Stage
R [0 i’
W [0 This function displays the Stage Control panel used to display and control the position

of the motorised stage

[CompieFiodz =T | general information about the stage see Stage Overview

W Z mave onWent
[ Track Z
¥ Protected 2

—

coordinates

il
Detector

Click on any other active Go To fisld to open a nermal input Gy
value box and to enter the coordinate

=

SECECEERE

K

Click on the elements of the dialog for more information

F Note The Stage Stop button will abort stage movement
This may also be achieved by pressing F12

T D 4 N o< X

Click on the tab background with the right mouse button to open
the Stage Popup Menu.

»  Select anather tab or close SEM Control with B
KN

A context sensitive help for the first steps when operating the microscope are available by pressing the key
combination SHIFT + FI1. The mouse cursor will now become a question mark. In this mode, selecting a
function or a symbol with the left mouse button will display a help text of this specific symbol or menu. The
context sensitive help can be switched off by pressing the key “ESC”.

4=, SEM - [MUSTERMANN]
RSN = [ F0_1500 Series M= e

g - File Edt Bookmark DOptions Help
_I/ Qantantsl Index I Back | Print | % | 2 I

k7 ;

ﬂl Restore Conditions Icon {lcon 1)

The standard use of this icon is described below, but may have been modified
Left Mouse button performs the Restore Conditions function.

Middle Mouse Button performs the Load State function

It is also possible to print the different help texts by selecting File=> Print Topic in the corresponding help
panel. The text will then be printed on a standard printer. When using the key combination Ctrl + C or
clicking the Pop-Up menu Edit—> Copy the help text will be copied to the buffer store to be added to other
Windowsg applications. Note however that only the text will be copied to the buffer store without the
graphics of the respective help menu.

The different help texts may include user remarks by selecting Edit=> Annotate in the respective Pop-Up
menu. You may then enter text in the window Annotate. This text will be stored in the help files when
pressing the key “Save”. A little paper clip will now be displayed in the left upper corner of the window to
symbolize that a remark has been entered on the respective subject. This remark is not user specific; that
means any user may use it by clicking the paper clip with the left mouse button. Each user will be able to edit
or delete such a remark.
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2~ LED_1500 Series O] x|
File Edit Bookmark Options Help
Eonlentsl Index | Back | FErint | o | s |
I Annotate H 9
| —— Curent annatation: )
f}‘];l [T he full frame is used for scanning. ;I Save below bt may be

Focus Wobble sweeps the focus of the

@ objective lens backwards and forwards
through focus on the specimen plane. When
the aperture is mizaligned a lateral shift iz Delst= | 'B Mormal

Thie observed.

Cancel

Copy

Ele il g

Past :
== 1o Mouse adjustment.

El
\E/ Middle button click displays the SEM Control Scanning tab.

See also Macro Editor
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8 Important Keys and Key Combinations

Keys Function

F1 Opens the general help texts for the microscope

Shift + F1 Opens the context sensitive help

F2 Switching on and off the toolbar

Shift + F2 Performs a correction of the lens hysteresis

F3 Switches on and off open panels in the LEO user interface

Shift + F3 Switches on and off the PC plane

F4 Activates the magnification table, switching to the next set magnification

(see — or undoing the Center Feature magnification (When pressing the
key F4 after use of the Center Feature function, the previous magnification
will be reset)

F5,F6, F, F8, F11(with or

Reserved for user macros

without shift key)

F9 Opens the help for keys and key combinations

F12 (with or without shift Immediate stop of the sample stage

key)

Tab Switches between coarse and fine settings

CTRL + Tabulator Opens the Center Point function (see

CTRL + Shift +Tabulator Opens the Center Feature function (see

Home Resetting the image shift to 0

Scroll Lock Switching between freezing and deleeting of image store
Pause Stopping an activated macro

* Starts the function “Find Image”

CTRL +2 Loads the actual image to the “Second Image Window”
CTRL+ A Opens the Annotation Panel

CTRL+B Opens the window Toolbar View

CTRL+D Switches ON/OFF the data zone display

CTRL+E Opens the TIFF Export panel
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CTRL +F Performs an automatic fine focus

CTRL + Shift + F Performs an automatic coarse focus

CTRL+ G Opens the SEM Control window

CTRL +1 Opens the SEM Status window

CTRL +M Opens the Annotation window and starts point-to-point measurement
CTRL+0O Opens the TIFF Import window

CTRL+P Displays the printer control window.

CTRL + S Performs an automatic astigmatism correction.

CTRL + Shift + S Performs an automatic astigmatism correction and a fine focus
CTRL+T Opens the Text Editor

CTRL+V Open the Vacuum Panel in the SEM Control window

Shift + arrow key (N) Starts the option Stage Scan (stage will drive to the first field)
+ Increases the scan speed by one value

Decreases the scan rate by one value

Shift + double-clicking the
left mouse button within the
image

Activates the Center Point function

LEO Electron Microscopy Ltd

127



LED

9  Optional Applications

9.1 Working with the Hard Panel/Joystick

By default, a joystick will be available for the control of the motorized axes of the sample stage. In the upper
display the actual coordinates of the stage will be entered. By means of the left big joystick it will be possible
to move the X and Y-axes. By turning the upper button the right or to the left, the rotation of the stage will be
controlled. The smaller right joystick will be available for the control of the Z-axis and for the stage kilt (T).

All axes are magnification compensated. When working with a lower magnification, the stage will move
relatively fast. When using higher magnification, the stage will move slower. The same principle applies to
the sensitivity of the joystick. When slightly moving the joystick, the corresponding axes will move slowly.
On stronger movement the stage will drive faster. Simultaneous control of the different axes is also possible.

4 1 - Control of the X and Y axes of the stage is by moving the
joystick to the corresponding direction and control of the stage
rotation is by turning the joystick to the right or to the left

2 - Control console

3 - Moving the Z and Tilt axes

4 - Display with the actual stage position(not on all panels)

It is also possible to control the stage by means of a hard panel, which will allow control of the motorized
axes of the sample stage as well as setting and alignment of special parameters by means of the
potentiometer. The different functions of the hard panel will be selected by pressing different keys. This will
result in a re-assignment of both potentiometers and of the joystick. The different parameters that can be set
by means of the potentiometer (Encoder) (14, 15) and joystick (16) are listed below.

The functions 1 to 7 are always assigned to the potentiometers, whereas setting of the stage coordinates is
possible by means of the potentiometers as well as by means of the joystick.
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- Focus/ Magnification

- Stigmator X/ Y

- Image shift X/ Y

- Image Rotation fine/coarse
Blocking the joystick

- Adjustment of the apertures X/ Y
- Centering the cathode X/ Y

- Stage axes X/ Y (Potentiometer)
- Stage axes X/ Y (Joystick)

10-  Stage axes Z/ T (Potentiometer)
11-  Stage axes Z (Joystick)

12 -  Stage axes M/ R (Potentiometer)
13-  Stage axis R (Joystick)

O 01O\ W A~ W=
1
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The menu Airlock is opened using the Pop-Up menu TOOLS 2> GO TO PANEL > AIRLOCK. This menu is
specially for SEMs with a sample airlock. In the field Separation Valve the user may control the V3 valve
(isolation valve between tip area and sample chamber). When clicking on “Close Column Chamber Valve”
the corresponding valve will be closed to be re-opened using Open Column Chamber Valve. The
corresponding status will be indicated in the field Column Chamber valve=. Opening the V3 valve is only
possible after reaching system vacuum (sample chamber). Closing this valve is only possible after switching
off the acceleration voltage.

Airlock

= 3

— Separation Y alve

|EOIumn Chamber valve = Clozed

| Open Colurnn Chamber W alve I

ElazeEalumm Ehamber talve I

- Airlock
Jirlock is = Clozed

I.t'-‘«irloc:k Ready =MNo

Fump | Went I

helfeletE = |

Specimen Change I

Resume Exchange |

Normally the vacuum will deteriorate due to the locking. Even after closing
the separation valve between sample chamber and airlock, the turbo pump
will need a certain time to pump the area of the sample chamber to a
corresponding vacuum. Opening the V3 valve will only be possible after
reaching this limit.

Some special sample airlocks may also be controlled using the LEO 32 user
interface by clicking the field Airlock. Clicking “Pump” will start the
pumping procedure of the airlock. When reaching the necessary vacuum, the
setting Yes will be displayed in the field Airlock Ready= . It is now possible
to open the separation valve between airlock and sample chamber and to
exchange the samples. After closing the separation valve, the sample airlock
can be vented by clicking on “Vent”.

Some airlocks have a “Stop function”. When pressing the key “Hold
Vacuum”, the pumps of the sample airlock will be switched off , but the
airlock will not be vented automatically.

To enable a semi-automatic exchange of samples, the keys “Specimen
Change” and “Resume Exchange” are available. Both keys will open a
macro listed in the directory C:\Program Files\Leo\Leo32\Distrib. These
macros contain basic settings for the sample exchange. They can be edited
and adapted to the requirements of the respective user and instrument.

Default parameters of the Macro “Specimen Change”:

1.
3.
4,
5.

6.

Message asking if the stage has been initialised. If not, the macro will be stopped.
Activating the CCD camera (if adapted)
Asking if the electron beam has been switched on. Yes—> Switching off the high tension. If not, the

macro will be stopped.

Inquiry if an Airlock Control is available. Yes—> start of the pump procedure. If not, jump to the next

instruction.

Driving the stage to the position $exchange (this global variable contains the stage position for

airlocking samples)
Closing the V3 valve

If the macro has been processed without error, the message “Ready to exchange” will be displayed. Now
the valve between airlock and sample chamber can be opened to exchange the specimen. After doing so,
close the valve and press the key “Resume Exchange” .

Default Processing of the Macro “Resume Exchange”:

AU e

Finish the macro “Specimen Change”
Delay loop untill release of the vaccum (not more than 2000 seconds)

Opening the V3 valve

Venting the airlock (if Airlock Control has been installed)
Selection of the inlens detector as signal source
Closing the panel “Airlock”
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If the macro has been processed correctly, the message “Resume completed’ will pop up. Now the
acceleration voltage may be switched on to continue the work on the microscope.

On the first opening of the macro “Specimen Change” the message below will be displayed to inform the
user that the macro must first be adapted. After clicking “OK” the message will be closed and the macro
finished.

Macro Message

This is the default specimen change common macro. |t must be edited for your configuration, saved as a common macro and then
deleted from pour macro librar

Editing the macro will be done using the Macro Editor by opening the Pop-Up menu TOOLS > MACRO
EDITOR... . After start of the Editor, the file “Specimen Change.MLF” will be loaded to the Editor using
the Pop-Up menu File> Load Macro File. This file is saved in the directory C:\Program
Files\Leo\Leo32\Distrib.

LALEO Macro Editor -- c-\program filesileo\leo32\user\default\current mil

MLED Macro Editor -- e:\program files\leo\leo32\user\default\current mil

Fle Edi Yiow e Loy Debug Geneolor Heo Fie Edt View Insen Libray Debug Genewtsr Help
sls] el € sle] | (w2 wlmlx] wlaf -] o] p|=|e] o) ¢ |ole] |2 [m| 2| w|m]x] |z 4] [8]
=

* THIS MACRO IS USED WHEN AN AIRLOCK IS FITTED %

7~ This macro is called from toolbar and airlock panel to perform the first part of specimen exchange *f
{* It must be edited to suit the user's requirements. Delete the next two lines %} F* THIS MACRO IS USED IF AN AIRLOCK IS FITTED %

Message : This is the default specimen change common macro. It must be edited for your configuration, saved as a common macr¢ [+ This macro is the second part of specimen exchange - called from aiflock panel %
E"“;:;mfl’:hm CNo 1 True * It may be edited to suit the user's requirements *f

Message : Stage Is notiniiallsed - aborting macro [+ Abort Specimen Change Macro - allows user to change his mind by pressing resume
End This Macre End Macro SPECIMEN CHANGE

Endif Statement Waiting for Vac Status = Ready - [ 2000 sees ] Halt on timeout

If : Column Chamber valve = Open  Is Not True

Open Column Chamber Yalve

EndIf Statement

Show Airlock Panel
If : Beam State = Beam On  Is True

EHT Off

Else Continue From Here If : Airlock Control = Yes  Is True

If : Beam State = EHT Off s Not True Vent Airlock |
If : Beam State = Shutdown  Is Not True Endlif Statement

Message : Beam state not Shutdown, nor EHT On nor EHT Off. Aborting macro. Switch Gun On and retry. [ Add here instructions to move stage, EHT On etc as required %/

End This Macro

Endif Statement Signal A= —

ndif Statement o

EndIf Statement Hide Airlock Panel _lll
Endlf Statement kil »

If : Airlock Control = Yes  Is True —I| [Curentline 10 [Curment Status : Editing [Last Enor: ¢

Pump Airlock
Endlf Statement

I Modify the following statement as required *

Stage goto Z= 1.000 mm

Waiting for Stage Is = Idle - [ 300 secs ) Halt on timeout

I If stage does not have motorised 1ilt the next two instructions should be deleted %

Stage goto T= 0.0 Deg

Waiting for Stage Is = Idle - [ 300 secs ) Halt on timeout

[* The global label SEXCHANGE is assumed to have been set up to the airlock exchange position %

Stage Goto Label $exchange &
| | r
Curert Line 10 |Current Stalus : Ediing [Last Enor 7

Editing the Macro:

1.) Delete the message (Message: This is the...) and the command End This Macro in line 5

2.) Select of the CCD camera in line 10 (if adapted)

3.) Delete the command Stage Go To T= 0.0 Deg and the following delay loop in line 30 if the stage is not
equipped with a motorised tilt axis

4.) Control whether the global position $EXCHANGE is available and whether it contains the correct
coordinates for the airlock position (if not, the position SEXCHANGE must be set using the stage

coordinate storage (see

The macro “resume exchange” can also be edited by the user. It is in the same directory as the macro
“Specimen Change”. It will be useful for example to insert new commands as from line 13 to drive the stage
to a special position or to switch on the acceleration voltage automatically.

After editing a macro, it will have to be re-saved. If it is implemented to the macro library by using the Pop-
Up menu FILE->SAVE MACRO TO LIBRARY , it will only be available for the respective user in his
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directory. If the macro is to be used by all users, it must be saved using FILE> SAVE AS MACRO TO
COMMON FILE.
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9.3 Gun Monitor Utility

The program Gun Monitor Utility provides the ability to record important parameters of the microscope in
certain intervals when operating the LEO user interface and to display them in form of a graph. The menu
may be opened using the Windowsg-interface START> PROGRAM-> LEO-32 SERVICE-»> GUN
MONITOR UTILITY.

Clicking the Pop-Up menu MONITOR 2> START will start the record. Using the window Display Options
(Pop-Up menu: MONITOR-> OPTIONS...) selection of the different channels and of the colors will be
possible (8 channels are available). Six of the eight channels are pre-defined to record extractor voltage,
extractor tension, filament heating current, vacuum in the tip area, liner tube voltage and acceleration
voltage. Removing the check next to the parameter by clicking with the left mouse button will suppress the
recording of this parameter. The two parameters at the end of the list may be edited freely by the user by
selecting one of the parameters proposed in the respective list.

The square close to the parameter indicates the color assigned to the parameter in the diagram. Changing this
color is possible by clicking on the square with the left mouse button. When doing so, a color pallet will be
displayed allowing the selection of a new color. The columns Min. Value and Max. Value will indicate
minimum and maximum values of the different parameters. These limits, which will affect the presentation
in the diagram, can be modified manually.

After entering all settings, the panel will be closed by clicking “OK”. Pressing the key “Defaulf’ will undo
these settings and return to the basic condition.

== Untitled - Gun Monitor Display Options
File  Monitor  iew Help — Digplay -
Min. Yalue Max Value
,,, ()4
0= .| ] |e:a| & | 1] —=
| |n|m| él ?l 1 _I @ _I_I_l . ¥ Ewutractor ¥ ID— 3000 W
B B
W Eutractar | I I L
i 0 300 Defaults |
. [+ Filament | ID— W mé
W Gun Y : | - | B
: . ¥ Gun ¥acuum 1e-010 0.0001 o
T . ¥ Linery [0 [5000 W
’ \ Been | ET
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Estractor: 4200 141215 Liner Tube = -
whractor A . Il ID— IW [Degrees
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MonitodIntziyals Xl The monitor interval of the different parameters can be set in the window
Monitor Interval... which can be opened using the Pop-Up menu
Cancel MONITOR - Interval... or by using the corresponding symbol in the toolbar.

Settings will be possible between 1 and 60 seconds. After selection of the
interval, the window will be closed by clicking “OK”’.

Manitar Interval W
[zeconds] -

After starting the monitor, the different values of the parameters will be displayed in the diagram with the
respective colors. The scale in the basic condition has been selected to enable the presentation of all values of
the different parameters in one diagram. Placing the cursor to one of the graphs will indicate the
corresponding value and the time in the lower left part of the panel Gun Monitor.

The record can be stopped using the Pop-Up menu MONITOR > STOP. Sclecting FILE-> PRINT... will
output the diagram to the printer. The different values can be saved in a separate file by selecting FILE >
SAVE AS... in the Pop-Up menu to assign a file name. The data will then be saved in the file *. MON and can
be reloaded to the program later on by clicking FILE-> OPEN... in the Pop-Up menu to be displayed as a
graph again.
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Another ability to save data is to click FILE> EXPORT DATA. The recorded values will then be saved to a
separate *.CSV file . This file format can be read by many Windowsg applications (Word, Word Pad, Excel
etc.) so that the data will be available for processing in other programs. The example below shows a loaded
* CSV file in the program Word Pad.

Gun Run up Data starting Friday March 17 2000: 10:35:09

Time, Filament I, Extractor V, Extractor I, Gun Vacuum, Liner V, EHT V, Stigmation X, Stigmation Y
(Sec), (mA), (V), (uA), (mBar), (V), (V), (%), (%)

3, 2285, 4200, 200, 2.22e-006, 8000, 3000, 0, 0

6, 2285, 4200, 200, 2.22e-006, 8000, 3000, 0, 0

9, 2285, 4200, 200, 2.22e-006, 8000, 10000, 0, 0

12, 2285, 4200, 200, 2.22e-006, 8000, 10000, 0, 0

15, 2285, 4200, 200, 2.22e-006, 8000, 10000, 7.8975, -10.4325
18, 2285, 4200, 200, 2.22e-006, 8000, 10000, 9.165, -10.8225
21, 2285, 4200, 200, 2.22e-006, 8000, 10000, 16.0875, 3.705
25, 2285, 4200, 200, 2.22e-006, 8000, 10000, 21.255, 14.3325
28, 2285, 4200, 200, 2.22e-006, 8000, 10000, 21.255, 14.3325
31, 2285, 4200, 200, 2.22e-006, 8000, 10000, 21.255, 14.3325
34, 2285, 4200, 200, 2.22e-006, 8000, 7000, 21.255, 14.3325
37, 2285, 4200, 200, 2.22e-006, 8000, 7000, 56.0625, 56.16
40, 2285, 4200, 200, 2.22e-006, 8000, 7000, 56.8425, 57.0375

Many of the different commands and panels can be opened by means of the toolbar by clicking the symbols
explained below.

Symbol Explanation Symbol Explanation

New record of the parameters; deleting Interrupting the record

the graphics in the diagram

[=
=l

Loading saved data Starting the record

Saving the monitored data Opening the window Display Options

Saving the monitored data to a *.CSV file Opening the window Monitor Interval...

Printing the diagram (Zoom In)

Display of the gun monitor version Default display of the X axis

Stopping the record (Zoom Out)

@] | [=] | [ (= [ [«
| =] | [e]| @ | [e
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9.4 RemCon32 (requires the license REMCON)

The program RemCon32 provides the access to remote control of the SEM using a serial interface (RS232).
This allows reading and controlling special parameters of the microscope. This communication is frequently
utilized when using EDX/WDX systems.

When using the program RemCon32, care should be taken to first start the LEO user interface, then the
program RemCon32 and lastly the respective control program. The program will be opened using the
Windowsg- plane START> PROGRAM > LEO-32-> RemCon32. As this program is frequently used,
especially if an EDX/WDX system has been adapted, it can be started automatically together with the LEO-
32 user interface by modifying the macro “START” and saving it in the respective user directory (see .

For correct communications it is important that the settings on the selected port (serial interface COMI,
COM2 etc.) are correct and that the respective port has been activated for communication. Opening of the
window Communication Settings will be by using the Pop-Up menu COMMS > SETTINGS. The graph
below shows the default settings for a selected port. If Open port and minimize has been selected, the port
will be opened automatically on start of the program RemCon32. At the same time, the window will be
diminished to appear only in the Windowsg task bar. Selecting COMMS > ECHO ON will indicate the
communicated commands and answers in the window RemCon32.

For test purposes it may also be useful to operate the program in Local Mode by selecting the menu
COMMS > LOCAL MODE using the Pop-Up menu. By doing so, it will be possible to enter commands and
inquiries manually in the panel RemCon32. If correct communication has been established, the
corresponding answer will be displayed in the window or the corresponding command will be executed in
the LEO 32 user interface.

The respective RS232- protocol, i.e. a list of all RemCon32 commands applicable to LEO 32 software will
be available on request at LEO GmbH.

&% RemCon32 [_]0O0]  Communication 5ettings =]

Filz View gy Properties  Help ~DOn Startup
Open port
I and minimise

~Echa

P T e ——————

= e i o
mDM 1 = H! @:l![gll ! 300 E00 1200

_____ | 2400 O 4800 o GE0D

i~ Drata Bits Stop Bit
[ 7 8 ’76 1 2 ‘

0 = On
Local Mode - Earity LComms Port Flow Control———
- {+ MNone * Caml (+ None
I £ Odd " Com2 € wonfoff
C Even " Com3 " RTS
" Comd " Ron/RTS
Set various zenial port settings
Cancel !

&4 RemCon32 =]

File “iew Comms Properties Help
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Important Software Licenses

LED

Name of License

Description

Explanation of the License

I15XX-ACCOUNT

User Accounting

Automatic registration of special parameters during a
working session to enable the Administrator to retrace
which user has been operating the SEM at what times. For
each user, the number of saved TIFF images, output
photos and prints will be saved (see .

15XX-CENTER

Center Feature/ Stage
Map

Contains the two centering functions center point and
center feature. It is also possible to use the function stage

map (see b.6}.

15XX-CLIP Cut & Paste Copying and inserting SEM images to and from the buffer
store (see B.2.5).
15XX-COMPU Compucentric Stage Compucentric software to allow tilt-eucentric and

Software

rotation-eucentric control of a non-eucentric stage (see

15XX-DUALMAG

Dual Magnification

This function allows the display of a zoomed image in the
mode Split Screen without freezing the lower
magnification image. (see b.3.3).

I15XX-DYNFOCUS

Dynamic Focus

Enables a dynamic adjustment of the focus during the
beam pass on tilted sample surfaces (see b.3.4).

I5XX-GAMMALUT

Input Gamma

Release of the function Input LUT (see[3.2.1)). Enables the
individual adjustment of the input transfer characteristic
of a detector

15XX-GRATICULE

Graticule

Inserting a graticule on the screen (see B.3.3). The
distance between the lines can be set between 50 and 512

I15XX-IMMATH

Image Processing

Provides mathematic manipulation of the image store, e.g.
by using Kernel functions, adding or subtracting images
or by means of the detection of gray scale distribution.
(see

15XX-INVERT

Input Signal Invert

Inverting a signal by means of Input- LUT (see B.2.1}

15XX-MEASA

Advanced Measurement

Expanded measurement possibilities such as measuring
squares_or inserting horizontal/vertical measuring lines
(see h71).

15XX-REDUCED Adjustable Reduced Use of a small raster window, adjustable in size and
Raster position. Useful for the adjustment of parameters such as

focus or stigmator (see m

15XX-REMARCH FTP Remote Archiving | Sending files to a FTP server
15XX-REMCON RS 232 Remote Control | Reading or setting special parameters of the SEM using

the serial interface (see .

15XX-SCANEXP

Scan Rate Expansion

15 different scan rates (instead of 3 by default) (see B.7).

15XX-SCANROT

Scan Rotation

Allows an electronic rotation of the image by rotating the
scan direction (see b.3.6)

15XX-SIGMIX

Signal Mixing

Continuous mix of two detector signals in the range 0 to

100% (see [£.3.1).

15XX-SPLIT

Split Screen

When selecting the function Split Screen, the screen will
be subdivided in two zones. Each zone can be assigned
different detectors and each zone can be frozen
independently from the other (see p.3.2)
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15XX-SPOT

Spot Mode

Spot by spot positioning of the electron beam on a defined
point of the sample (see k.3.2).

15XX-STAGECO

Stage co-ordinate store
and reopen

Saving stage coordinates together with the magnification
and the working distance (see. These positions can be
moved to automatically.

I5XX-STAGEREG | Stage Registration Definition of user specific coordinate systems for the
specimen stage (see

15XX-STAGESCAN | Stage Scan This software option provides the ability to examine a
sample area by using a series of exactly defined, regularly
dispersed image fields (see

15XX-STDAPI API API OCX- protocol to write user routines in the LEO user

interface by means of Visual Basic, Visual C++ and Java

15XX-SURVEY

Stage Survey Mode

To adjust automatically magnifications and working
distances for two different application modes (see

15XX-TILTCOMP

Tilt Compensation

By means of this function, it is possible to correct the
perceived distortion caused when scanning tilted samples

(see b.3.5).

I5XX-XRAY

Simple X- Ray dot map/
Linescan

Imaging analogous EDX mappings and lines cans (see
bh.3.7).
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9.6 Water Flow/ Temperature

Flow and temperature of the cooling water in the system are controlled continuously to avoid an overheating
of the electronics. If the flow is interrupted or if the temperature rises beyond the set limit (Water Temp
Limit), the system will automatically be driven to safety mode. The power supply for the stage control and
the electron optic will be switched off and the window below will pop up. After eliminating the error,
clicking the key “Reset Overheat” will reactivate the power supply for the system .

This window can also be opened using the Pop-Up menu TOOLS 2> GO TO PANEL-> WATER FLOW/
TEMPERATURE.

Stage Too Hot:
Indicates the electronic status for the stage. The indication “Yes” will drive the
system to the safety mode.

IStage TooHot = Mo

|EQ Too Hat =N
] EO Too Hot:
fuater DK = Yes Indicates the electronic status for the electron optics. The indication “Yes” will
[wiater Temp = 0.0°C drive the system to the safety mode
Jiwater Temp Limit= 35.0°C
Water OK:

Indicates the cooling water flow. The indication “No” will drive the system to

|SEM Overheat = OK o - g
the safety mode as the flow is insufficient or has been interrupted.

Eresetvertieat | Cloze |

Water Temp:
If the system is in safety mode, this case will indicate the actual temperature of the cooling water.

Water Temp Limit:
Indicates the limit value for the temperature of the cooling water. If this value is exceeded, the system will

drive to the safety mode.

SEM Overheat:
Status indication for the temperature of the cooling water.

OK: Temperature of the cooling water is okay.
Too Hot: The temperature of the cooling water is too high; the system will drive to the safety mode.
Monitor: The error has been eliminated. The system is waiting for the user to reset the safety mode.

Key Reset Overheat:
Resetting the safety mode after elimination of the error.

Key Close:
Closing the panel Water Flow/ Temperature.
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9.7 Working with the Specimen Current Monitor

A specimen current monitor option may be installed on the SEM. For the control of this current meter, the
window Specimen Current Monitor is available which can be opened using the Pop-Up menu TOOLS >
GO TO PANEL > SPECIMEN CURRENT MONITOR.

When activating the control box SCM On, measurements will be displayed in the field Specimen I =, The
system will automatically switch to the various measuring ranges. When activating the control box Spoet, spot
mode will be switched on (see f£.3.2).

The beam current will be measured by means of a Faraday cup that consists

Specimen Curent Monitor__ INIEI ES RPNy strongly absorbing material (usually carbon) with a hole covered by an

[Specimen|= D4 electron-microscope aperture (aperture 30-100pm). To measure the probe
[SCM Status = Of current, the magnification on the instrument is set so that the complete beam
enters the hollow through the aperture opening. When switching on the

I Spot Specimen Current Monitor, the grounding of the sample holder (sample
stage) will be interrupted and a pico-ammeter will be inserted (Specimen
Current Monitors). If the beam is focused into the (or spot mode is set on the) Faraday cup, the measured
current will be the same as the entering beam current.

A similar measurement can be performed on real samples. To avoid strong divergences of the measured
value, it is recommended to use the spot mode. The primary electron beam impinging on the sample will
release interactive processes. The sample will not emit mainly SE and BSE electrons. When using very thin
samples, there may also occur a transmission of single electrons. If there is no charging of the specimen, the
measured current will be equivalent to the electrons absorbed in the sample (specimen current).

Measuring the beam current by means of the Measuring the beam current on a real sample
Faraday cup
PE
SE
BSE

L 4

1 - aperture PE — primary electron beam

2 — primary electron beam SE — SE electron

3 - Faraday cup with absorbed RE and SE electrons | BSE — RE electron

4 — pico-ammeter TE- transmitted electrons (only on very thin samples)
SC — electrons absorbed in the sample (specimen
current)
Ipg= IsgHsetHret]sc Isc= Ipg-Ise-Igse-Ite
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9.8 Accounting (Requires the License: ACCOUNT)

The software Accounting provides the ability to record important information on the different working
sessions on the microscope in a separate data base file. Later on the Administrator can refer to this
information. It will thus be possible to document the rate of capacity utilization or to list the times of the
working sessions for the different users.

The menu Accounting must be opened using the Administrator (see paragraph [2) (Supervisor privilege) and
contains the following different submenus:

& LED 32 Administrator [MUSTERMANN] M= E
Users [RESMRQ0] Licences . Configuiation.. Service Dalabase Help
Usyy  Creste Database i i Image Directory User level

v Active
Owners C:\Program Fil___\[E032\useryAck | C:\Program Fil.. EOSLE032yimages [.Any,

Delete Up To, C:\Program Fil...32\user\default | C:\Program Fil...EO\LE032\images | Any
C:\Program Fil...32\user\service | C:\Program Fil.._.EO\LE032\images | Any
C:\Program Fil...E032\user\guest | C:\Program Fil...EO\LE032\images | Expert
C:\Program Fil..._user\Mustermann | C:\Program Fil.._.EO\LE032\images | Any
C:\Program Fil...32\user\default C:\Program Fil...EO\LE032\images Nowice
C:\Program Fil...32\user\service | C:\Program Fil.._.EO\LE032\images | Any
c:\program fil.._32\user\default | c:\program fil.._eo\leo32\images | Any
| C:\Program Fil...LEO32\user\test | C:\Program Fil...EO\LEO32\images | Any

Compact Database
Repai Database

Create Database: Creating an empty file (account.mdb) in the directory C:\Program Files\ LEO\
LEO32\ System. If a file has already been created, a warning message will pop up.

Active: Switching on/off the record to the data base file.
Owners: Opening the window Account Owners (see below).
Delete Up To: Deleting records from a defined date. Example: If you want to delete all records

from February 06, 2000 until the generation date (July 19, 1999), enter 07-Feb-00 in
the window Delete session records. A safety inquiry will be displayed before
deleting the data.

Compact Database: Due to the modification of data within the database, the file may get fragments
using unnecessarily storage place. When opening Compact Database, a
defragmentation will be performed after creating a safety copy (account.bak) in the
directory \LEO32\System. If errors appear on defragmentation, delete the file
“account.mdb” and change the name of the file “account.bak” to “account.mdb”, to
reset the original condition.

Repair Database: Errors in the database may result from incomplete records caused, for example, by a
software crash. The routine Repair Database will try to repair these errors in the
database. After opening Repair Database you should also apply the routine
Compact Database to the file.

Review: Listing the different working sessions in a separate window (see below).

. Delete session records =13

i Cument Recards in database—————————————

| From 13.Jul 93
| To 20Me D admin
323 Records Are pou gure you want to delete all records wp to Monday, Februam OF, 2000

Delete Up To in?.peh.gq
Cancel | oK |

o |
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9.8.1 Review

When clicking ACCOUNTING - REVIEW a panel will be displayed listing the different records of the file
“account.mdb”. On each working session on the microscope, the following data will be stored: date, user
name, the LEO 32 user interface starting time, the LEO 32 user interface closing time, duration of the
working session, number of exposed photos, number of prints using the LEO 32 user interface, number of
saved TIFF files and status of the data base record (Normal, Abnormal etc.). Four different status indications

are possible:

Normal: Record of the data base has been activated (\/ Activate); working session has been finished
normally

Abnormal: Working session has been finished abnormally, e.g. due to a software crash

ON: Record of the data base switched on

OFF: Record of the data base switched off

By default, the list of files will be represented as in the graph below. The different records are sorted
primarily on day of working session, then month and year. Selecting User Name in the field Sort sessions by
will list the files by user names.

If you only wish to indicate the total of working sessions of the different users you will have to select
Accounts in the field Display. This will list the different users with the respective number of working
sessions, the total of working hours and the number of output photos and prints as well as the number of
saved TIFF files (see right graph below).

It is also possible to list one specific user by clicking Select username and selecting a user in the field User
Name selection

If Owners have been defined (see), which may include several users, selecting a corresponding Owner
in Select Owner, will compose a list based on the Owner.

For the selection of different periods you may use the field Log On Data selection. Example: If you want a
list including all working sessions from January 8, 2000 up to March 8, 2000, enter From 08-Jan-2000 and
To 09-Mar-2000. Activating the green check will list the corresponding interval.

. [[=] 3 = [[=] 3
Prirt Copy Prirt Copy
Log On Usernane Log OFf Duration Photo Print Tiff Usernane Sessions Duration Phote Print Tiff
87 . Jan. 88 17:AMUSTERHANN 87. Jan. 88 18:3 B0:46 8 O 6 MNormal |a] Ack 46 8619 :62 1 0 6
087. Jan. 88 26:1HUSTERHANN B87. Jan. 86 21:5 61:38 Hormal Development ] 8 a 8
08. Feb. 00 B8:2FACTORY 88. Feb. 80 88:3 00:01 Hormal Factory 5 0003 :25 ] L] e
68. Feb. 08 08:3MUSTERHANN 88. Feb. 86 B89:2 88:59 Hormal Guest 3 0860602 8 a ]
88. Jan. 88 16:2HUSTERHANN B88. Jan. 86 18:3 82:06 Hormal Hustermann 119 0892:15 1 L] 18
88. Jan. 88 19:BMUSTERHANN 88. Jan. 88 22:8 2:19 Hormal Houice 1 8988: 61 8 0 8
B68. Jan. 88 22:8MUSTERHANN 68. Jan. 86 22:0 68:01 Hormal J Service 68 8621:49 8 [ 2
8. Jan. 0@ 22:@MUSTERMANN 88. Jan. 080 22:0 00:01 Hormal System ur 0030:18 1 3 10
88. Jan. 08 22:8MUSTERHANN B88. Jan. 86 22:1 60:03 Hormal test 7 0064 -42 8 L] 8
8. Jan. 08 22:6SERVICE 88. Jan. 86 22:0 00:02 Hormal [
88. Jan. @8 22:8SERUIGE 88. Jan. 88 22:8 B0:62 Normal [========= Totals 288 8171:34 3 3 36
88. Jan. 88 22:1HUSTERHANN B88. Jan. 88 22:1 Hormal
8. Jan. 0@ 22:1MUSTERMANN 88. Jan. 080 22:1 80:01 Hormal
88. Jan. 88 22:1HUSTERHANN B88. Jan. 86 22:1 68:02 Hormal
8. Jan. 98 22:1SERVICE 88. Jan. 86 22:2 809:03 Hormal
88. Jan. 88 22:BHUSTERMANN 88. Jan. 88 23:4 BB:55 Abnormal
88. Jan. 88 23:5HUSTERHANN B89. Jan. 86 B60:0 68:09 Hormal
88. Mrz. 88 17:8SYSTEM 8. Mrz. 88 18:3 B1:38 Normal
B68. Hrz. 88 19:4SYSTEM 68. Hrz. 86 208:5 61:05 Hormal
08. Hou. 99 B8:2Factory 88. Nov. 99 88:2 00:01 Hormal
68. Nou. 99 88:2Service B88. NHou. 99 88:2 Hormal
08. Hou. 99 BB:2SERVICE 88. Nov. 99 88:4 00:23 Hormal
88. Nou. 99 88:2System 88. Nou. 99 88:2 Hormal
B68. Hou. 99 BB:2SYSTEM 68. Nov. 99 B8:2 Hormal
08. Hou. 99 10:5SERVICE 88. Nou. 99 12:4 01:49 Hormal
88._ Okt. 99 23:3SERVICE B88. Okt. 99 23:4 686:18 Hormal
08. Sep. 99 20:5SERVICE 08. Sep. 99 20:5 Normal ||
~LogOn Date User Name ~LogOnDale User Name
FED @ AllUsemames Display Sort sessions by— FED @ Al semames Display Sort sessions by—;
LI e | @ Sessions @ LogOn | oo - Sokct ey MusEmam ] © Sessions & LogOn
© Pecounts © UserName & pecounts © UserName |
I~  Select Dunsr —> & - I~  Select Duner =5 [Misiemorn = -

The database file “account.mdb” can be loaded and processed using other Windowse programs (e.g.
Microsofte Access). It is also possible to copy certain files to the buffer store by clicking COPY and to insert
them to other programs (e.g. Microsofts Word, Microsofte Excel etc.). The content of the respective panel
will be printed on the standard printer by clicking PRINT in the Pop-Up menu.
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9.8.2 Owners

Different users belonging to the same institute or product unit are grouped under one Owner. Each user can
only have one Owner. Editing an Owner is by the Pop-Up menu ADMINISTRATOR ACCOUNTING >
OWNERS. Now the window Account Owners will be opened where already created Owners will be listed.
Creating a new Owner is done using the Pop-Up menu OWNERS > NEW . In the panel Creating new
Owner it is possible to enter the complete address of the respective institute or product unit. The fields Name
and Company must be filled in. Close the window by clicking “OK”. The new Owner will now be
displayed. When activating an owner (clicking the left mouse button) and selecting OWNERSHIP-> ADD
using the Pop-Up menu, the different users can be selected in the window Select Username to add. The users
belonging to the corresponding Owner will be indicated in the list Owned Usernames. If a user name is to be

deleted from the corresponding Owner, select the user name and delete it from the list by clicking
OWNERSHIP-> REMOVE.

. Account Dwners

. Creating new Owner [_ (O] =]
Owners  Dwnership
Owner Reference = 7
0064 User 1 Institut 1 Duined Lsemames
0805 User 2 Institut 2 T User 3
ook Campay Institut 5

Mustermann

Address

i, Select Usemame to add [Hj[=] B3
Zip/Post Code I
Factary
Systemn
Country I

&5

TS =B The Owner with the name User 1 contains the users
e S| Dwenen | P PR Ack, Guest and Mustermann. When selecting User
§:§i§m.. I st - A 1 in the field Select Owner, all working sessions of
[========= Totals 168 0111:19 2 [) 24

these users will be listed.

v @ Seloot Dwner > [User 1 2
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Administrator 8, 27

Airlock 12,27, 130

Annotation 18, 21, 22, 35, 58
General 63
Measurement & Results 62
Standard 62

Aperture 23, 37

As Seen 18, 50

Auto Focus 35

Auto Stigmation 35

AutoBC 30, 35, 38

B

Backlash 72, 77, 92, 98
Bakeout 11, 27,42

Beam Blanked 44, 96

Beam Shift 23, 27, 45, 75, 96

C

Calibrate Stage Centre 27, 85
Calibrate Stigmation 27
Calibration Wizard 8
Capture Now 28

CCD 13,35

Centre 51

Centre Feature 75, 80, 96
Centre Point 75, 80, 96
Chamberscope 35
Clipboard 18

Coarse 31

Collector Bias 38, 39
Colour Merge 49, 71
COMPO 38, 39
Compucentric Set Up 27, 87
Compucentric Software 26
Copy 25

Crosshairs 21, 96
current.adz 20, 21, 67
current.anp 64

Cycle Time 40

data.vac 8,9
Delta 91

Detector 24, 37
Dimensions 19, 49

LED

Dual Magnification 26, 35, 41, 100
Dwell Time 40
Dynamic Focus 26, 28

E

Edit 16

EHT 11,23, 30, 34, 37, 43
EHT Off @ Log Off 11, 43
Emission 23, 40, 44, 96
Encoder 128

Exit 15,32,43

Ext Scan Control 28
Extractor 43

F

Filament Age 48
Filament Current 11, 43
File 14

24 Bit Colour 50
File information 19, 51
File Name

Next 50

No. 50
File Nr. 50
Filter 25, 104
Find Image 25
Fine 31
Fit to Image 52
Focus Wobble 35, 44
Frame Average 41
Freeze 24,35, 41
FTP Remote Archiving 8

G

Gamma 38

Go To 46,91

Goto Panel 27

Graticule 21

Gun 23, 37,42

Gun Align 44

Gun Monitor Utility 8, 133
Gun Service 8,23

Gun Setup 23

HFP Status 20
Hide 20, 22
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Image 24
Image Capture Mode 28
Image Directory 10
Image Gallery 24, 25, 52
Image Processing 24, 25, 102
Image Reduction 51
Inlens- Detector 31, 37, 39
Input LUT 16, 21
Insert

Annotation Text 18

Point to Point Marker 18
Invert

Display LUT 56

Input LUT 17, 38

J
Joystick Disable 46, 93, 129

L

Leave Gun On At Shutdown 11, 43
Line Scan 26, 40
Load
Annotation 15
Display LUT 55
Image 14
Input LUT 17
State 14, 33
Log Off 15, 32, 43

M

Magnification Calibration 28
Magnification Table 98
Merge 18

Mixing 24, 38

Move XY Only 73

N

Noise Reduction 24, 31, 41, 98
Normal 26, 35, 40
NTSC 13

0]

Origin 19, 51

Other Settings (Administrator) 11
Output Device 48, 120

Overlay 49, 71

Owner 142
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